
 

 

 

 

 

 

 

Brandschutztechnische Bemessung von Tragwerken 

aus Stahl nach Eurocode 1 und 3  

 

 

 

Diplomarbeit 

Tobias Michael Flesch 

 

 

 

 
 
 
 
 

 

 

 
 
  
Prüfer:  
Prof. Dr. - Ing. T. Krause 
Dipl. - Ing. G. Spennes August 2007 



Inhaltsverzeichnis 

  I 

Inhaltsverzeichnis 

1 Einleitung.......................................................................................................................... 1 

2 Grundlagen ....................................................................................................................... 4 

2.1 Berechnungen nach Eurocodes.................................................................................................... 4 

2.1.1 DIN EN 1990 - Eurocode 0 .................................................................................................... 5 

2.1.2 DIN EN 1991 - Eurocode 1 .................................................................................................... 6 

2.1.3 DIN EN 1993 - Eurocode 3 .................................................................................................... 8 

2.2 Feuerwiderstandsklassen nach Eurocode .................................................................................... 9 

2.3 Brandszenarien ........................................................................................................................... 10 

2.3.1 Einheitstemperaturkurve...................................................................................................... 10 

2.3.2 Naturbrandszenario ............................................................................................................. 11 

2.3.3 Normbrand versus Naturbrand ............................................................................................ 11 

3 Thermische Analyse von Stahl im Brandfall .................................................................13 

3.1 Wärmeübergang ......................................................................................................................... 13 

3.1.1 Konvektion ........................................................................................................................... 13 

3.1.2 Strahlung.............................................................................................................................. 14 

3.2 Wärmeleitung .............................................................................................................................. 16 

3.3 Stahltemperatur in Abhängigkeit vom Profilfaktor....................................................................... 18 

3.3.1 Ungeschützte Stahlprofile.................................................................................................... 18 

3.3.2 Geschützte Stahlprofile........................................................................................................ 20 

3.4 Thermische Einwirkungen für die Temperaturberechnung......................................................... 21 

3.4.1 Vereinfachte Brandmodelle ................................................................................................. 21 

3.4.1.1 Vollbrand ...................................................................................................................... 21 

3.4.1.2 Lokaler Brand ............................................................................................................... 22 

3.4.1.3 Berechnungsbeispiel - Lokaler Brand .......................................................................... 22 

3.4.2 Allgemeine Brandmodelle.................................................................................................... 25 

4 Berechnung der Tragfähigkeit im Brandfall ..................................................................27 

4.1 Materialeigenschaften von Stahl ................................................................................................. 27 

4.1.1 Thermische Eigenschaften .................................................................................................. 27 

4.1.1.1 Dichte ........................................................................................................................... 27 

4.1.1.2 Spezifische Wärmekapazität ........................................................................................ 28 

4.1.1.3 Wärmeleitfähigkeit ........................................................................................................ 30 

4.1.1.4 Thermische Dehnung ................................................................................................... 31 

4.1.2 Mechanische Eigenschaften................................................................................................ 32 

4.1.2.1 Streckgrenze ................................................................................................................ 32 

4.1.2.2 Zugfestigkeit ................................................................................................................. 33 

4.1.2.3 Festigkeit und Elastizität............................................................................................... 33 

4.1.2.4 Verformungsverhalten .................................................................................................. 35 



Inhaltsverzeichnis 

  II 

4.2 Normativer Hintergrund............................................................................................................... 36 

4.3 Vereinfachtes Nachweisverfahren .............................................................................................. 37 

4.3.1 Berechnung der Festigkeit................................................................................................... 37 

4.3.2 Berechnung der kritischen Temperatur ............................................................................... 38 

4.4 Allgemeines Nachweisverfahren................................................................................................. 39 

4.5 Berechnungsbeispiele................................................................................................................. 41 

4.5.1 Ermittlung der kritischen Temperatur eines Stahlträgers .................................................... 41 

4.5.2 Allgemeines Nachweisverfahren am Beispiel einer Stahlstütze.......................................... 42 

4.6 Systemreserven eines Tragwerkes............................................................................................. 43 

4.6.1 Variante 1............................................................................................................................. 44 

4.6.2 Variante 2............................................................................................................................. 46 

4.6.3 Variante 3............................................................................................................................. 47 

4.6.4 Fazit ..................................................................................................................................... 48 

5 Feuerwiderstandsdauer von ungeschützten Stahlprofilen ..........................................49 

5.1 Praxisorientierte Berechnung der Stahltemperatur..................................................................... 49 

5.1.1 Näherungsformel ................................................................................................................. 49 

5.1.2 Validierung mit SAFIR ......................................................................................................... 51 

5.2 ‚Overmarching’ ............................................................................................................................ 52 

5.3 Anwendung von FR-Stahl ........................................................................................................... 53 

5.4 Bemessungsbeispiele ................................................................................................................. 54 

5.4.1 Ungeschützter Biegeträger im Brandfall .............................................................................. 54 

5.4.2 Ungeschützte Stahlstütze im Brandfall ................................................................................ 58 

6 Anwendungsbeispiel aus dem Stahlhochbau ...............................................................63 

6.1 Kalte Bemessung ........................................................................................................................ 64 

6.2 Heiße Bemessung....................................................................................................................... 65 

6.2.1 Vereinfachtes Nachweisverfahren....................................................................................... 66 

6.2.2 Allgemeines Nachweisverfahren mit SAFIR........................................................................ 67 

6.3 Nachweis der Feuerwiderstandsdauer R 30............................................................................... 68 

6.3.1 ‚Overmarching’..................................................................................................................... 68 

6.3.2 Naturbrandszenario ............................................................................................................. 70 

6.4 Ausgeführte Bauobjekte.............................................................................................................. 71 

6.4.1 Multifunktionshalle ‚Kölnarena’ ............................................................................................ 71 

6.4.2 Shopping Centre ‚Cactus’ .................................................................................................... 72 

6.4.3 Bürogebäude ‚State Street Bank’ ........................................................................................ 73 

6.4.4 Aufstockung eines Schulgebäudes...................................................................................... 74 

7 Zusammenfassung und Ausblick...................................................................................75 

8 Literaturverzeichnis ........................................................................................................77 

9 Abbildungsverzeichnis ...................................................................................................79 



Inhaltsverzeichnis 

  III 

10 Tabellenverzeichnis ......................................................................................................81 

11 Software .........................................................................................................................82 

12 Anlagen ..........................................................................................................................83 



Einleitung  

  Seite 1  

1 Einleitung 

In Deutschland sind in den Bauordnungen der einzelnen Bundesländer Schutzziele definiert, 

deren Erfüllung bei der Auslegung von Bauwerken zwingend beachtet werden muss. Aus 

diesen Anforderungen ergeben sich Schutzzielforderungen, die neben wesentlichen Kriterien 

für die Sicherheit im Brandfall, wie beispielsweise dem Personenschutz und der Rauch- bzw. 

Feuerausbreitung, auch die Standfestigkeit tragender Bauteile und des Gesamttragwerkes 

im Brandfall fordern.  

Der Baustoff Stahl, als architektonisches und gestalterisches Element eingesetzt, inspiriert 

Bauherren, Ingenieure und Architekten gleichermaßen, wenn es um die Frage großer 

Spannweiten und schlanker Tragkonstruktionen geht. So besteht in der modernen 

Architektur oftmals der Anspruch, Stahlkonstruktionen als sichtbare Tragelemente zu 

erhalten - Stahl ungeschützt. Im Vergleich zum Material- und Zeitaufwand 

brandschutztechnischer Bekleidung sind die geringeren Investitionskosten ein weiterer 

Grund für die Ausführung ungeschützter Stahlkonstruktionen.  

Der Nachweis einer geforderten Feuerwiderstandsdauer für Stahlkonstruktionen, abhängig 

von Art und Nutzung des betreffenden Gebäudes, stellt Brandschutzingenieure und 

Tragwerksplaner vor eine besondere Herausforderung, da der Werkstoff Stahl im Brandfall 

signifikant an Tragfähigkeit verliert und daher einer genauen Analyse bedarf. 

Der Festigkeitsverlust von Stahl ist, im Gegensatz zu anderen Baustoffen, auf Grund der 

charakteristischen Materialbeschaffenheit bereits bei vergleichsweise niedrigen 

Temperatureinwirkungen sehr hoch. So verliert der Baustoff Stahl schon ab einer 

Temperatur von 400 °C signifikant an Festigkeit und verfügt bei einer Temperatur von 800 °C 

nur noch über 10 % der Ausgangsfestigkeit. 

Bis heute ist in Deutschland der Nachweis für das Tragverhalten von Konstruktionen unter 

Brandbeanspruchung auf Versuche in Brandräumen unter Einwirkung der 

Einheitstemperaturkurve beschränkt.  

Hierbei wird jedoch kein realistischer Temperaturverlauf eines Naturbrandes erreicht, 

sondern vielmehr der ‚worst case’ dargestellt und so ein Ergebnis erzielt, welches in der 

Regel auf der sicheren Seite liegt. 

In den letzten Jahrzehnten haben sich Forschungsgruppen und Wissenschaftler, u.a. 

Professor Schleich aus Luxemburg, zunehmend mit der Entwicklung von 

Berechnungsmethoden für Naturbrandkurven und mit dem Tragverhalten von Stahl unter 

Brandbeanspruchung beschäftigt und die Erkenntnisse mit Daten aus realen 

Brandereignissen und Brandversuchen validiert.  

Bei den im Zuge der Europäisierung entwickelten Eurocodes sind die Ergebnisse, soweit 

abgesichert und konsensfähig, in die europäische Normung eingegangen und die 
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Bemessungsregeln für den außergewöhnlichen Lastfall Brand fester Bestandteil der neuen 

Regelwerke.  

Während in der DIN 18800 für den Stahlbau nur das ‚kalte Bemessungsverfahren’ zur 

Verfügung stand, ist es zukünftig auf der Grundlage der DIN EN 1993-1-2 [7] möglich, 

Konstruktionen aus Stahl für eine mögliche Brandbeanspruchung zu bemessen.  

In der DIN EN 1991-1-2 [3] sind hierzu verschiedene Nachweisebenen aufgeführt und die 

Anwendung ingenieurmäßiger Methoden, wie beispielsweise die Bemessung eines 

Tragwerkes unter Annahme von Naturbrandkurven, berücksichtigt. 

Ist für Stahlkonstruktionen in ungeschützter Bauweise unter Einwirkung der 

Einheitstemperaturkurve meist nur der Nachweis der Feuerwiderstandsklasse R 30 möglich, 

so kann mit ingenieurmäßigen Methoden unter Anwendung des allgemeinen 

Nachweisverfahrens mit Naturbrandkurven in der Regel ein entscheidend höherer 

Feuerwiderstand erreicht werden.  

 

Ziel dieser Arbeit ist es, in einem ersten Schritt das thermische und mechanische Verhalten 

von Stahl zu analysieren. Hierbei sollen besonders die Vorgänge des Wärmeübergangs und 

der Wärmeleitung im Stahl sowie die Abhängigkeit der Stahltemperatur vom Profilfaktor im 

Brandfall untersucht werden. 

Des Weiteren soll die realisierbare Feuerwiderstandsdauer von Stahlprofilen unter 

Brandbeanspruchung durch die Einheitstemperaturkurve betrachtet werden. Hierbei steht 

besonders die Verwendung von feuerresistentem Stahl und dem so genannten 

‚Overmarching’ im Mittelpunkt, wobei für eine praxisgerechte Anwendung auch die Effizienz 

als Kriterium zwingend zu berücksichtigen ist. 

Es werden unter Anwendung der Eurocodes 1 und 3 Bemessungsbeispiele vorgestellt und 

die o.g. Methoden anhand dieser Beispiele miteinander verglichen.  

Außerdem wird die Bemessungssoftware SAFIR, entwickelt von Professor Franssen 

(Universität Lüttich), vorgestellt und auf ihre praxisorientierte Anwendung hin überprüft. Mit 

Hilfe dieser Software, basierend auf der Finiten-Element-Methode, können die thermische 

Analyse für Bauteile und in einem weiteren Schritt die mechanische Analyse für Tragwerke 

durchgeführt werden.  

Abschließend werden Anwendungsbeispiele aus dem Stahlhochbau berechnet. Konkret soll 

hierzu ein zweigeschossiger Rahmen aus Stahl für ein Bürogebäude bemessen werden. 

Hierzu werden sowohl die Kalt- als auch die Heißbemessung nach dem vereinfachten 

Nachweisverfahren der DIN EN 1993 [6,7] durchgeführt. Im Vergleich erfolgt die Berechnung 

des Gesamttragwerkes im Brandfall mit SAFIR.  

Ziel ist es, eine Aussage darüber zu treffen, welche zusätzliche Sicherheit bzgl. des 

Feuerwiderstandes mit dem allgemeinen Nachweisverfahren erreicht werden kann und 
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welche Feuerwiderstandsklasse für das Tragwerk unter Einwirkung einer Naturbrandkurve 

erzielt wird.  

Darüber hinaus soll die Anwendung der neuen Eurocodes, insbesondere der ‚heißen 

Bemessung’, erläutert und damit in der Praxis leichter umsetzbar werden. Bisher erfolgte die 

Entwicklung der neuen Normen, insbesondere für die Brandschutzteile, weitgehend auf 

wissenschaftlicher Ebene ohne eine ausreichende Anwendung in der Praxis vorweisen zu 

können. 
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2 Grundlagen 

2.1 Berechnungen nach Eurocodes 

In den 80er Jahren entstand die erste Generation der Eurocodes, die ursprünglich als 

Aktionsprogramm zur Beseitigung von Handelseinschränkungen im Baubereich und zur 

Harmonisierung technischer Regeln im Bereich der Lastannahmen und Bemessung 

baulicher Anlagen ins Leben gerufen worden war.  

In einer ersten Phase wurden die Eurocodes von der europäischen Normungsorganisation 

als europäische Vornormen (ENV) veröffentlicht und über nationale Anwendungsdokumente 

(NAD) zur probeweisen Anwendung bauaufsichtlich bekannt gemacht. Die in den Vornormen 

gekennzeichneten Zahlenwerte, so genannte ‚boxed values’, dienten der Berücksichtigung 

nationaler Unterschiede wie beispielsweise der Bauart, den Sicherheitsanforderungen und 

verschiedener klimatischer Bedingungen. 

In einer zweiten Phase begann ab dem Jahre 1997 die Übertragung der Vornormen in 

europäische Normen, nachdem aus Stellungnahmen resultierende technische Änderungen 

bzw. Ergänzungen übernommen wurden. 

Für Deutschland werden diese dann in den Status der DIN EN übernommen und die 

nationalen Anwendungsdokumente (NAD) durch so genannte Nationale Anhänge (NA) 

ersetzt (vgl. Abb. 2-1). Hier werden die national festzulegenden Parameter wie vorher in den 

‚boxed values’ festgelegt.  

 

  

 Abb. 2-1: Entwicklungsphasen des Eurocodes 

 

Bis zum 31. März 2010 sollen alle Teile der Eurocodes mit ihren jeweiligen Nationalen 

Anhängen (NA) eingeführt und in der Praxis ausreichend erprobt sein, so dass die nationalen 

Bemessungsnormen zurückgezogen werden können [vgl. 15]. 

Abbildung 2-2 gibt einen Überblick über den Aufbau der Eurocodes und ihre Beziehungen 

zueinander. 
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 Abb. 2-2: Aufbau der Eurocodes 

 

Zur Anwendung kommen im Rahmen dieser Arbeit vor allem die DIN EN 1991 [2-5] und die 

DIN EN 1993 [6,7], also der Eurocode 1 und 3. Der Schwerpunkt liegt hierbei jeweils auf dem 

für die brandschutztechnische Bemessung relevanten zweiten Teil, der ‚heißen Bemessung’ 

des Eurocodes.  

Außerdem wird die DIN EN 1990 [1] mit allgemeinen Angaben zu den Grundlagen der 

Tragwerksplanung berücksichtigt. 

Im Folgenden werden die für die brandschutztechnische Bemessung wesentlichen Inhalte 

der Normen und ihre Anwendung erläutert. 

 

2.1.1 DIN EN 1990 - Eurocode 0 

In der DIN EN 1990 [1] sind die allgemeinen Grundlagen der Tragwerksplanung 

festgeschrieben, sie bildet zusammen mit der in Kapitel 2.1.2 beschriebenen  

DIN EN 1991 [2-5] die Basis für die materialspezifischen Eurocodes 2 bis 9. 

In der Norm sind Prinzipien und Anforderungen zur Gebrauchstauglichkeit, Tragsicherheit 

und Dauerhaftigkeit  von Tragwerken festgelegt. Sie beruht auf dem Konzept der 

Bemessung nach Grenzzuständen mit Teilsicherheits- und Kombinationsbeiwerten für die 

verschiedenen Bemessungssituationen. 
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2.1.2 DIN EN 1991 - Eurocode 1 

In der DIN EN 1991 [2-5] sind die verschiedenen Einwirkungen auf Tragwerke aufgeführt, so 

beinhaltet beispielsweise die DIN EN 1991-1-1 [2] Angaben zu Eigengewicht und Nutzlast, 

die DIN EN 1991-1-3 [4] die Berechnung von Schneelasten und die DIN EN 1991-1-4 [5] die 

von Windlasten.  

Die maßgeblichen Rechengrundlagen für die Bemessung im Brandfall sind in der DIN EN 

1991-1-2 [3] angegeben. Neben allgemeinen Hinweisen zur Tragwerksbemessung im 

Brandfall werden hier Berechnungsansätze zur Ermittlung der thermischen Einwirkungen für 

die Temperaturberechnung und der mechanischen Einwirkungen für die 

Tragfähigkeitsberechnung aufgeführt.  

Für die thermischen Einwirkungen werden nominelle Temperaturzeitkurven, wie 

beispielsweise die Einheitstemperaturkurve, oder der Ansatz von Naturbrandkurven als 

Möglichkeit angegeben. Letztere werden in vereinfachte und allgemeine Brandmodelle 

eingeteilt.  

Hier sind besonders die allgemeinen Rechenmodelle von Interesse, die in der Regel mit 

Brandsimulationsprogrammen wie OZone, MRFC oder FDS durchgeführt werden. So kann 

eine realistische Brandentwicklung mit entsprechendem Temperaturverlauf berechnet und 

für die brandschutztechnische Bemessung berücksichtigt werden.  

In Tabelle 2-1 sind die thermischen Modelle zusammengefasst dargestellt. 

 

Thermische Brandmodelle 

Einheitstemperaturkurve 

Außenbrandkurve 
Nominelle 

Temperaturzeitkurven 
(normative Regelung) 

Hydrokarbon-Brandkurve 

Lokaler Brand 
Vereinfachte Brandmodelle 

Vollbrand 

Zonenmodelle 

Naturbrände  
(nutzungsabhängige 

Regelung) 
Allgemeine Brandmodelle 

Feldmodelle 

 Tab. 2-1: Übersicht der möglichen thermischen Brandmodelle 

 

Im Anhang der DIN EN 1991-1-2 [3] sind Berechnungsgrundlagen für parametrische 

Temperaturzeitkurven (DIN-Anhang A), lokale Brände (DIN-Anhang C) und erweiterte 

Brandmodelle  (DIN-Anhang D) angegeben. Außerdem sind hier Angaben zur Ermittlung der 
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Brandlastdichte, zur Energiefreisetzungsrate und zu thermischen Einwirkungen auf 

außenliegende Bauteile aufgeführt. 

In Kapitel 3.4 dieser Arbeit werden die o.g. allgemeinen und vereinfachten Brandmodelle 

erläutert und die Berechnung eines lokalen Brandes anhand eines Beispieles detailliert 

vorgestellt.  

Das Verfahren einer brandschutztechnischen Bemessung ist in Abbildung 2-3 schematisch 

aufgezeigt. 

 

 

 Abb. 2-3: Alternative Bemessungsverfahren nach DIN EN 1991-1-2 [3] 

 

Mit den Eurocodes stehen drei verschiedene Bemessungsverfahren zur Verfügung, wobei 

zwei ausschließlich auf die Bauteilanalyse beschränkt sind (vgl. Kapitel 4).  

Mit dem tabellarischen Verfahren können z.B. für Verbundbauteile Mindestabmessungen in 

Abhängigkeit einer bestimmten Feuerwiderstandsklasse bestimmt werden. Für den Stahlbau 

gibt es dieses in der DIN EN 1993-1-2 [7] nicht. 

Eine Bemessung nach dem vereinfachten Verfahren lässt einen Nachweis auf zwei 

verschiedenen Ebenen zu.  

Für nicht stabilitätsgefährdete Bauteile kann der Nachweis auf Temperaturebene geführt 

werden, wobei die für das Bauteil kritische Temperatur in Abhängigkeit vom 

Ausnutzungfaktor ermittelt wird. Auch ist ein Nachweis auf Tragfähigkeitsebene möglich. Ziel 

des Nachweises ist, dass alle Einwirkungen bis zum Erreichen einer bestimmten 
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Feuerwiderstandsdauer ohne ein Versagen des Bauteiles aufgenommen werden können. In 

seltenen Fällen kann das vereinfachte Bemessungsverfahren auch auf einfache 

Teiltragwerke, wie beispielsweise Rahmen, angewendet werden. 

Bei den allgemeinen Rechenverfahren wird, meist unter Anwendung von speziellen FEM-

Programmen, eine thermische und mechanische Analyse durchgeführt und so das 

tatsächliche Tragvermögen eines Teil- oder Gesamttragwerkes berechnet.  

 

2.1.3 DIN EN 1993 - Eurocode 3 

Die DIN EN 1993-1-1 [6] enthält allgemeine Bemessungs- und Konstruktionsregeln für den 

Stahlhochbau, die, vergleichbar der DIN 18800, Anwendung bei der ‚kalten Bemessung’ von 

Stahlkonstruktionen findet.  

Die Rechengrundlagen zur Bemessung im Brandfall sind in der DIN EN 1993-1-2 [7], häufig 

als ‚heißer Teil’ des Eurocode 3 bezeichnet, angegeben. 

Hier werden sowohl die Materialeigenschaften von Stahl (vgl. Kapitel 4.1) als auch Regeln 

für die Tragwerksberechnung im Brandfall festgelegt. 

Diese Regeln orientieren sich an den in der DIN EN 1993-1-1 [6] festgelegten Berechnungen 

(kalte Bemessung), jedoch werden temperaturabhängige Abminderungsfaktoren, 

resultierend aus den Materialeigenschaften, und andere Beiwerte für den Brandfall 

berücksichtigt. 

Dabei wird zwischen einfachen und erweiterten Berechnungsmodellen unterschieden. 

Während sich die einfachen Berechnungsansätze auf Einzelbauteile beziehen, finden die 

allgemeinen Modelle bei Gesamttragwerken Anwendung. Hier wird der kombinierte Einfluss 

von mechanischen und thermischen Einwirkungen berücksichtigt (vgl. Kapitel 4). Dazu 

zählen u.a. Zwängungen und Spannungen infolge thermischer Einwirkungen, geometrische 

Imperfektionen und Einflüsse aus Nichtlinearität des Werkstoffverhaltens.   
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2.2 Feuerwiderstandsklassen nach Eurocode 

Die Klassifizierung der Bauteile erfolgt nach dem europäischen ‚Grundlagendokument 

Brandschutz’ und wird, wie in Tabelle 2-2 dargestellt, in Leistungskriterien mit verschiedenen 

Anforderungen unterteilt [vgl. 10]. 

 

Kriterium Anforderung 

R Feuerwiderstandsdauer ohne Verlust der Tragfähigkeit 

RE 
Feuerwiderstandsdauer ohne Verlust der Tragfähigkeit 

und des Raumabschlusses 

REI 
Feuerwiderstandsdauer ohne Verlust der Tragfähigkeit, 

des Raumabschlusses und der Wärmedämmung 

REI-M 
Wie REI – zusätzlich widerstandsfähig gegen 

mechanische Beanspruchung 

 Tab. 2-2: Feuerwiderstandsklassen nach Eurocode 

 

Die Tragfähigkeit ‚R’ beschreibt die Fähigkeit eines Bauteils, einer Brandbeanspruchung 

ohne Verlust der Standsicherheit für eine bestimmte Zeitdauer zu widerstehen.  

Der Raumabschluss ‚E’ ist die Eigenschaft eines Bauteils, einer einseitigen Brandeinwirkung 

standzuhalten, ohne dass eine Ausbreitung des Brandes auf die der Brandbeanspruchung 

abgewandte Seite erfolgt.  

Analog dazu bedeutet die Wärmedämmung ‚I’  die Fähigkeit eines Bauteils, einer einseitigen 

Brandeinwirkung standzuhalten, ohne dass eine signifikante Wärmeübertragung auf die 

brandabgewandte Seite erfolgt.  

Das Kriterium ‚M’ steht, wie in Tabelle 2-2 bereits beschrieben, für eine zusätzliche äußere 

mechanische Beanspruchung. 

In den jeweiligen Brandschutzteilen der Eurocodes 2 bis 6 sind Anforderungen an die 

Feuerwiderstandsdauer von 30, 60, 90, 120, 180 und 240 Minuten enthalten. So besteht die 

Anforderung an eine Stahlstütze in der Feuerwiderstandsklasse R 30 darin, im Brandfall 

einen 30-minütigen Feuerwiderstand ohne Versagen der Tragfähigkeit zu erfüllen. 

Neben den o.g. Klassifizierungen existieren noch Kennzeichnungen für die 

Strahlungsundurchlässigkeit (W), das Selbstschließen von Feuerschutzabschlüssen (C) und 

die Leckrate für Rauchdurchtritt (S).  
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2.3 Brandszenarien 

Der Temperaturverlauf eines Brandszenarios ist im Wesentlichen abhängig von der 

Brandlast, der Energiefreisetzungsrate, der Ventilation, der Materialbeschaffenheit und der 

Geometrie des Brandraumes. 

Hierbei werden nominelle Temperaturkurven und vereinfachte bzw. allgemeine 

Brandmodelle unterschieden (vgl. Kapitel 2.1.2). Die vereinfachten und allgemeinen 

Brandmodelle werden auch als Naturbrandszenarien bezeichnet, weil sie ein realitätsnahes 

Abbild der Brand- und Temperaturentwicklung durch Berechnung mit spezieller Software 

möglich machen. 

Im Folgenden werden die wesentlichen Merkmale der Einheitstemperaturkurve und der 

Naturbrandszenarien dargestellt und die Vor- und Nachteile herausgearbeitet. 

 

2.3.1 Einheitstemperaturkurve 

Die Einheitstemperaturkurve ist als ‚Umhüllende’ möglicher Brandereignisse zu verstehen 

und beschreibt den Temperaturverlauf des Rauchgases im Brandraum, sie stellt sozusagen 

den ‚worst case’ dar.  

In der DIN EN 1991-1-2 [3] ist die Temperaturkurve mit der in Gleichung 2.1 angegebenen 

Funktion definiert und in Abbildung 2-4 graphisch dargestellt. 

 

 C][)1t8(log34520Θ 10g °°°°++++××××++++====  Gl. 2.1 

mit Θg  Gastemperatur im Brandabschnitt [°C] 

 t  Zeit [min] 
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 Abb. 2-4: Einheitstemperaturkurve (ETK) nach DIN EN 1991-1-2 [3] 
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Die Temperaturkurve ist in den ersten 30 Minuten durch einen schnellen Anstieg auf 842 °C 

gekennzeichnet. Der anschließende Verlauf fällt etwas flacher aus, nach 180 Min. werden 

1110 °C erreicht.  

Bei der Temperaturermittlung wird eine unbeschränkt vorhandene Brandlast vorausgesetzt, 

was den kontinuierlichen Temperaturanstieg und die fehlende Abkühlphase im Vergleich zu 

Naturbrandkurven erklärt. 

 

2.3.2 Naturbrandszenario 

Beim Naturbrand wird unter Anwendung vereinfachter oder allgemeiner Brandmodelle  

(vgl. Kapitel 2.1.2), meist mit Hilfe von Brandsimulationsprogrammen, ein realistischer 

Temperaturverlauf ermittelt und anschließend der Nachweis der Tragfähigkeit unter 

Anwendung dieser Temperaturkurve geführt. Dabei muss nachgewiesen werden, dass der 

Widerstand der Konstruktion nach einer bestimmten Zeit größer ist als die vorhandene 

Einwirkung (Efi,d ≤ Rfi,d,t). 

Hierzu wird zunächst unter Anwendung der DIN EN 1991-1-2 Anhang E [3] der 

Bemessungswert der Brandlastdichte qf,d berechnet. Dabei werden brandlasterhöhende 

Faktoren wie auch durch Brandschutzmaßnahmen reduzierende Faktoren berücksichtigt. 

Der Ausgangswert wird mit der charakteristischen Brandlast qf,k angesetzt, die in 

Abhängigkeit der Nutzung in Tabelle E.4 mit einem Mittelwert und der 80 %-Fraktile 

angegeben ist. Ebenso kann der Tabelle E.5 die Energiefreisetzungsrate (RHR) für 

verschiedene Nutzungen entnommen werden.  

Der Temperaturverlauf ist weiterhin abhängig von Brandlastdichte, Energiefreisetzungsrate 

und Randbedingungen wie beispielsweise den Geometrie- und Ventilationsverhältnissen. Es 

wird dabei zwischen ventilations- und brandlastgesteuerten Bränden unterschieden.  

Bei einem ventilationsgesteuerten Brand ist ein Mangel an Sauerstoff dafür verantwortlich, 

dass der Temperaturanstieg flacher, aber dafür über einen längeren Zeitraum verläuft.  

Ein brandlastgesteuerter Brand ist durch Sauerstoffüberschuss und einen schnellen 

Temperaturanstieg gekennzeichnet, allerdings ist die Dauer der Temperaturspitze deutlich 

kürzer und es kommt früher zu einer Temperaturabsenkung. 

 

2.3.3 Normbrand versus Naturbrand 

Nominelle Temperaturkurven, wie beispielsweise die Einheitstemperaturkurve, setzen mit 

dem stetigen Anstieg der Brandraumtemperatur eine unbegrenzte Brandlast voraus. An 

dieser Vorgabe ist bereits zu erkennen, dass hiermit kein reales Brandereignis beschrieben 

werden wird.  
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Aus dieser Erkenntnis entstand in den letzten Jahren die Entwicklung von 

Naturbrandkonzepten und deren Validierung mit real durchgeführten Großbrandversuchen 

als wichtiger Schwerpunkt der brandschutztechnischen Bemessung. Die verfügbaren 

Berechnungen und Brandsimulationsmodelle geben Ingenieuren ein geeignetes Werkzeug 

an die Hand, Naturbrände und daraus resultierende Temperatur- und Rauchentwicklung 

möglichst realitätsnah zu berechnen und zu simulieren. So werden oftmals ein rascherer 

Temperaturanstieg und eine höhere Temperaturspitze gegenüber der 

Einheitstemperaturkurve erreicht, jedoch tritt nach Erschöpfen der Brandlast ein Abklingen 

der Temperatur (Abkühlphase) ein. 

Dennoch ist die Einheitstemperaturkurve in vielen Normen zu finden und bildet die 

Grundlage für Bauteilklassifizierungen anhand von Tabellenwerken.  

Insbesondere bei geringeren Brandlastdichten und bei einer Feuerwiderstandsdauer über 30 

Minuten erzielt der Nachweis mit einer Naturbrandkurve realere und damit deutlich 

effizientere Ergebnisse. Die Berechnung einer Naturbrandkurve erfordert allerdings auch 

einen höheren Zeitaufwand im Vergleich zur Einheitstemperaturkurve. 

Abbildung 2-5 stellt die Einheitstemperaturkurve im Vergleich zum Naturbrand und 

vorhandener Brandschutzmaßnahmen dar und verdeutlicht die zuvor gewonnenen 

Erkenntnisse.  

 

 Abb. 2-5: Einheitstemperaturkurve im Vergleich zur Naturbrandkurve [20] 

 

Es ist zu erkennen, dass bei nicht vorhandenen oder einem Versagen der 

Brandschutzmaßnahmen die Temperaturspitze einer Naturbrandkurve oberhalb der 

Temperatureinheitskurve liegen kann. Bei wirkungsvollen Brandschutzmaßnahmen, z.B. 

einer vorhandenen Sprinkleranlage, wird die Brandentstehung frühzeitig eingedämmt und 

der Temperaturverlauf fällt entsprechend flacher aus. Abgebildet ist auch die o.g. 

charakteristische Temperaturabsenkung in der Abkühlphase. 
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3 Thermische Analyse von Stahl im Brandfall 

Bei der thermischen Analyse von Stahlkonstruktionen sind für den Brandfall verschiedene 

Eigenschaften zu berücksichtigen, die sich auf die Erwärmung eines Querschnittes 

auswirken und einer differenzierten Betrachtung bedürfen. 

Zum einen muss der Wärmeübergang von der Heißgasschicht zur Stahloberfläche betrachtet 

werden, zum anderen bewirkt die Wärmeleitung eine Temperaturverteilung innerhalb des 

Stahls. 

Die Berechnungsvorgaben aus der DIN EN 1991-1-2 [3] bzw. der DIN EN 1993-1-2 [7] und 

die entsprechenden physikalischen Vorgänge werden im Folgenden detailliert erläutert. 

 

3.1 Wärmeübergang 

Der Wärmeübergang ist als Netto-Wärmestrom definiert und beschreibt allgemein den 

Vorgang des Temperaturüberganges auf die Stahloberfläche. Physikalisch gesehen wird 

dieser in einen Strahlungs- und einen Konvektionsanteil unterteilt, die nachfolgend noch 

einzeln betrachtet werden. 

Die Randbedingungen werden über den Netto-Wärmestrom des den Stahl umgebenden 

Raumes beschrieben und sind u.a. abhängig vom gewählten Brandszenario und von der 

Beschaffenheit des Bauteiles. Als Anfangsbedingung wird üblicherweise eine 

Raumtemperatur von 20 °C angenommen. 

In der DIN EN 1991-1-2 [3] wird der Netto-Wärmestrom, unter Berücksichtigung der 

Wärmeübertragung durch Konvektion und Strahlung, mit Gleichung 3.1 angegeben. 

 

 net,rnet,cnet hhh &&& ++++====  Gl. 3.1 

 

3.1.1 Konvektion  

Unter Konvektion versteht man im Allgemeinen den Transport thermischer Energie in 

Fluiden, also Gasen oder Flüssigkeit. Die Wärmeübertragung findet durch den Austausch 

von Teilchen zwischen Fluid und Festkörper statt, wobei Wärmeenergie übertragen wird. 

Der konvektive Anteil wird nach DIN EN 1991-1-2 [3] mit folgender Formel berechnet und 

anschließend in Gleichung 3.1 eingesetzt. 

 

 [W/m²])(αh mgcnet,c θθθθ−−−−θθθθ××××====&  

mit αc  Wärmeübergangskoeffizient für Konvektion [W / m²K] 
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θg Gastemperatur in der Umgebung des beanspruchten Bauteils [°C] 

θm Oberflächentemperatur des Bauteils [°C] 

 

Als Gastemperatur dürfen nach DIN EN 1991-1-2 [3] nominelle Temperaturkurven oder die 

mit Hilfe von Naturbrandszenarien ermittelten Temperaturverläufe verwendet werden. Die 

Oberflächentemperatur lässt sich mit Brandsimulationsprogrammen (FDS, MRFC etc.) 

bestimmen. 

Der konvektive Wärmestrom kann proportional zum Temperaturunterschied (θg – θm) 

angenommen werden und wird durch den Wärmeübergangskoeffizienten gekennzeichnet. 

Dieser beschreibt die Fähigkeit eines Gases, Energie von der Oberfläche eines Stoffes 

abzuführen bzw. an die Oberfläche abzugeben. In der DIN EN 1991-1-2 [3] ist der 

Wärmeübergangskoeffizient, abhängig von dem gewählten Brandmodell, vorgegeben und in 

Tabelle 3-1 dargestellt. 

 

Brandszenario 
Wärmeübergangskoeffizient ααααc 

[W/m²K] 

Einheitstemperaturkurve 25 

Außenbrandkurve 25 

Hydrokarbon-Brandkurve 50 

Vereinfachte Brandmodelle 35 

Allgemeine Brandmodelle 35 

 Tab. 3-1: Wärmeübergangskoeffizient αc [3] 

 

3.1.2 Strahlung 

Wärmestrahlung, auch als thermische Strahlungsemission bezeichnet, beschreibt in der 

Physik den Transport thermischer Energie in Form elektromagnetischer Strahlung. Anders 

als bei der Konvektion und Wärmeleitung ist der Mechanismus der Wärmestrahlung auch im 

Vakuum möglich. 

Steht ein Körper im thermischen Gleichgewicht mit seiner Umgebung, so sind Emission und 

Absorption gleich groß. Hat er jedoch eine größere Temperatur, emittiert er mehr als er 

absorbiert, kühlt ab und erwärmt die Umgebung bis zum erneuten Gleichgewicht. 

Der ‚schwarze Körper’ ist in der Physik ein idealisiertes Modell, welches die gesamte 

einfallende Strahlung absorbiert und daher auch eine maximale Emission (ε = 1) hat. So 

lassen sich im Versuch die Emissionsgrade jedes beliebigen Körpers bestimmen, als 

Referenzwert gilt der ‚schwarze Körper’.  
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In Tabelle 3-2 ist der Emissionsgrad für verschiedene Stoffe angegeben. Zu beachten ist, 

dass der Emissionsgrad abhängig von der Temperatur und damit der Wellenlänge ist, bei der 

gemessen wird. 

 

 

 

 

 

 

 

 

 

 

 

Tab. 3-2: Emissionsgrade verschiedener Materialien bei Raumtemperatur 

 

Nach dem Strahlungsgesetz von Stephan-Boltzmann wird über die so genannte 

Strahlungstemperatur der Brandumgebung die maximale Strahlung ermittelt. Bei 

konservativer Betrachtung kann gezeigt werden, dass die Strahlungstemperatur gleich der 

Gastemperatur angesetzt werden darf.  

Dies bildet die Grundlage zur Berechnung des Netto-Wärmestroms durch Strahlung, ist nach 

DIN EN 1991-1-2 [3] zu folgender Formel bestimmt und kann ebenfalls in Gleichung 3.1 

eingesetzt werden. 

  

 (((( )))) (((( ))))[[[[ ]]]] [[[[ ]]]]²m/W273273h
4

m

4

rfmr,net ++++θθθθ−−−−++++θθθθ××××σσσσ××××εεεε××××εεεε××××ΦΦΦΦ====&  

mit Φ  Konfigurationsfaktor 

 ε m Emissivität der Bauteiloberfläche 

 ε f Emissivität des Feuers 

 σ Stephan – Boltzmann – Konstante ( = 5,67 x 10-8 W/m²K4 ) 

θr wirksame Strahlungstemperatur des Brandes [°C] 

θm Temperatur der Bauteiloberfläche [°C] 

 

Die Emissivität der Bauteiloberfläche ist Tabelle 3-2 oder entsprechender Literatur zu 

entnehmen. Falls der Wert nicht bekannt ist, kann hier vereinfachend εm = 0,8 angesetzt 

werden. Die Emissivität der Flamme darf nach DIN EN 1991-1-2 [3] mit  

Material Emissionsgrad ε 

Schwarzer Körper  1,0 

Feuer 1,0 

Glas 0,94 

Holz 0,94 

Stahl 0,70 

Beton 0,70 
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εf = 1,0 angenommen werden. Wenn das betrachtete Bauteil vollständig von Flammen 

eingeschlossen ist, kann die Strahlungstemperatur durch die Gastemperatur der 

Bauteilumgebung ausgedrückt werden (θr = θg). 

Der Konfigurationsfaktor berücksichtigt Größe der strahlenden Oberfläche, den Abstand 

zwischen strahlender und empfangender Fläche und deren Orientierung zueinander sowie 

Abschattungseffekte, wie sie beispielsweise bei I-Profilen auftreten. In Anhang G der DIN EN 

1991-1-2 [3] ist das genaue Verfahren für die Berechnung des Konfigurationsfaktors 

erläutert, auf der sicheren Seite liegend kann er mit Φ = 1,0 angenommen werden. 

 

3.2 Wärmeleitung 

Unter Wärmeleitung versteht man den Wärmefluss in Fluiden oder Feststoffen, der sich bei 

einer Temperaturdifferenz einstellt und nach dem zweiten Hauptsatz der Thermodynamik 

stets in Richtung der niedrigeren Temperatur gerichtet ist. Die Wärmeleitung ist maßgeblich 

von der Dichte, der spezifischen Wärmekapazität, des Wärmeleitkoeffizienten und der 

Temperatur eines Stoffes abhängig.  

Unterschieden wird zwischen stationärem und instationärem Temperaturfeld, wobei im 

Brandfall eine Temperaturänderung über die Zeit angesetzt wird und so der instationäre Fall 

betrachtet werden muss. 

Bei einem eindimensionalen System mit stationärem Temperaturfeld, also konstanter 

Temperatur, kann die übertragene Wärmeleistung unter Anwendung des ‚Fourierschen 

Gesetzes’ ausgedrückt und berechnet werden zu 

 

 (((( ))))21 TTA
δ

λ
Q ××××××××××××====&  

mit λ  Wärmeleitkoeffizient 

δ Elementdicke 

A Fläche des durchströmten Elementes 

T1  Temperatur der wärmeren Oberfläche 

T2 Temperatur der kälteren Oberfläche 

 

Für ein dreidimensionales Modell mit instationärem Temperaturfeld ist eine Berechnung nur 

über die ‚Fouriersche Differentialgleichung’ möglich, die hier auf Grund der komplexen 

mathematischen Berechnung nicht weiter betrachtet werden soll.  

Der Werkstoff Stahl verfügt über eine gute Wärmeleitfähigkeit (vgl. Kapitel 4.1.1.3), daher 

werden vereinfachend eine gleichmäßige Erwärmung entlang der lokalen Bauteilachse und 

ein homogenes Temperaturgefüge über den Querschnitt angenommen.  
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Daraus resultierend wird in der DIN EN 1993-1-2 [3] für innenliegende Stahlkonstruktionen 

der folgende, vereinfachte Ansatz zur Entwicklung der Stahltemperatur angegeben, wobei 

zwischen Temperaturanstieg in einem geschützten und ungeschützten Stahlbauteil 

differenziert werden muss. 

 

� ungeschützter Stahl 

 C][∆th
ρc

/VA
k∆θ net

aa

m
sha,t °°°°××××××××

××××
==== &  Gl. 3.2 

             

� geschützter Stahl 

 t,g

10φ/a,tg,t

aap

pp

a,t ∆θ)1(e∆t
)3φ/1(

)θ(θ

ρcd

/VAλ
∆θ ××××−−−−−−−−××××

++++

−−−−
××××

××××××××
====  Gl. 3.3 

 

mit /VAd
ρc

ρc
φ pp

aa

pp
×

×

×
=  

 ksh Korrekturfaktor für den Abschattungseffekt [-] 

 Ai/V Profilfaktor des ungeschützten / geschützten Stahlbauteils [1/m] 

 Ai die dem Brand ausgesetzte Oberfläche des Bauteils pro Längeneinheit [m²/m] 

 V Volumen des Bauteils pro Längeneinheit [m³/m] 

 ca spezifische Wärmekapazität von Stahl [J/kgK]; siehe Kapitel 4.1.1.2 

 cp spezifische Wärmekapazität des Brandschutzmaterials [J/kgK] 

 ρa Rohdichte von Stahl [kg/m³]; siehe Kapitel 4.1.1.1 

 ρp Rohdichte des Brandschutzmaterials [kg/m³] 

 θ a,t Stahltemperatur zum Zeitpunkt t [°C] 

 θ g,t Umgebungstemperatur zum Zeitpunkt t [°C] 

 ∆θ g,t Anstieg der Umgebungstemperatur während des Zeitintervalls ∆t [°C] 

 dp Dicke des Brandschutzmaterials 

 neth&  flächenbezogener Bemessungswert des Nettowärmestroms [W/m²]; siehe Gl. 3.1 

 ∆t Zeitintervall [sec] 

 λp Wärmeleitfähigkeit des Brandschutzmaterials 

  

Der Korrekturfaktor ksh berücksichtigt den beispielsweise bei I-förmigen Profilen auftretenden 

Abschattungseffekt der Flansche. Hierbei wird die Wärmestrahlung behindert und der 

Temperaturanstieg im Bauteil verläuft langsamer. Für eine konservative Berechnung oder 

erste Abschätzung kann ksh mit 1,0 angenommen werden.  

Dieser Effekt tritt allerdings nur bei ungeschützten Profilen auf und wird bei geschützten 

Stahlprofilen nicht berücksichtigt (vgl. Gl. 3.3). 
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Die Berechnung der Bauteiltemperaturen nach Gleichung 3.2 für ungeschützte 

Stahlkonstruktionen gilt laut DIN EN 1993-1-2 [3] ausschließlich für Profilfaktoren größer  

10 m-1 und Zeitintervalle von ∆t ≤ 5 Sekunden.  

Für die Temperaturberechnung von geschützten Stahlbauteilen ist in Gleichung 3.3 das 

Zeitintervall auf ∆t ≤ 30 Sekunden zu beschränken. 

Zur Berechnung der Gleichung 3.1 und 3.2 sind in [8] zwei Excel-Makros beschrieben, mit 

denen  sich die Formeln in Abhängigkeit von den verschiedenen Parametern berechnen 

lassen.  

Alternativ kann die Temperaturermittlung für ungeschützte Stahlkonstruktionen auch mit Hilfe 

der Näherungsformel, entwickelt an der Universität Hannover, berechnet werden  

(vgl. Kapitel 5.1.1). 

 

3.3 Stahltemperatur in Abhängigkeit vom Profilfaktor 

Im Folgenden soll der Temperaturverlauf von Stahlprofilen verschiedener Profilfaktoren in 

Abhängigkeit von der Temperaturbeaufschlagung durch die Einheitstemperaturkurve 

ermittelt werden. 

Der Profilfaktor gibt das Verhältnis zwischen der dem Brand ausgesetzten Stahloberfläche 

und dem Stahlvolumen an, ist also eine Maßzahl für die Schlankheit eines Bauteiles. Je 

schlanker ein Stahlprofil, desto größer der Profilfaktor und umgekehrt.  

Es wird dabei zwischen ungeschützten und geschützten Stahlbauteilen unterschieden. Die 

genauen Berechnungsverfahren zur Ermittlung des Profilfaktors sind in Kapitel 4.2.5.1 und 

4.2.5.2 der DIN EN 1993-1-2 [7] mit entsprechenden Abbildungen zu finden. Die Werte 

können alternativ entsprechenden Tabellen entnommen werden, in denen Profilfaktoren 

abhängig von Profil und Brandschutzsystem angegeben sind [14]. 

 

3.3.1 Ungeschützte Stahlprofile 

Am häufigsten werden ungeschützte Stahlprofile als dreiseitig beflammte und durch die 

aufliegende Betonplatte geschützte Deckenträger oder als Stützen bzw. Träger mit 

vierseitiger Beflammung eingesetzt.  

Kennzeichnend für nicht verkleidete Bauteile ist, dass ein Wärmeübergang von der 

Heißgasschicht in den Stahl ungehindert möglich ist und so auf Grund der thermischen und 

mechanischen Eigenschaften von Stahl ein rascher Temperaturanstieg und damit 

verbundener Festigkeitsverlust im Querschnitt auftritt. 

Zur Analyse wurden in SAFIR unbekleidete Stahlprofile verschiedener Schlankheiten mit 

vierseitiger Beflammung berechnet. Anschließend wurden die Ergebnisse für 10 Min.,  
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20 Min. und 30 Min. ausgewertet und sind in Abbildung 3-1 dargestellt. Abgebildet ist die 

Temperaturentwicklung im Stahl in Abhängigkeit vom Profilfaktor für die drei vorgenannten 

Zeitstufen.  
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 Abb. 3-1: Stahltemperatur in Abhängigkeit vom Profilfaktor für ungeschützte Bauteile  

 

Bei t = 10 min ist festzustellen, dass Profilfaktoren unter 200 m-1 eine deutliche Reduzierung 

der Temperatur im Querschnitt gegenüber der Brandtemperatur bewirken. So heizt sich eine 

IPE 360 (Am/V = 186) nur noch auf 547 °C auf, was gegenüber der Gastemperatur von  

678 °C eine Differenz von 19,3 % bedeutet. 

Mit der Zeitstufe t = 20 min relativiert sich diese Differenz zwischen Gas- und 

Stahltemperatur und liegt mit einer Stahltemperatur von 732 °C nur noch 6,2 % unter der 

Temperatur im Brandraum. 

Bei t = 30 min wird schließlich eine Stahltemperatur von 825 °C erreicht und der Unterschied 

zur Heißgastemperatur beträgt lediglich noch 17 °C oder 2,0 %. 

Lässt sich bei kurzer Branddauer mit Profilfaktoren größer als 100 m-1 noch eine effiziente 

Reduzierung der Bauteiltemperatur bewirken, so ist bei 30-minütiger Feuerbeanspruchung 

ein Profilfaktor unterhalb von 50 m-1 notwendig. 

Die Wahl eines größeren Profils und die Reduzierung des Profilfaktors finden bei dem so 

genannten ‚Overmarching’ Anwendung, da sich mit den daraus resultierenden niedrigeren 

Temperaturen eine höhere Tragfähigkeit im Brandfall erzielen lässt und so häufig eine 

Feuerwiderstandsdauer von 30 Minuten nachgewiesen werden kann. 

Die genaue Vorgehensweise wird in Kapitel 5.2 näher beschrieben und an Hand von 

Anwendungsbeispielen vorgestellt.  
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3.3.2 Geschützte Stahlprofile 

Um Stahlprofile im Brandfall vor der äußeren Temperatureinwirkung zu schützen, bieten sich 

verschiedene Methoden an. 

Es gibt die Möglichkeit, Profile mit profilfolgender Verkleidung vor direkter 

Brandbeanspruchung zu schützen. Hier gibt es verschiedene Ausführungen wie z.B. eine 

Beschichtung mit Spritzputz oder spezielle Anstriche, die im Brandfall aufquellen und so eine 

wärmedämmende Schicht bilden.  

Außerdem können Profile mittels einer Kastenverkleidung, beispielsweise 

Brandschutzplatten aus Gipskarton, vor direkter Beflammung geschützt werden. So kann im 

Bedarfsfall eine Feuerwiderstandsdauer von R 30 und höher zuverlässig realisiert werden. 

Hierbei ist für jede Baumaßnahme eine individuelle Betrachtung notwendig, da 

Kastenverkleidungen zwar günstiger als feuerhemmende Anstriche o.ä. sind, jedoch deren 

Montage mit zusätzlichem Zeitaufwand verbunden ist.  

In Abbildung 3-2 ist eine Kostenschätzung für verschiedene Brandschutzbekleidungen zur 

Veranschaulichung aufgeführt. 

 

 

 Abb. 3-2: Kostenschätzung für Brandschutzmaßnahmen [11] 

 

In nachfolgender Abbildung 3-3 ist die Stahltemperatur in Abhängigkeit vom Profilfaktor für 

verkleidete Stahlprofile unter Brandbeanspruchung der Einheitstemperaturkurve (ETK) 

dargestellt. Abgebildet ist der Zustand nach 90 Minuten, bei dem die ETK eine Temperatur 

von 1006 °C aufweist.  
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 Abb. 3-3: Stahltemperatur in Abhängigkeit vom Profilfaktor für geschützte Bauteile [17] 

 

Festzustellen ist, dass eine Bekleidungsstärke von 15 - 25 mm bei schlankeren 

Querschnitten für eine Branddauer von 90 Minuten keine deutlich niedrigere Stahltemperatur 

bewirkt. 

Bei einer Stärke der Brandschutzplatten von 35 - 60 mm ist jedoch auch bei Profilfaktoren 

größer als 300 m-1, also schlankeren Profilen, eine effiziente Reduzierung der 

Bauteiltemperatur möglich. 

 

3.4 Thermische Einwirkungen für die Temperaturberechnung 

Nach DIN EN 1991-1-2 [3] stehen, wie auch in Tabelle 2-1 dargestellt, verschiedene 

Brandmodelle für die thermische Einwirkung und anschließende Temperaturberechnung von 

Stahlbauteilen zur Verfügung (vgl. Kapitel 2.1.2). 

Hier ist neben den nominellen Temperaturkurven wie der Einheitstemperaturkurve  

(vgl. Kapitel 2.3.1) die Berechnung von Naturbrandmodellen aufgeführt. Diese werden in 

allgemeine und vereinfachte Brandmodelle unterteilt und im Folgenden erläutert. 

 

3.4.1 Vereinfachte Brandmodelle 

3.4.1.1 Vollbrand 

In Anhang A der DIN EN 1991-1-2 [3] wird ein Verfahren zur Berechnung von 

parametrischen Temperaturzeitkurven beschrieben, mit denen der Brandverlauf eines 

Vollbrandes für kleine und mittlere Räume bestimmt werden kann. Neben der 

Brandlastdichte, der Abbrandgeschwindigkeit des Brandmaterials und der Eigenschaften der 

Umfassungsbauteile wird auch die Sauerstoffzufuhr über den Ansatz des Öffnungsfaktors 

berücksichtigt. 
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Die parametrischen Temperaturzeitkurven wurden empirisch ermittelt und haben daher 

keinen Bezug zu dem in Anhang E der DIN EN 1991-1-2 [3] aufgeführten Bemessungsbrand 

auf der Grundlage von Brandlastdichte und Energiefreisetzungsrate. Diese Lastannahme ist 

daher nach einer Untersuchung von Professor Hosser [26] für eine Anwendung in 

Deutschland ungeeignet.  

Stattdessen wird ein vereinfachtes Brandmodell nach [11] empfohlen, das vom 

Brandszenario über den Bemessungsbrand bis zum Temperaturzeitverlauf konsistent 

formuliert ist und ebenfalls mit geringem Aufwand angewendet werden kann.  

 

3.4.1.2 Lokaler Brand 

Anhang C der DIN EN 1991-1-2 [3] stellt ein Verfahren zur Berechnung thermischer 

Einwirkung von lokal begrenzten Bränden vor. Das Verfahren beruht auf physikalisch 

richtigen Ansätzen. Vergleichsberechnungen mit FDS haben beispielhaft gezeigt, dass das 

Verfahren zu richtigen Ergebnissen führt [vgl. 25]. Nachteilig ist, dass beeinflussende 

Parameter wie Ventilationsbedingungen und anlagentechnische bzw. abwehrende 

Brandschutzmaßnahmen nicht berücksichtigt werden können.   

Eingangsdaten sind neben der Ausbreitung des Feuers in Form des Durchmessers die 

Energiefreisetzungsrate (RHR), die Raumhöhe und die horizontale Entfernung des 

betrachteten Querschnittes zum Brandherd. 

Anwendungsvoraussetzung ist, dass während der gesamten Branddauer kein ‚flash-over’ 

eintritt, daher muss der Brandraum mindestens eine Größe von 400 m² und eine nicht 

gleichmäßig verteilte Brandlast aufweisen. Der Durchmesser des Brandes ist auf maximal  

10 m beschränkt und die Energiefreisetzungsrate muss kleiner als 50 MW sein. 

 

3.4.1.3 Berechnungsbeispiel - Lokaler Brand 

Im folgenden Beispiel soll die Wärmestromdichte für einen lokalen Brand nach  

DIN EN 1991-1-2 [3] Anhang C (vgl. Kapitel 2.1.2) berechnet und daraus die maximale 

Temperatur für zwei angrenzende ungeschützte Deckenträger ermittelt werden (vgl. [8]). 

Als Brandszenario wird ein brennendes Fahrzeug in einer geschlossenen Parkgarage mit 

einer lichten Höhe von H = 3,0 m angenommen. Die Energiefreisetzungsrate für einen PKW-

Brand kann mit Q = 5 MW gewählt werden, die Abmessungen des Fahrzeuges betragen  

4,5 m in der Länge und 1,80 m in der Breite (A = 8,1 m²).  

Der horizontale Abstand der Stahlprofile zum Mittelpunkt des Brandherdes beträgt r = 3,50 m 

bzw. r = 1,50 m. 

Die o.g. Maße sind in Abbildung 3-4 an Hand einer Skizze schematisch dargestellt. 
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 Abb. 3-4: Lokaler Brand nach DIN EN 1991-1-2 Anhang C [3] 

 

 Durchmesser des Feuers: 
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×π
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×π
=  

 

 Flammenlänge eines lokalen Brandes: 

 ( ) H80,31050148,021,302,1Q0148,0D02,1L
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f ≥=××+×−=×+×−=  

 

 Beiwert *

DQ : 

 ( ) 0,1244,021,31011,1/105D1011,1/QQ 5,2665,26*

D ≤=×××=××=  

 

 Vertikale Lage des gedachten Brandherdes: 

 ( ) ( ) m39,1244,0244,021,34,2QQD4,2'z 67,04,067,0*

D

4,0*

D =−×=−×=  

 

 Dimensionslose Energiefreisetzungsrate: 

 ( ) ( ) 413,06,21011,1/105H1011,1/QQ 5,2665,26*

H =×××=××=  

 

 Horizontale Flammenausbreitung: 

 ( )( ) ( )( ) m03,36,2413,06,29,2HQH9,2L
33,033,0*

HH =−×=−=  

 (Brandherd wird 0,4 m oberhalb des Bodens angenommen → H = 2,60 m) 
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 Wärmestromdichte Stahlprofil 1: 

 ²m/kW7,11²m/W1167807,115000y15000h 7,37,3 ==×=×= −−&  

  

 Parameter Stahlprofil 2 (r = 1,5 m): 

 78,0
39,16,203,3

39,16,25,1

'zHL

'zHr
y

H

=
++

++
=

++

++
=  

 

 Wärmestromdichte Stahlprofil 2: 

 ²m/kW6,37²m/W3761378,015000y15000h 7,37,3 ==×=×= −−&  

 

Der Netto-Wärmestrom in der brandbeanspruchten Fläche in Höhe der Decke lässt sich 

nach DIN EN 1991-1-2 [3] mit Gleichung 3.4 berechnen und kann anschließend in Gleichung 

3.2 zur Berechnung der Stahltemperatur eingesetzt werden. Diese Berechnung ist von 

verschiedenen Parametern abhängig und daher nur mit beispielsweise einem Excel-Makro 

möglich [vgl. Kapitel 3.2]. 

Die in Gleichung 3.4 beschriebene Formel lässt sich aber vereinfachend auch in 

Abhängigkeit von der Umgebungstemperatur des Bauteiles ausdrücken.  

Wird die Temperatur der Bauteiloberfläche θm mit der Umgebungstemperatur θg und der 

Strahlungstemperatur des Brandes θr gleichgesetzt, so ist der resultierende Netto-

Wärmestrom gleich null ( 0h net =& ). 

Der Wärmeübergangskoeffizient für vereinfachte Brandmodelle kann, wie in Kapitel 3.1.1 

beschrieben, mit αc = 35 W/m²K angesetzt werden. Der Konfigurationsfaktor und die 

Emissivität des Stahls bzw. der Flamme werden analog zu Kapitel 3.1.2 gewählt.  

Werden die o.g. Parameter in Gleichung 3.4 eingesetzt und die Formel entsprechend 

umgestellt, so steht mit Gleichung 3.5 eine Berechnungsformel der Wärmestromdichte in 

Abhängigkeit von der Umgebungstemperatur des Bauteiles zur Verfügung.  

 

 (((( )))) (((( ))))[[[[ ]]]] ²]m/W[29327320hh 44

mfmmcnet −−−−++++θθθθσσσσ××××εεεε××××εεεε××××φφφφ−−−−−−−−θθθθαααα−−−−==== &&    Gl. 3.4 

 

 (((( )))) (((( ))))[[[[ ]]]] ²]m/W[2932731067,50,17,00,12035h
44

g

8

g −−−−++++θθθθ××××××××××××××××++++−−−−θθθθ××××==== −−−−&     Gl. 3.5 

 

Abschließend lässt sich mit Gleichung 3.5 ein Funktionsgraph (Abb. 3-5) in Abhängigkeit von 

der Umgebungstemperatur des Bauteiles erstellen, wonach sich die maximal mögliche 

Stahltemperatur mit Hilfe der zuvor berechneten Wärmestromdichte h&  ermitteln lässt.  



Thermische Analyse von Stahl im Brandfall  

  Seite 25  

 

0
100
200
300
400
500
600
700
800
900

1000

0,0 10,0 20,0 30,0 40,0 50,0 60,0 70,0 80,0 90,0 100,0

Wärmestromdichte  [kW/m²]

U
m

g
eb

u
n

g
st

em
p

er
at

u
r 

[°
C

]

 

 Abb. 3-5: Wärmestromdichte in Abhängigkeit von der Umgebungstemperatur 

 

Das Stahlprofil mit einem horizontalen Abstand von 3,50 m und einer Wärmestromdichte von 

11,7 kW/m² erreicht somit eine Stahltemperatur von maximal 260 °C. Für das auf der 

horizontalen Achse näher am Brandherd gelegene Stahlbauteil lässt sich anhand des 

Funktionsgraphen eine Bauteiltemperatur von maximal 560 °C ermitteln. 

Die Wärmestromdichte für den lokalen Brand nach DIN EN 1991-1-2 [3] ist auf 100 kW/m² 

begrenzt, so dass unter o.g. vereinfachten Annahmen eine Heißgastemperatur von 880 °C 

nicht überschritten wird und damit Bauteiltemperaturen oberhalb dieser Grenze 

ausgeschlossen werden können. 

 

3.4.2 Allgemeine Brandmodelle 

Anhang D der DIN EN 1991-1-2 [3] beschreibt die Grundlagen der Anwendung erweiterter 

bzw. allgemeiner Brandmodelle. Sie stellen eine Alternative zur Berechnung der 

Temperaturentwicklung in einem Brandraum dar und werden mit 

Brandsimulationsprogrammen (FDS, OZone, MRFC, etc.) ermittelt. Die Brandmodelle 

werden nach DIN EN 1991-1-2 [3] wie folgt unterteilt und unterscheiden sich durch ihre 

Leistungsfähigkeit und Berechnungsgenauigkeit. So stehen zur Berechnung des 

Temperaturverlaufes Ein-Zonen-Modelle, Zwei-Zonen-Modelle und Feld-Modelle zur 

Verfügung. 

Ein-Zonen-Modelle sollten für die Randbedingungen nach dem Feuerüberschlag verwendet 

werden. Dabei wird eine gleichmäßige Verteilung der Temperatur, der Dichte, der inneren 

Energie und des Gasdruckes im Brandabschnitt unterstellt. 

Die Grundannahme für ein Zwei-Zonen-Modell ist eine Heißgasschicht unter der Decke, die 

Verbrennungsprodukte aufnimmt, und eine darunter liegende kältere Rauchgasschicht. 

Dieses Modell ist für den Zeitraum der Brandentwicklung zutreffend. 
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Mit dem Programm OZone ist beispielsweise eine kombinierte Berechnung der beiden o.g. 

Modelle möglich. So erfolgt die Berechnung während der Brandentwicklung als Zwei-Zonen-

Modell und bei Erreichen des ‚flash-over’, also des Vollbrandes im Brandraum, wird 

automatisch auf das Ein-Zonen-Modell umgeschaltet. 

Die Feld-Modelle, so genannte rechnergestütze Fluid-Dynamik-Modelle (z.B. FDS), dürfen 

zur numerischen Lösung der partiellen Differenzialgleichungen, die an allen Orten des 

Brandabschnittes die thermodynamischen und aerodynamischen Unbekannten liefern, 

verwendet werden.  
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4 Berechnung der Tragfähigkeit im Brandfall 

In diesem Kapitel wird die allgemeine Vorgehensweise für eine brandschutztechnische 

Bemessung der Tragfähigkeit vorgestellt werden.  

Als Grundlage hierfür werden neben der in Kapitel 2 beschriebenen Eurocodes 1 und 3 noch 

die DIN EN 1990 [1] benötigt, worin allgemeine Grundlagen der Tragwerksplanung 

festgeschrieben sind.  

Der Lastfall Brand ist in den Normen als außergewöhnliche Einwirkung definiert und bedarf 

daher besonderer Bemessungs- und Konstruktionsregeln. 

 

4.1 Materialeigenschaften von Stahl 

Die Materialeigenschaften von Stahl unter erhöhter Temperatur unterscheiden sich 

maßgeblich von denen bei Raumtemperatur und haben u.a. Auswirkungen auf die 

Temperaturbeständigkeit und damit das Tragverhalten von Stahlkonstruktionen im Brandfall.  

In der DIN EN 1993-1-2 [7] werden diese materialspezifischen Eigenschaften entsprechend 

berücksichtigt und bilden die Grundlage für die ‚heiße Bemessung’. 

Sie können allgemein in thermische und mechanische Eigenschaften gegliedert werden und 

sollen im Folgenden aufgezeigt und erläutert werden. 

 

4.1.1 Thermische Eigenschaften 

Die thermischen Eigenschaften von Stahl gliedern sich in folgende Punkte 

  

� Dichte 

� Spezifische Wärmekapazität 

� Wärmeleitfähigkeit 

� Thermische Dehnung 

 

Im Folgenden sollen diese o.g. Eigenschaften näher erläutert werden. 

 

4.1.1.1 Dichte 

Die Dichte eines Stoffes beschreibt das Verhältnis der Masse je Volumeneinheit. Die Dichte 

eines Materials ist abhängig von Temperatur und Druck, was sich insbesondere bei 

gasförmigen Stoffen auswirkt. 
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Die Rohdichte von Stahl kann nach DIN EN 1993-1-2 [7] Kapitel C.2.2 mit  

ρa = 7.850 kg/m³ als konstant angenommen werden, da der Einfluss von 

Temperaturschwankungen als gering einzuschätzen und so zu vernachlässigen ist. 

In Tabelle 4-1 sind für verschiedene Stoffe die jeweiligen Dichten als Vergleich aufgeführt. 

 

Material Dichte [kg/m³] 

Stahl 7.850 

Glas 2.500 

Beton 2.400 

Kalksandstein 1.000 – 2.200 

Wasser 1.000 

Holz  310 - 700 

 Tab. 4-1: Rohdichte verschiedener Stoffe bei Raumtemperatur [21] 

 

4.1.1.2 Spezifische Wärmekapazität 

Wärmekapazität ist als notwendige Wärmemenge zur Erwärmung eines Körpers in 

Proportion zur Masse des Körpers und der zu erzielenden Temperaturdifferenz definiert. 

Dieser Proportionalitätsfaktor wird als spezifische Wärmekapazität mit der Einheit J/kgK 

bezeichnet. Er gibt an, welche Wärmemenge einem Kilogramm einer Masse zuzuführen ist, 

um seine Masse um die Differenz ∆T = 1 K zu erhöhen. 

Die spezifische Wärmekapazität von Stahl kann nach DIN EN 1993-1-2 [7] anhand folgender 

Gleichungen ermittelt werden. 

 

 

 J/kgKθ1034,1θ1091,2θ280,0450c 3

a

72

a

4

aa

−− ×+×−×+=  C600θC20 a °<≤°  

 J/kgK
θ738

13002
666c

a

a
−

+=  C735θC600 a °<≤°   

 kgK/J
731

17820
545c

a

a
−θ

+=  C900θC735 a °<≤°   

 J/kgK650ca =  C1200θC650 a °<≤°  

mit  ca spezifische Wärmekapazität [J/kgK] 

 θa Stahltemperatur [°C]  
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In Abbildung 4-1 ist der Graph in Abhängigkeit von der Temperatur dargestellt. Auffallend ist 

der bei ca. 700 °C stark ansteigende, asymptotische Verlauf der Funktionskurve. Hier findet 

eine temperaturbedingte Umwandlung von α-Mischkristallen in γ-Mischkristalle statt. Die so 

hervorgerufene Gefügeänderung mit einem geringeren spezifischen Volumen im Stahl hat 

einen Anstieg der spezifischen Wärmekapazität zur Folge.  

 

 

 Abb. 4-1: Spezifische Wärmekapazität in Abhängigkeit von der Temperatur [7] 

 

Des Weiteren ist in Tabelle 4-2 eine Aufstellung verschiedener Materialien mit der jeweiligen 

spezifischen Wärmekapazität bei Raumtemperatur zu finden. 

 

Material Spez. Wärmekapazität  [J/kgK] 

Wasser 4.190 

Holz  1.600 

Beton 1.000 

Glas 750 

Stahl 450 

 Tab. 4-2: Spezifische Wärmekapazität verschiedener Stoffe bei Raumtemperatur [21] 
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4.1.1.3 Wärmeleitfähigkeit 

Wärmeleitfähigkeit, auch als Wärmeleitzahl bezeichnet, ist ein Stoffkennwert für den 

Wärmedurchgang durch einen Körper infolge von Wärmeleitung. Angegeben wird die 

Wärmemenge, die pro Sekunde bei ∆T = 1 K auf einer Länge von einem Meter durch einen 

Querschnitt von einem Quadratmeter transportiert wird. 

Die Wärmeleitfähigkeit von Stahl kann nach DIN EN 1993-1-2 [7] wie folgt bestimmt werden. 

 

 W/mKθ1033,354λ a

2

a

−×−=  C800θC20 a °<≤°  

 W/mK3,27λa =  C1200θC800 a °<≤°  

mit  λa Wärmeleitfähigkeit [W/mK] 

 θa Stahltemperatur [°C] 

 

 

 Abb. 4-2: Wärmeleitfähigkeit in Abhängigkeit von der Temperatur [7] 

 

In Abbildung 4-2 ist die Wärmeleitfähigkeit in Abhängigkeit von der Temperatur abgebildet. 

Im Bereich von 20 – 800 °C sinkt die Leitfähigkeit nahezu linear von  

53,3 W/mK auf 27,3 W/mK, anschließend bleibt der Verlauf konstant. 
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Tabelle 4-3 zeigt im Vergleich verschiedene Materialien und deren Wärmeleitfähigkeit bei 

Raumtemperatur. 

 

Material Wärmeleitfähigkeit  [W/mK] 

Kupfer 380 

Aluminium 160 

Stahl 53,3 

Beton 1,96  

Glas 1,00 – 1,40 

Wasser 0,62 

Holz  0,13 – 0,18 

 Tab. 4-3: Wärmeleitfähigkeit verschiedener Stoffe bei Raumtemperatur [21] 

 

4.1.1.4 Thermische Dehnung 

Thermische Dehnung ist die Längenänderung ∆l eines Körpers bei einer 

Temperaturänderung ∆T = 1 K bezogen auf die Ausgangslänge von 1 m. 

Insbesondere unter Brandeinwirkung können beim Werkstoff Stahl, bedingt durch die 

Wärmedehnung, innere Schnittgrößen bzw. Zwängungen resultieren und so das 

Tragverhalten abhängig vom statischen System nachhaltig beeinflussen.  

Nach DIN EN 1993-1-2 [7] kann die thermische Dehnung anhand folgender Gleichungen 

errechnet werden. 

 

 42

a

8

a

5 10416,2θ104,0θ102,1∆l/l −−− ×−×+×=  C750θC20 a °<≤°  

 2101,1∆l/l −×=  C860θC750 a °<≤°  

 3

a

5 102,6θ102∆l/l −− ×−×=  C1200θC860 a °<≤°  

mit  l Länge bei 20°C [m] 

 ∆l Ausdehnung infolge Temperatur [m] 

 θa Stahltemperatur [°C] 
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 Abb. 4-3: Thermische Dehnung in Abhängigkeit von der Temperatur [7] 

 

Der hinlänglich aus dem Stahlbau bekannte Temperaturausdehnungskoeffizient von  

αt  = 1,2 x 10-5 [1/K] resultiert aus den in Abb. 4-3 dargestellten Beziehungen. 

Durch Division der relativen Längenänderung ε = ∆l / l durch die Temperatur erhält man den 

Temperaturausdehnungskoeffizienten αt. 

 

4.1.2 Mechanische Eigenschaften 

Unter dem Begriff mechanische Eigenschaften werden für den Werkstoff Stahl folgende 

Punkte zusammengefasst: 

 

� Streckgrenze  

� Zugfestigkeit 

� Festigkeit und Elastizität 

� Verformungsverhalten 

 

4.1.2.1 Streckgrenze 

Die Streckgrenze, auch Fließgrenze genannt, definiert den Punkt, bis zu dem Stahl im 

einachsigen Zugversuch ohne bleibende plastische Verformung gestreckt bzw. gedehnt 

werden kann. 
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4.1.2.2 Zugfestigkeit 

Die Zugfestigkeit von Stahl ist die Spannung, die aus der im Zugversuch erreichten 

maximalen Zugkraft bezogen auf den Ausgangsquerschnitt rechnerisch ermittelt wird. 

Die im Spannungs-Dehnungs-Diagramm angegebenen Werte von Zugfestigkeit und 

Streckgrenze sind bei duktilen Werkstoffen wie Stahl geringer, da der Wert der maximalen 

Zugkraft im Einschnürbereich der Probe ermittelt wird. Dieser Querschnitt ist jedoch auf 

Grund der Querkontraktion kleiner als der Ausgangsquerschnitt, mit dem die Spannung 

ermittelt wird. 

 

4.1.2.3 Festigkeit und Elastizität 

Die Festigkeit und die Elastizität von Stahl sind stark abhängig von der Temperatur im 

Werkstoff und somit entscheidend für das Tragverhalten von Stahlbauteilen. 

Der Elastizitätsmodul nimmt bei zunehmender Temperatur stetig ab, so dass der Bereich des 

linear-elastischen Verhaltens deutlich reduziert wird. Bei 600 °C wird bereits eine 

Abminderung von 70 % gegenüber dem Ausgangswert bei 20 °C erreicht. Ebenso verringert 

sich die Streckgrenze ab einer Temperatur von 400 °C, von daher bleibt bei 600 °C nur noch 

eine Reststreckgrenze von weniger als 50 % gegenüber dem Ausgangswert  bei 

Raumtemperatur.  

Allgemein gilt, je höher die Temperatur im Stahl, umso weniger Spannung kann dieser 

aufnehmen und umso niedriger ist die Fließgrenze. 

 

 

 Abb. 4-4: Spannungs-Dehnungslinie von Stahl unter erhöhter Temperatur [7] 

 

Die in Abbildung 4-4 dargestellte Spannungs-Dehnungslinie lässt sich in vier 

charakteristische Bereiche einteilen.  
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Zu Beginn ist der Bereich des linear-elastisch ansteigenden Verformungsverhaltens zu 

erkennen (Phase I), der anschließend an der Proportionalitätsgrenze in den elastisch-

plastischen, ellipsenartigen Bereich übergeht (Phase II). 

Mit Erreichen der effektiven Fließgrenze geht die Kurve in einen konstanten Verlauf über, die 

Fließdehnung (Phase III). Abschließend ist im vierten Bereich ein starker Spannungsabfall 

bis zum Versagen des Bauteils zu erkennen, welches als Bruchdehnung bezeichnet wird 

(Phase IV). 

In Tabelle 4-4 sind die Abminderungsfaktoren nach DIN EN 1993-1-2 [7] für die oben 

genannte Spannungs-Dehnungsbeziehung von Stahl unter erhöhter Temperatur aufgeführt. 

Die Abminderungsfaktoren in Abhängigkeit von der Stahltemperatur θa beziehen sich auf den 

jeweiligen Ausgangswert bei einer Raumtemperatur von 20°C.  

 

 

 Tab. 4-4: Abminderungsfaktoren für die Spannungs-Dehnungsbeziehung von Stahl [7] 
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Zur Veranschaulichung ist in Abbildung 4-5 ein Diagramm abgebildet, das die in Tabelle 4-4 

beschriebenen Abminderungsfaktoren in Abhängigkeit von der Temperatur darstellt. 

 

 

 

 Abb. 4-5: Abminderungsfaktoren in Abhängigkeit von der Temperatur [7] 

 

4.1.2.4 Verformungsverhalten 

Bei dem Verformungsverhalten von Stahl wird zwischen elastischem und plastischem 

Verhalten unterschieden. 

Bei der elastischen, reversiblen Verformung werden durch das Einwirken äußerer Kräfte die 

Atome aus ihrer Gleichgewichtslage gebracht. Anziehende oder abstoßende Bindungskräfte 

bei Zug- oder Druckbeanspruchung bewirken die sofortige Rückkehr der Atome in ihre 

Ausgangslage bei Wegfall der äußeren Einwirkung.  

Die plastische, irreversible Verformung beruht auf der Verschiebung von Gitterbereichen im 

Werkstoff, wobei die Verbindungen der Atome verlagert, jedoch nicht aufgelöst werden. Eine 

vollständige Auflösung der atomaren Verbindungen tritt erst bei der Bruchdehnung auf. 

Mit steigender Temperatur nimmt das elastische Verhalten stetig ab, da die mittleren 

Atomabstände infolge der thermischen Ausdehnung und größeren Gitterschwingungen 

zunehmen und damit die atomaren Bindungskräfte verringert werden.  

Dagegen nimmt das plastische Verformungsverhalten bei hohen Temperaturen durch 

zunehmende Bewegung der Atome und Verschiebungen der Kristalle innerhalb des Gitters 

stetig zu und es kann bereits bei geringen Einwirkungen zu starken Verformungen des 

Stahls kommen.  
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4.2 Normativer Hintergrund 

In Kapitel 6.4.3 der DIN EN 1990 [1] sind die Kombinationsregeln für Einwirkungen mit 

entsprechenden Formeln aufgeführt.  

Gleichung 4.1 zeigt die Kombination von Einwirkungen für die ständige, Gleichung 4.2 die für 

die außergewöhnliche Bemessungssitutation. 

  

 Grenzzustand der Tragfähigkeit bei Raumtemperatur 

 ]k,i,i0Q,i
1i

1k,1Q,Pk,jG,j
1j

d QψγQPγGγ[EE
>>>>≥≥≥≥
∑∑∑∑++++γγγγ++++++++∑∑∑∑====  Gl. 4.1 

 

 Grenzzustand der Tragfähigkeit im Brandfall 

 ]Qψ)Qψoder(ψAPG[EE k,i,i2
1i

1k,1,21,1dk,j
1j

d
≥≥≥≥≥≥≥≥
∑∑∑∑++++++++++++++++∑∑∑∑====  Gl. 4.2 

mit Gk,j charakteristischer Wert einer ständigen Einwirkung j 

 Qk,1 charakteristischer Wert einer maßgebenden veränderlichen Einwirkung 1 

 Qk,i charakteristischer Wert einer nicht maßgebenden veränderlichen Einwirkung i  

 P maßgebender Wert einer Vorspannung 

 Ad Bemessungswert einer außergewöhnlichen Einwirkung 

ψ Kombinationsbeiwerte der veränderlichen Einwirkungen 

γ Teilsicherheitsbeiwerte 

 

Für die Brandbemessung sollte nach DIN EN 1990 [1] für den Bemessungswert Ad neben 

den Temperaturauswirkungen auf die Baustoffeigenschaften auch die der indirekten 

thermischen Einwirkung des Brandes berücksichtigt werden. Unter diesen indirekten 

Einwirkungen sind Kräfte und Momente aus thermischer Dehnung oder Verformung (z.B. 

Zwangskräfte) zu verstehen, die je nach Brandszenario und statischem System 

berücksichtigt werden müssen.  

Die Kombinationsbeiwerte variieren und sind abhängig von der Art der Nutzung des 

Objektes. Die wichtigsten Werte für den Hochbau sind in Tabelle A.1.1 der DIN EN 1990 [1] 

zusammengestellt. Die Teilsicherheitsbeiwerte ergeben sich aus dem Sicherheitskonzept 

und sind in den Tabellen A.1.2(A-C) angegeben. Die Reduzierung einwirkender Lasten, die 

bei der Verbrennung entsteht, sollte im Allgemeinen nicht berücksichtigt werden.   
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Der Nachweis der Tragfähigkeit kann nach DIN EN 1991-1-2 [3] auf den drei nachfolgend 

genannten Ebenen erfolgen. 

 

� Temperaturebene → θd ≤ θcr,d 

� Festigkeitsebene → Rfi,d,t � Efi,d,t 

� Zeitebene → tfi,d � tfi,requ 

mit tfi,d Bemessungswert der Feuerwiderstandsdauer 

 tfi,requ erforderliche Feuerwiderstandsdauer  

 Rfi,d,t Bemessungswert der Beanspruchbarkeit im Brandfall zum Zeitpunkt t 

 Efi,d,t  Bemessungswert der maßgebenden Beanspruchungen im Brandfall zum Zeitpunkt t 

 θd  Bemessungswert der Baustofftemperatur 

 θcr,d  Bemessungswert der kritischen Baustofftemperatur 

 

Dabei werden die ersten beiden Nachweisverfahren auf Temperatur- und Festigkeitsebene 

für die vereinfachten Berechnungsverfahren nach DIN EN 1993-1-2 [7] angewendet.  

Der Nachweis auf Zeitebene wird für Tragwerksteile und Gesamttragwerke mit Hilfe von 

numerischen Simulationsmodellen durchgeführt. Hierbei werden auch Schnittgrößen aus 

thermischer Verformung, beispielsweise Zwangskräfte, berücksichtigt. 

 

4.3 Vereinfachtes Nachweisverfahren 

Nach dem in DIN EN 1993-1-2 [7] beschriebenen einfachen Bemessungsverfahren wird 

unterstellt, dass ein Bauteil seine lastabtragende Funktion zum Zeitpunkt t eines 

Brandereignisses erfüllt, wenn der Bemessungswert der maßgebenden Beanspruchung 

kleiner ist als der entsprechende Wert der Beanspruchbarkeit des Stahlbauteils, es gilt also 

allgemein Efi,d ≤ Rfi,d,t. 

Wie bereits in Kapitel 2.1.3 näher ausgeführt, wird das vereinfachte Bemessungsverfahren in 

den Nachweis auf Festigkeits- und Temperaturebene unterteilt und soll nachfolgend genauer 

betrachtet werden [vgl. 18]. 

 

4.3.1 Berechnung der Festigkeit 

Es können annähernd alle Stahlbauteile wie beispielsweise Träger, Stützen und Zugstäbe 

nach dem Verfahren berechnet werden. Der Temperatureinfluss bei Brandeinwirkung wird 

hierbei durch Abminderungsfaktoren oder durch Beiwerte, die bei Brandversuchen ermittelt 

wurden, berücksichtigt. 
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Das vereinfachte Bemessungsverfahren kann in folgenden Fällen angewendet werden. 

 

� Für Bauteile, die durch eine Normalkraft oder ein Biegemoment beansprucht 

werden, kann der Nachweis wie ein plastischer Nachweis unter erhöhter Temperatur 

mit entsprechendem Abminderungsfaktor der Streckgrenze geführt werden. 

� Für stabilitätsgefährdete Bauteile unter Druckbeanspruchung wird der Nachweis 

gegen Biegeknicken im Brandfall geführt, hierbei werden die Abminderungsbeiwerte 

der Streckgrenze und der Steifigkeit bei der Ermittlung des bezogenen 

Schlankheitsgrad berücksichtigt. 

� Für Bauteile unter kombinierter Biege- und Druckbeanspruchung mit 

Biegedrillknickgefährdung wird die Interaktion zwischen Biegung und Druck durch 

eine Kombination der beiden oben genannten Verfahren berücksichtigt. 

 

Die genauen Berechnungsformeln sind in der DIN EN 1993-1-2 [7] enthalten. Darüber hinaus 

wird das vereinfachte Nachweisverfahren über die Berechnung der Festigkeit in Kapitel 5.4 

und Kapitel 6.2.1 in Berechnungsbeispielen angewendet.  

 

4.3.2 Berechnung der kritischen Temperatur 

Bei dem Nachweis der kritischen Temperatur wird diese in Abhängigkeit vom 

Ausnutzungsgrad eines Bauteiles bestimmt und mit der Temperatur im Querschnitt zum 

Zeitpunkt t verglichen. Liegt die errechnete oder durch eine thermische Analyse ermittelte 

Stahltemperatur unterhalb der kritischen Temperatur, so ist der Tragfähigkeitsnachweis 

erbracht.  

Erlaubt ist der Nachweis ausschließlich für Stahlbauteile mit geringen Temperaturgradienten 

unter Ausschluss von Verformungskriterien und Stabilitätsproblemen, anwendbar z.B. in 

folgenden Fällen: 

 

� Geschützte oder ungeschützte Stahlträger mit drei- bzw. vierseitiger Beflammung 

� Geschützte oder ungeschützte Stahlstützen mit allseitiger Brandbeanspruchung 

� Zugbeanspruchte Stahlbauteile unter Brandeinwirkung 

 

Die Vorgehensweise ist in Abbildung 4-6 graphisch dargestellt und gliedert sich in die 

folgenden Aufgabenschritte: 

 

1) Berechnung der mechanischen Einwirkungen im Brandfall Efi,d 

2) Berechnung der Tragfähigkeit Rfi,d,0 zum Zeitpunkt t = 0 
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3) Bestimmung des Ausnutzungsgrades  0,d,fid,fi0 R/E====µµµµ   

4) Berechnung der kritischen Temperatur  

     4821
9674,0

1
ln19,39

833,3

0

cr ++++











−−−−

µµµµ××××
××××====θθθθ  

 

 

Abb. 4-6: Vorgehensweise zur Berechnung der kritischen Temperatur [18] 

 

Eine weitere Möglichkeit besteht nach DIN EN 1993-1-2 [7] darin, den Ausnutzungsgrad bei 

zugbeanspruchten Bauteilen auf der sicheren Seite liegend über das Lastniveau zu ermitteln. 

Hierbei wird die Ausnutzung mit dem Abminderungsfaktor der Lastkombination durch 

[ ]0,Mfi,Mfi0 / γγη=µ  bestimmt. 

 

4.4 Allgemeines Nachweisverfahren 

Allgemeine Berechnungsverfahren können generell für jede Art der mechanischen 

Tragwerksanalyse im Brandfall verwendet werden. Insbesondere bei der globalen Analyse 

von Gesamttragwerken ist dieses Verfahren von Vorteil, weil hier häufig das vereinfachte 

Berechnungsverfahren nicht zur Verfügung steht.  

Auch kann als Brandbeanspruchung neben der Einheitstemperaturkurve eine der Nutzung 

entsprechende Naturbrandkurve gewählt werden (vgl. Kapitel 2.3), womit ein realistischerer 

Temperaturverlauf erreicht wird. 

Bei dem allgemeinen Nachweisverfahren sollte stets eine Plausibilitätsprüfung der 

Berechnungen des globalen Tragverhaltens und lokaler Effekte mit Versuchsergebnissen 

erfolgen. Außerdem ist eine kritische Überprüfung, insbesondere des Versagensgrundes, 

erforderlich. 
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Weiter sind folgende wichtige Anwendungsregeln zu beachten: 

 

� Das Gesamttragwerk muss mit entsprechenden Randbedingungen vollständig 

abgebildet werden.  

� Bei Teiltragwerken sind die Randbedingungen, die durch den nicht modellierten Teil 

gegeben sind, entsprechend abzubilden. 

� Die Belastungssituation muss mit der Belastung für die außergewöhnliche 

Bemessungssituation im Brandfall übereinstimmen. 

� Alle potenziellen Versagensfälle, die durch das allgemeine Berechnungsverfahren 

nicht berücksichtigt werden, müssen entweder konstruktiv ausgeschlossen oder 

durch entsprechende Modellierung im Modell bei einer numerischen Analyse 

berücksichtigt werden. 

� Die aus der thermischen Analyse implementierten Modelle müssen dem realen 

Materialverhalten im Brandfall entsprechen.  

� Auswirkungen von temperaturinduzierten Spannungen und Dehnungen sowie 

kombinierte Einflüsse aus mechanischen Einwirkungen, geometrischen 

Imperfektionen und thermischer Einwirkung sind zu berücksichtigen.  

� Nichtlineare Werkstoffeigenschaften, einschließlich der ungünstigen Einflüsse auf 

die Steifigkeit durch Be- und Entlastung eines Bauteils sind zu beachten. 

 

Unter Berücksichtigung der o.g. Aspekte liegt in der Anwendung des allgemeinen 

Nachweisverfahrens und geeigneter Bemessungssoftware ein hohes Potenzial, das sich 

nach der Einführung der Eurocodes in Zukunft weiter etablieren wird. Auch wenn das 

allgemeine Berechnungsverfahren international anerkannt ist und bei anspruchsvollen 

Stahlkonstruktionen für den Nachweis der Tragfähigkeit im Brandfall zur Anwendung kommt, 

wird in Deutschland einer Zulassung des Nachweisverfahrens noch mit Zurückhaltung 

begegnet. 
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4.5 Berechnungsbeispiele 

4.5.1 Ermittlung der kritischen Temperatur eines Stahlträgers 

Anhand der in Kapitel 4.3.2 beschriebenen Vorgehensweise soll für den Biegeträger (vgl. 

Kapitel 5.4.1), unter Vernachlässigung von Stabilitätsproblemen die kritische Temperatur 

berechnet werden.  

Es ergeben sich folgende Werte: 

 

1) Berechnung der mechanischen Einwirkungen im Brandfall Efi,d 

 kNm0,325ME fi,EDd,fi ==  

 

2) Berechnung der Tragfähigkeit Rfi,d,0 zum Zeitpunkt t = 0 

 kNm11331030
0,1

1,1
0,1M

γ

γ
kMR pl,Rd

M,fi

M,θ

y,θ,Rd0fi,0,d,fi =×







×=×













×==  

 

3) Bestimmung des Ausnutzungsgrades  0,d,fid,fi0 R/E=µ   

 287,01133/0,325M/MR/E Rd,0,fiEd,fi0,d,fid,fi0 ====µ  

 

4) Berechnung der kritischen Temperatur  

     4821
9674,0

1
ln19,39

833,3

0

cr +







−

µ×
×=θ  

 C5,6704821
287,09674,0

1
ln19,39

833,3
°=+








−

×
×=  

  

Die kritische Temperatur des Biegeträgers beträgt somit ca. 670 °C. Zur Kontrolle kann nun 

die maximale Momentenbeanspruchbarkeit bestimmt und anschließend der Nachweis der 

Tragfähigkeit geführt werden. 

 

 Abminderungsfaktor bei Tcrit = 670 °C: 

 302,0k y,θ =  

  

 Bemessungswert der Momentenbeanspruchbarkeit: 

 kNm1,3421030
0,1

1,1
302,0M

γ

γ
kM pl,Rd

M,fi

M,θ

y,θfi,t,Rd =×







×=×













×=  
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 Nachweis: 

 10,95
342,1

325

M

M

Rdt,fi,

EDfi,
≤==  Nachweis erbracht 

 

Anhand des oben geführten Nachweises ist zu erkennen, dass die Ermittlung der kritischen 

Temperatur nahe an die entsprechende Versagenstemperatur heranreicht. Somit bietet 

diese Methode eine schnell durchzuführende Berechnung mit zufriedenstellendem Ergebnis, 

kann aber nach DIN EN 1993-1-2 [7] ausschließlich bei nicht stabilitätsgefährdenden 

Bauteilen angewendet werden. 

 

4.5.2 Allgemeines Nachweisverfahren am Beispiel einer Stahlstütze 

An dem Beispiel einer eingespannten Stütze mit seitlich gehaltenem Stützenkopf soll durch 

eine Berechnung mit SAFIR der Unterschied des Tragverhaltens zwischen Normbrand- und 

Naturbrandbeanspruchung verdeutlicht werden. Für die vierseitig beflammte Stütze wurde 

ein HEA 200 Profil mit einer zentrischen Belastung von 150 kN und einer Länge von 3,0 m 

gewählt, das statische System ist in Abbildung 4-7 dargestellt. Zusätzlich wurde in der Mitte 

der Stütze eine Imperfektion von 2,0 cm eingebaut, da ansonsten bei reiner Druckbelastung 

anstatt eines Knickens nur eine Stauchung auftreten würde. 

 

  

 Abb. 4-7: Statisches System der Stütze mit Imperfektion 

 

Im ersten Schritt wird eine vierseitige Brandbeanspruchung der Stütze durch die 

Einheitstemperaturkurve angesetzt und die entsprechende Tragfähigkeit mit SAFIR 

berechnet. Wie in Abbildung 4-8 zu erkennen, tritt nach 23 Minuten ein Bauteilversagen 

durch Ausknicken der Stütze auf. 
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 Abb. 4-8: Knickversagen der Stütze nach 23 Min. (SAFIR) 

 

Im zweiten Schritt wird eine Beanspruchung der Stütze durch eine Naturbrandkurve 

angenommen, wobei nach 20 Minuten eine maximale Heißgastemperatur von 800 °C 

erreicht wird. Wie in Abbildung 4-9 gut zu erkennen, tritt mit zunehmender Temperatur eine 

Verformung von maximal 6 mm auf, die in der Abkühlphase mit abnehmender Temperatur 

ebenfalls zurückgeht. Ein Versagen kann in diesem Fall nach dem allgemeinen 

Nachweisverfahren in Kombination mit einer Naturbrandkurve ausgeschlossen werden.  

 

   

 Abb. 4-9: Horizontalverformung der Stütze unter Naturbrandbeanspruchung (SAFIR) 

 

4.6 Systemreserven eines Tragwerkes 

Neben der in Kapitel 5.2 beschriebenen Methode des ‚Overmarching’ oder der Verwendung 

von FR-Stahl ist auch die Wahl des statischen Systems eines Tragwerkes für die 

Feuerwiderstandsdauer entscheidend.  

In Abhängigkeit von den Steifigkeitsverhältnissen und dem statischen System können 

Systemreserven in Form von Lastumlagerungen aktiviert werden und stellen so für den 
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Brandfall eine zusätzliche Sicherheit hinsichtlich des Gesamtversagens des Tragwerkes dar. 

Bei der Lastumlagerung werden zusätzliche Lasten von brandbeanspruchten Bauteilen, 

deren Tragfähigkeit sich auf Grund der Erwärmung und des zunehmendem 

Steifigkeitsverlust reduziert, auf angrenzende Bauteile übertragen.  

Voraussetzung für die lastübernehmenden Bauteile ist, dass sie nicht oder nur in geringem 

Maße von einer Brandeinwirkung betroffen sind und so über die nötigen Tragreserven 

verfügen.  Darüber hinaus müssen für die Bauteile geeignete konstruktive Verbindungen 

vorgesehen werden, die eine Lastübertragung auch im Brandfall gewährleisten. 

Beispielsweise ermöglicht die Ausführung einer Rahmenecke als biegesteife Verbindung 

eine Lastumlagerung und so eine effiziente Ausnutzung der Querschnitte bzw. die 

Aktivierung der Systemreserven. 

Im Folgenden soll ein einfacher Rahmen mit einer Streckenlast von 20 kN/m auf dem Riegel 

hinsichtlich seiner Feuerwiderstandsdauer analysiert werden. Hierbei werden insgesamt drei 

verschiedene Varianten mit der Brandbemessungssoftware SAFIR berechnet, wobei das 

statische System bei gleich bleibenden Randbedingungen variiert wird. Als 

Brandbeanspruchung wird die Einheitstemperaturkurve angesetzt, wobei die Stützen 

vierseitig und der Riegel dreiseitig dem Brand ausgesetzt sind.  

 

4.6.1 Variante 1 

� Gelenkige Lagerung der Stützenfüße 

� 1-fach statisch unbestimmt 

� Gesamttragwerksversagen nach 16 Minuten (960 Sek.) 

 

  

 Abb. 4-10: Statisches System – Variante 1 
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 Abb. 4-11: Gesamtverformung des Systems nach 16 Min. – Variante 1 

 

  

 Abb. 4-12: Verformung uy in Trägermitte in Abhängigkeit von der Zeit – Variante 1 

 

Unter Brandbeanspruchung (ETK) ist bei dem in Abbildung 4-10 dargestellten statischen 

System nach 16 Min. ein Versagen des Riegels festzustellen. Abbildung 4-12 zeigt die 

vertikale Verformung uy in Abhängigkeit von der Zeit, wonach zum Versagenszeitpunkt eine 

Durchbiegung von 2,8 cm festzustellen ist (vgl. Abb. 4-11). 
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4.6.2 Variante 2 

� Festeinspannungen der Stützenfüße 

� 3-fach statisch unbestimmt 

� Gesamttragwerksversagen nach 20 Minuten (1200 Sek.) 

 

  

 Abb. 4-13: Statisches System – Variante 2 

 

  

 Abb. 4-14: Gesamtverformung des Systems nach 20 Min. – Variante 2 

 

  

 Abb. 4-15: Verformung uy in Trägermitte in Abhängigkeit von der Zeit – Variante 2 
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Nach Änderung des statischen Systems und angenommenen Festeinspannungen an den 

Fußpunkten der Stützen (Abb. 4-13) erhöht sich die Feuerwiderstandsdauer auf 20 Minuten. 

In Abbildung 4-15 ist die vertikale Verformung uy in Abhängigkeit von der Zeit dargestellt. 

Deutlich zu erkennen sind der stark zunehmende Festigkeitsverlust nach 900 Sekunden und 

die damit verbundene plastische Verformung bis zum Versagenszeitpunkt. Die Durchbiegung 

in der Trägermitte beträgt zum Zeitpunkt des globalen Tragwerksversagen 15,6 cm  

(vgl. Abb. 4-14). 

 

4.6.3 Variante 3 

� Festeinspannungen der Stützenfüße, zusätzliche Stütze in Trägermitte  

� 6-fach statisch unbestimmt 

� Gesamttragwerksversagen nach 67 Minuten (4020 Sek.) bzw. nach 31 Minuten 

(1860 Sek.) bei Erhöhung der Streckenlast auf 40 kN/m 

 

  

 Abb. 4-16: Statisches System – Variante 3 

 

  

 Abb. 4-17: Gesamtverformung des Systems nach 67 Min. – Variante 3 
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 Abb. 4-18: Verformung ux in Stützenmitte in Abhängigkeit von der Zeit – Variante 3 

 

Zur Vermeidung eines vorzeitigen Versagens des Riegels wird in Variante 3 in der Mitte eine 

zusätzliche Stütze angeordnet (Abb. 4-16). Wie in Variante 2 werden die Stützen als 

festeingespannt angenommen.  

Nach der globalen Tragwerksananalyse tritt ein Versagen durch Ausknicken der mittleren 

Stütze erst nach 67 Minuten auf (vgl. Abb. 4-17, 4-18). Für eine geforderte 

Feuerwiderstandsklasse R 30 kann die Last anschließend noch erhöht werden. So ist eine 

Erhöhung der Last auf 40 kN/m möglich, ohne dass ein Versagen innerhalb der ersten 

dreißig Minuten auftritt, was einer Steigerung von 100 % entspricht. 

 

4.6.4 Fazit 

Nach der Berechnung der o.g. drei verschiedenen Rahmentragwerke ist zu erkennen, dass 

bereits durch geringfügige Änderungen am statischen System eines Tragwerkes eine 

deutliche Steigerung der Tragfähigkeit möglich ist.  

Bei dem Vergleich der ersten beiden Varianten ist erkennbar, dass durch die 

Festeinspannung der Stützenfüße im Gegensatz zur gelenkigen Lagerung eine um 25 % 

erhöhte Feuerwiderstandsdauer erreicht wird. 

Mit einer konstruktiven Stützung des Trägers (Variante 3) kann ein vorzeitiges Versagen des 

Riegels verhindert werden. Bis zum Ausknicken der mittleren Stütze wird eine Steigerung der 

Feuerwiderstandsdauer von 335 % auf 67 Min. gegenüber der Variante 2 erreicht. Zudem 

kann bei einer Laststeigerung auf 40 kN/m noch immer eine 30-minütige 

Feuerwiderstandsdauer gewährleistet werden. 

Die Berücksichtigung dieser Systemreserven ist allerdings nur bei der Analyse eines Teil- 

oder Gesamttragwerkes nach dem allgemeinen Verfahren nach DIN EN 1993-1-2 [7]  

möglich, da die statischen Auflagerbedingungen bei dem vereinfachten Nachweisverfahren 

lediglich eingeschränkt berücksichtigt werden. 
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5 Feuerwiderstandsdauer von ungeschützten Stahlprofilen 

5.1 Praxisorientierte Berechnung der Stahltemperatur 

Die in Kapitel 3.3.1 angegebene Formel zur Berechnung der Stahltemperatur bei 

ungeschützten Bauteilen ist auf Grund der Randbedingungen und der verschiedenen 

Eingangsparameter nicht sehr anwenderfreundlich und bedarf eines erheblichen 

Rechenaufwandes.  

Bisher fehlte eine geschlossene, mathematische Funktion, mit der sich näherungsweise in 

kurzer Zeit die Stahltemperatur in Abhängigkeit von der Brandbeanspruchung durch die 

Einheitstemperaturkurve ermitteln lässt. 

Diese Näherungsformel [22] wurde in der Vergangenheit am Institut für Stahlbau an der 

Universität Hannover aufgestellt und soll hier vorgestellt und mit dem FEM-Programm SAFIR 

validiert werden. 

 

5.1.1 Näherungsformel 

Die Koeffizienten der Näherungsformel zur Berechnung der Temperaturen ungeschützter 

Stahlbauteile bei Brandbeanspruchung durch die Einheitstemperaturkurve wurden, nach 

Wahl einer geeigneten Ausgangsfunktion, über die Minimierung der Fehlerquadrate 

bestimmt.  

Der Gültigkeitsbereich ist auf Stahltemperaturen unterhalb von 700°C, auf Profilfaktoren 

zwischen 25m-1 und 300m-1 und auf eine Branddauer von maximal 30 Minuten 

eingeschränkt.  

Die Berechnung ist ausschließlich von zwei Eingangsparametern, der Branddauer in Minuten 

und dem Profilfaktor, abhängig, was eine Berechnung in wenigen Minuten mit einfachen 

Hilfsmitteln ermöglicht.  



Feuerwiderstandsdauer von ungeschützten Stahlprofilen  

  Seite 50  

In Gleichung 5.1 ist die Formel zur Berechnung der Stahltemperatur mit den dazugehörigen 

Variablen c1-c4 dargestellt. 
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In Abbildung 5-1 sind die Temperaturverläufe ungeschützter Stahlquerschnitte verschiedener 

Profilfaktoren in Abhängigkeit von der Brandbeanspruchung durch die 

Einheitstemperaturkurve abgebildet. 

 

 

 Abb. 5-1: Temperaturverlauf ungeschützer Stahlquerschnitte unter ETK [22] 
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5.1.2 Validierung mit SAFIR  

Die als Näherungsformel beschriebene Berechnung soll hier für ausgewählte Zeitstufen und 

für Profilfaktoren durchgeführt und die Ergebnisse mit dem  

FEM-Programm SAFIR validiert werden. 

Es wurden die Zeitstufen 10 Min., 20 Min. und 30 Min. sowie Profilfaktoren zwischen 25 und 

300 mit einer Abstufung von etwa 25, abhängig von vorhandenen Profilen, gewählt.  

In Tabelle 5-1 sind die jeweiligen Daten und die Abweichung in Prozent aufgeführt. 

 

10min ETK 20min ETK 30min ETK 

Tmax [°C] ∆∆∆∆ [%] Tmax [°C] ∆∆∆∆ [%] Tmax [°C] ∆∆∆∆ [%] Am/V 

SAFIR Gl.5.1 - SAFIR Gl.5.1 - SAFIR Gl.5.1 - 

25 153,2 122,3 -25,2 368,8 327,2 -19,6 478,3 425,9 -12,3 

50 255,3 208,8 -22,3 518,7 443,7 -16,9 690,6 631,4 -9,4 

78 355,8 290,4 -22,5 637,4 564,2 -12,9 741,4 741,0 0,0 

100 375,1 343,9 -9,1 651,2 625,3 -4,1 753,8 784,6 +4,1 

122 428,1 389,3 -10,0 691,1 667,6 -3,5 778,4 809,0 +3,9 

151 500,0 438,8 -13,9 722,1 704,8 -2,5 812,6 825,4 +1,6 

175 544,6 472,4 -15,3 731,9 725,1 -0,9 825,0 831,3 +0,8 

200 556,1 501,8 -10,8 733,5 739,7 +0,8 827,1 833,3 +0,7 

227 576,6 528,2 -9,1 735,8 750,3 +2,0 830,3 832,6 +0,3 

253 577,6 549,4 -5,1 737,2 757,0 +2,7 830,6 830,3 -0,0 

276 607,3 565,4 -7,4 741,6 760,9 +2,6 833,8 827,5 -0,8 

298 611,5 578,5 -5,7 742,8 763,3 +2,7 834,3 824,3 -1,2 

 Tab. 5-1: Validierung der Näherungsformel mit SAFIR 

 

Nach Auswertung der Daten lässt sich die Aussage treffen, dass für die Zeitstufe  

t = 10 Min. die Fehlerquote zwischen Handrechnung und einer genauen Berechnung mit 

SAFIR am höchsten ist. Die Werte liegen allerdings alle über den mit SAFIR ermittelten 

Werten und daher auf der sicheren Seite.  

Für die anderen beiden Zeitstufen ist die Fehlerquote der Näherungsformel für Profilfaktoren 

oberhalb von Am/V = 100 m-1 mit Abweichungen deutlich unterhalb von 5,0 % als sehr gut 

einzustufen. Lediglich für die kleineren Profilfaktoren unterhalb von 100 m-1 ist eine Differenz 

von bis zu 19,6 % festzustellen. Allerdings sind hierbei die niedrigen Bauteiltemperaturen zu 

berücksichtigen und die Abweichung in absoluten Werten tolerierbar. 
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Mit dieser Erkenntnis ist die Formel vor allem für den Nachweis der Feuerwiderstandsklasse 

R 30 von ungeschützten Stahlkonstruktionen geeignet. Zur Veranschaulichung ist in 

Abbildung 5-2 die Temperaturentwicklung in Abhängigkeit von dem Profilfaktor nach  

30-minütiger Brandbeanspruchung durch die Einheitstemperaturkurve im Vergleich zu den 

Ergebnissen der Näherungsformel dargestellt. 

 

400

500

600

700

800

900

0 100 200 300 400

Profilfaktor [A/V]

S
ta

h
lt

em
p

er
at

u
r 

[°
C

]

SAFIR

Näherungsformel

 

 Abb. 5-2: Vergleich der Berechnungsergebnisse bei t = 30 Min. (ETK) 

 

Die Einschränkung, dass die Näherungsformel nur für Bauteiltemperaturen von bis zu 700 °C 

gültig ist, bestätigt sich nicht. Die Abweichungen bei Temperaturen oberhalb einer Grenze 

von 700 °C liegen alle deutlich unter 4,5 %, somit kann diese Näherungsformel 

uneingeschränkt für die Profilfaktoren 25 m-1 - 300 m-1  bei Brandbeanspruchung durch die 

Einheitstemperaturkurve eingesetzt werden. 

 

5.2 ‚Overmarching’ 

Das so genannte ‚Overmarching’ beschreibt die Methode, Stahlprofile größer als für die 

‚kalte Bemessung’ notwendig zu dimensionieren und so die Reserven für die 

Heißbemessung zu erhöhen.  

Dabei werden durch Verringerung des Profilfaktors niedrigere Bauteiltemperaturen und eine 

weniger große Abminderung der Streckgrenze erzielt, so dass die Beanspruchbarkeit des 

Stahlbauteils im Brandfall erhöht wird und eine längere Feuerwiderstandsdauer erreicht 

werden kann. 

Bei der Umsetzung sind allerdings stets die Effizienz des ‚Overmarching’ und die 

Gebrauchstauglichkeit des Gesamttragwerkes zu überprüfen. Ein stark überhöhter 

Deckenträger einer Hallenkonstruktion kann beispielsweise die nutzbare Höhe einschränken 

und ist ggf. im Vergleich mit Stahlverbundträgern oder geschützten Stahlträgern aus 

wirtschaftlicher Sicht nicht tragbar.  
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Oft stellen architektonische Planungen mit dem Ziel einer sichtbaren Stahlkonstruktion 

ebenfalls einen wichtigen Aspekt dar und sind im Konsens mit Bauherrn und Architekten 

sorgfältig abzuwägen. 

 

5.3 Anwendung von FR-Stahl     

Die Verwendung von FR-Stahl, einem feuerresistentem Stahl,  stellt eine Alternative zu 

konventionellem Baustahl dar. Es handelt sich um einen niedriglegierten Stahl, der über eine 

Mindeststreckgrenze von 275 N/mm² und über eine Zugfestigkeit im Bereich von   

460 - 620 N/mm² verfügt.  

Im Gegensatz zu herkömmlichen Baustählen ist die Reststreckgrenze auf Grund erhöhter 

Wärmefestigkeit deutlich höher, daher verliert er bei hohen Temperaturen nicht so schnell an 

Tragfähigkeit und hält einer Brandbeanspruchung länger stand. Geeignete mechanische 

Verbindungsmittel, die ebenfalls eine erhöhte Feuerwiderstandsdauer aufweisen, sind mit 

entsprechenden bauaufsichtlichen Prüfzeugnissen verfügbar. 

Abbildung 5-3 zeigt die zulässige Steigerung des Ausnutzungsfaktors in Abhängigkeit zur 

Querschnittstemperatur. 

 

 

 Abb. 5-3: Steigerung der Lastausnutzung in Abhängigkeit von der Stahltemperatur [12] 

 

Ein herkömmlicher Stahl weist bei einer Temperatur von 700 °C eine Reststreckgrenze von 

23 % auf, dagegen verfügt ein FR-Stahl noch über eine mehr als doppelt so große 

Reststreckgrenze von ca. 50 %, wie auch der Abbildung 5-3  zu entnehmen ist. 

Im Vordergrund weiterer Entwicklungen steht das Ziel, durch den Einsatz des 

feuerresistenten Stahls in Verbindung mit geeigneten Brandschutzanstrichen, die den Stahl 
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ebenfalls ‚sichtbar’ halten, die Feuerwiderstandsklasse R 90 oder sogar  

R 120 zu erreichen [vgl. 12].  

Zu beachten ist, dass auch mit herkömmlichem Feinkornbaustahl höherer Güte die 

Wärmefestigkeit und damit die Lastausnutzung gesteigert werden kann.  

Im nachfolgenden Kapitel 5.4 sollen die verschiedenen Varianten an Hand von 

Berechnungsbeispielen aufgezeigt werden. 

 

5.4 Bemessungsbeispiele 

Im Folgenden werden zwei Berechnungsbeispiele für ungeschützte Stahlbauteile unter 

Brandeinwirkung mit einer Feuerwiderstandsklasse von 30 Min. (R 30) vorgestellt.  

Zum einen sollen ein Biegeträger brandschutztechnisch bemessen, zum anderen eine 

Stahlstütze berechnet und die notwendigen Querschnitte in Abhängigkeit von der Stahlgüte 

bestimmt werden. 

Die Profilfaktoren werden unter der Annahme eines vierseitig brandbeanspruchten 

Querschnittes durch die Einheitstemperaturkurve ermittelt.  

 

5.4.1 Ungeschützter Biegeträger im Brandfall 

Zunächst soll ein Stahlprofil HEB 500 der Stahlgüte S 235 als Einfeldträger  nach dem 

elastisch-plastischen Verfahren bemessen werden, wobei Stabilitätsprobleme hierbei nicht 

berücksichtigt werden. Das statische System des Trägers mit entsprechender Belastung ist 

in Abbildung 5-4 dargestellt. 

 

  

 Abb. 5-4: Statisches System des Einfeldträgers mit Belastung 

 

 Belastung: 

 kN/m²0,3gk =  

 kN/m²0,5qk =  
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Zuerst wird die Berechnung für den Grenzzustand der Tragfähigkeit bei Raumtemperatur 

nach DIN EN 1993-1-1 [6] durchgeführt. 

  

 Streckenlast bei einem Trägerabstand von 4,0 m nach Gl. 4.1: 

 → qd = (1,35 x 5,0 + 1,5 x 3,0) x 4,0 =  45,0 kN / m 

 

 Resultierende Schnittgrößen: 

 kN0,225
2

1045
VEd =

×
=   

 kNm5,562
2

5225
MEd =

×
=  

 

Bemessungswert der Biege- und Querkraftbeanspruchbarkeit im vollplastischen 

Zustand: 

( ) ( )
kN1019

1,1

3/5,236,82

γ

3/fA
V

0M

yv

pl,Rd =
×

==  

( ) ( ) cm²6,828,27,245,18,2302239trttb2AAmit fwfv =×++××−=×++××−=  

kN1030
1,1

105,234820

γ

fw
M

2

0M

ypl

pl,Rd =
××

=
×

=
−

 

 

 Nachweis der Tragfähigkeit für S 235: 

 122,0
1019

225

V

V

pl,Rd

Ed ≤==  Nachweis erbracht 

 155,0
1030

5,562

M

M

pl,Rd

Ed ≤==  Nachweis erbracht 

 

Somit ist nachgewiesen, dass der Stahlträger HEB 500 der Stahlgüte S 235 für die 

gegebenen Einwirkungen im ‚Kaltzustand’ ausreichend bemessen ist. 

 

Nachfolgend soll die Berechnung für den Grenzzustand der Tragfähigkeit im Brandfall 

nach DIN EN 1993-1-2 [7] durchgeführt werden. Auf Grund der Nutzung als Büro darf der 

Kombinationsbeiwert der veränderlichen Einwirkung mit ψ1 = 0,5 angesetzt werden. 

 

 Streckenlast nach Gl. 4.2: 

 → qd = (1,0 x 5,0 + 0,5 x 3,0) x 4,0 =  26,0 KN / m 
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 Resultierende Schnittgrößen: 

 kN0,130
2

1026
Vfi,Ed =

×
=   

 kNm0,325
2

5130
M fi,Ed =

×
=  

 

Der Profilfaktor des HEB 650-Trägers kann Tabellenwerken [14] entnommen werden und 

beträgt Am/V = 89 m-1. Anschließend wird die Stahltemperatur nach 30-minütiger 

Brandbeanspruchung nach der Näherungsformel in Kapitel 5.1.1 berechnet.  

Der Abminderungswert der Streckgrenze ist abhängig von der Temperatur im Querschnitt 

und wird durch Interpolation aus Tabelle 4-4 entnommen. 

 

 Stahltemperatur bei t = 30 min (ETK): 

 C766
3092,98

3002,113592,9820
θ

558,1

558,1

30a, °≈
+

×+×
=  

 Abminderungsfaktor bei Tmax = 766 °C (interpoliert): 

 151,0k y,θ =  

 

Bemessungswert der Biege- und Querkraftbeanspruchbarkeit im vollplastischen 

Zustand zum Zeitpunkt t = 30 min: 

 kN1691019
0,1

1,1
151,0V

γ

γ
kV Rd

M,fi

0M,

y,θ,θ,wfi,t,Rd =×







×=×










×=  

 kNm1711030
0,1

1,1
151,0M

γ

γ
kM pl,Rd

M,fi

M,θ

y,θfi,t,Rd =×







×=×










×=  

 

 Nachweis der Tragfähigkeit für S 235: 

 177,0
169

130

V

V

fi,t,Rd

fi,Ed
≤==   Nachweis erbracht 

 19,1
171

325

M

M

fi,t,Rd

fi,Ed
≤==   Nachweis nicht erbracht 

 

Der Nachweis für die Tragfähigkeit im Brandfall kann für einen Stahl der Sorte S 235 nicht 

erbracht werden. Nachfolgend wird der Nachweis für die höherfeste Stahlgüte  

S 460 geführt. 
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Bemessungswert der Biege- und Querkraftbeanspruchbarkeit im vollplastischen 

Zustand zum Zeitpunkt t = 30 min: 

 kN3311994
0,1

1,1
151,0Vfi,t,Rd =×








×=  

 kNm3352016
0,1

1,1
151,0M fi,t,Rd =×








×=  

 

 Nachweis der Tragfähigkeit für S 460: 

 139,0
331

130

V

V

fi,t,Rd

fi,Ed
≤==   Nachweis erbracht 

 197,0
335

325

M

M

fi,t,Rd

fi,Ed
≤==  Nachweis erbracht 

 

Durch eine Erhöhung der Stahlgüte auf einen Feinkornbaustahl S 460 kann so eine 

Feuerwiderstanddauer von 30 Minuten erreicht werden. 

Im Vergleich wird der gleiche Nachweis anschließend noch mit dem in Abschnitt 5.3 

vorgestellten FR-Stahl geführt. Dieser besitzt bei einer Temperatur von 766 °C nach 

Abbildung 5-1 noch eine Reststreckgrenze von 29 %, also 0,29/ff Cy,20y,θ =° . 

 

Bemessungswert der Biege- und Querkraftbeanspruchbarkeit im vollplastischen 

Zustand zum Zeitpunkt t = 30 min: 

 kN3801192
1,0

1,1
0,29V Rdt,fi, =×








×=  

 kNm3841205
1,0

1,1
0,29M Rdt,fi, =×








×=  

  

 Nachweis der Tragfähigkeit für FR-Stahl: 

 10,34
380

130

V

V

Rdt,fi,

Edfi,
≤==   Nachweis erbracht 

 10,85
384

325

M

M

Rdt,fi,

Edfi,
≤==  Nachweis erbracht 

 

Beim Vergleich der geführten Nachweise des höherfesten Stahls S 460 und des 

feuerresistenten Stahls ist deutlich zu erkennen, dass mit der Wahl eines höherfesten Stahls 

annähernd die Eigenschaft des FR-Stahls erreicht werden kann. 
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Die Verwendung des FR-Stahls wird also nur seltenen Fälle ohne Alternativen bleiben und 

letztendlich werden Effizienz und Verfügbarkeit darüber entscheiden, welcher Stahl für eine 

R 30-Konstruktion verwendet wird. 

 

5.4.2 Ungeschützte Stahlstütze im Brandfall 

Als zweites Beispiel ist eine Stahlstütze mit einer Länge von L = 3,0 m für die ständige und 

außergewöhnliche Bemessungssituation nachzuweisen.  

Dabei soll durch ‚Overmarching’, d.h. der Auswahl  von massigeren Profilen und der 

Verringerung des Profilfaktors, die Widerstandsfähigkeit für die außergewöhnliche 

Bemessungssituation im Brandfall erhöht werden.  

Die Stahlstütze ist am unteren Auflager gelenkig, am oberen Auflager verschieblich gehalten 

und kann somit als Pendelstab betrachtet werden. Da es sich um ein Bauteil mit planmäßig 

zentrischem Druck handelt, ist ebenfalls ein Nachweis gegen Biegeknicken zu führen. Für 

die Knicklänge im ‚Kaltzustand’ ist der Eulerfall 2 mit Lcr = 1,0 x L maßgebend [24].  

In Abbildung 5-5 ist die entsprechende Systemskizze mit den aufgebrachten Lasten 

abgebildet. 

 

  

 Abb. 5-5: Statisches System Pendelstütze mit Belastung 

 

 Belastung: 

 kN0,1150G k =        

 kN0,600Qk =  
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Zunächst wird wie im vorangegangenen Beispiel der Grenzzustand der Tragfähigkeit bei 

Raumtemperatur nach DIN EN 1993-1-1 [6] berechnet. 

 

 Resultierende Normalkraft aus Belastung: 

 kN5,24526005,1115035,1NEd =×+×=  

 

 Abminderungsfaktor χ  für HEB 300 Profil der Stahlgüte S 235: 

 421,0
9,9358,7
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=
×

=
×

=
×

=  
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 Resultierender Bemessungswert der Knickfestigkeit: 

 kN3,2820
1,1

5,23149886,0fA
N

1M

y

Rd,b =
××

=
γ

××χ
=  

 

 Nachweis gegen Biegeknicken: 

 0,187,0
3,2820

5,2452

N

N

Rd,b

Ed ≤==      Nachweis erbracht 

 

Der Nachweis wurde für drei weitere Stahlgüten geführt und daraus die notwendigen Profile 

mit den dazugehörigen Werten der Biegeknickbeanspruchbarkeit ermittelt. In nachfolgender 

Tabelle 5-2 sind die entsprechenden Ergebnisse aufgeführt. 

Hier ist zu erkennen, dass mit der Anwendung höherer Stahlgüte erwartungsgemäß die 

Knickfestigkeit erhöht und so schlankere Profile gewählt werden können. 
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Stahlgüte Profil Am / V [-] Nb,Rd [kN] 

S 235 HEB 300 116 2820,0 

S 275 HEB 280  123 2783,7 

S 355 HEB 240 131 2592,7 

S 460 HEB 220 140 3028,8 

 Tab. 5-2: Biegeknickbeanspruchbarkeit der ständigen Bemessungssituation 

 

Nachfolgend wird der Nachweis der Tragfähigkeit im Brandfall nach DIN EN 1993-1-2 [7] 

geführt, wobei eine vierseitig beflammte Stütze angenommen wird.  

Die Profile werden aus der Baureihe der HEM-Träger gewählt, da das Verhältnis beflammter 

Oberfläche zum Volumen sehr günstig ausfällt und so niedrige Profilfaktoren erreicht werden. 

Der Nachweis gegen Biegeknicken ist ähnlich der ständigen Bemessungssituation, wird 

jedoch durch temperaturabhängige Faktoren abgemindert.  

Die Knicklänge darf für den Brandfall nach DIN EN 1993-1-2 [7] bei einem gegen 

Seitenverschiebung gesicherten Rahmen mit durchgehenden Stützen und innenliegende 

Stockwerken, die einen eigenen Brandabschnitt bilden, mit  

lfi = 0,5 x L bzw. für oberste Stockwerke mit lfi = 0,7 x L angenommen werden.  

In diesem Beispiel wird eine durchgehende Stahlstütze in einem unteren Geschoss  mit 

einem durch schubsteife Wände ausgesteiften Rahmen betrachtet (lfi = 0,5 x L).  

 

 Resultierende Normalkraft aus Belastung: 

 kN14506005,011500,1N Ed,fi =×+×=  

 

 Stahltemperatur bei t = 30 Min nach Kapitel 5.1.1: 

 C681
3045,154

3025,124045,15420
θ

531,1

531,1

30a, °≈
+

×+×
=  

 

 Abminderungsfaktoren bei Tmax = 681 °C: 

 276,0k y,θ =  

 168,0k ,E =θ  
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Abminderungsfaktor fiχ  für HEM 300 Profil der Stahlgüte S 235: 
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 Resultierender Bemessungswert der Biegeknickbeanspruchbarkeit: 

 kN5,1670
0,1

5,23303
276,0850,0

fA
kN

fi,M

y

,yfiRd,30,fi,b =
×

××=
γ

×
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 Nachweis gegen Biegeknicken: 

 0,187,0
5,1670

0,1450

N

N

Rd,30,fi,b

Ed,fi
≤==   Nachweis erbracht 

 

Der Nachweis wurde ebenfalls für die drei weiteren Stahlgüten geführt und daraus die 

notwendigen Profile mit den dazugehörigen Werten der Biegebeanspruchbarkeit im Brandfall 

ermittelt. In Tabelle 5-3 sind die entsprechenden Ergebnisse aufgeführt. 

 

 

 

 

 

 

 

 Tab. 5-3: Biegeknickbeanspruchbarkeit der außergewöhnlichen Bemessungssituation 

 

Vergleicht man die für den Brandfall ermittelten Profile mit denen der ständigen 

Bemessungssituation aus Tabelle 5-2, so ist festzustellen, dass Profile mit einem deutlich 

Stahlgüte Profil Am / V [-] Nb,fi,30,Rd [kN] 

S 235 HEM 300 60 1670,9 

S 275 HEM 300  60 1670,9 

S 355 HEM 280 71 1453,4 

S 460 HEM 240 73 1456,9 
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geringeren Profilfaktor zu wählen sind. Für die Stahlgüte S 235 muss beispielsweise ein um 

die Hälfte verringerter Profilfaktor angesetzt werden, das bedeutet hier den Einsatz eines 

HEM 300 Profiles anstatt eines HEB 300. 

Unter wirtschaftlichen Aspekten betrachtet bedeutet das einen doppelt so hohen Stahlbedarf. 

Ausgedrückt in Zahlen errechnet sich für das schlankere Profil ein Wert von 120 kg/m, für 

das massigere Profil muss mit 240 kg/m bereits das zweifache an Materialkosten 

veranschlagt werden. 
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6 Anwendungsbeispiel aus dem Stahlhochbau 

In diesem Kapitel soll am Beispiel eines Bürogebäudes aus Stahl das vereinfachte und 

allgemeine Nachweisverfahren nach DIN EN 1993-1-2 [7] angewendet werden  

(vgl. Kapitel 4). 

Die Berechnung wird exemplarisch an einem zweistöckigen Rahmentragwerk aus Stahl 

durchgeführt. Abmessungen und Lastannahmen sind der Statik des Bürogebäudes der BFT 

Planung GmbH und BFT Cognos GmbH entnommen, das in Stahlbetonbauweise realisiert 

wurde. Die Wind- und Schneelasten werden nach den Bemessungsregeln der DIN EN 1991-

1-3(4) [4,5] neu errechnet.  

Für den Rahmen werden gelenkige Fußpunkte und biegesteife Eckverbindungen gewählt, 

Abbildung 6.1 zeigt das statische System mit entsprechenden Lastannahmen und 

Abmessungen (vgl. Anhang A). 

Es ist zunächst der Nachweis der Tragfähigkeit für die ständige Bemessungssituation, die so 

genannte ‚Kalte Bemessung’ nach DIN EN 1993-1-1 [2], notwendig. Mit den sich daraus 

ergebenden Stahlprofilen wird anschließend der Nachweis der Tragfähigkeit für die 

außergewöhnliche Bemessungssituation, der ‚heißen Bemessung’ nach  

DIN EN 1993-1-2 [7], geführt. Dieser teilt sich in das o.g. vereinfachte und allgemeine 

Nachweisverfahren auf. 

 

  

 Abb. 6-1: Statische System mit Belastung 
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6.1 Kalte Bemessung 

Der Nachweis der Tragfähigkeit für die ständige Bemessungssituation wird nach den Regeln 

der DIN EN 1993-1-1 [6] durchgeführt.  

Die Schnittgrößen werden mit dem Programm InfoCAD berechnet, wobei für die jeweilig 

maßgebenden Schnittkräfte verschiedene Lastfallkombinationen berücksichtigt werden 

müssen.  

Für die Lastfallkombinationen werden die Teilsicherheitsbeiwerte nach DIN EN 1990 [1] 

Tabelle A.1.2(A) mit γG,j = 1,35 für die ständigen Einwirkungen und γQ,i = 1,5 für die 

veränderlichen Lasten angesetzt. Für Kombinationen mit mehreren veränderlichen Lasten 

muss der Kombinationsbeiwert ψ0,i = 0,7 für Bürogebäude nach DIN EN 1990 [1] Tabelle 

A.1.1 zusätzlich berücksichtigt werden (vgl. Kapitel 4.2). 

Aus diesen Vorgaben ergeben sich die nachfolgend dargestellten Lastfallkombinationen für 

die ständige Bemessungssituation wie folgt (vgl. Anhang A): 

 

� Kombination für eine veränderliche Einwirkung 

- LFK 1: kk q5,1g35,1 +∑  (Nutzlast) 

- LFK 2: kk s5,1g35,1 +∑  (Schneelast) 

- LFK 3: kk w5,1g35,1 +∑  (Windlast) 

 

� Kombination für zwei oder mehrere veränderliche Einwirkungen 

- LFK 4: ( )[ ]kkkk swq5,17,0g35,1 +++∑  (Nutz-, Wind- und Schneelast) 

- LFK 5: ( )[ ]kkk sq5,17,0g35,1 ++∑  (Nutz- und Schneelast, ohne Windlast) 

 

Die Schnittgrößenverläufe der 5 Lastfallkombinationen aus InfoCAD sind in Anhang A 

abgebildet, außerdem ist der jeweilig maßgebende Lastfall für jeden Nachweis einzeln 

ausgewiesen. 

Anschließend werden die erforderlichen Nachweise, abhängig von der vorhandenen 

Einbausituation, für die einzelnen Positionen durchgeführt und so die erforderlichen 

Querschnitte der Stahlprofile ermittelt (vgl. Abbildung 6-2). Als Stahlprofile werden hierbei 

Profile der Baureihe HEA gewählt, da für eine Bemessung im Brandfall der Profilfaktor im 

Gegensatz zu IPE-Profilen günstiger ausfällt. Profile der HEB- bzw. HEM-Baureihe werden 

aus wirtschaftlichen Gründen nicht angesetzt. Die Stützen werden als durchgehende Stützen 

angenommen, somit ist der jeweils größere Querschnitt der unteren bzw. oberen Ebene 

maßgebend. 
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 Abb. 6-2: Darstellung der Positionen mit erforderlichen Querschnitten 

 

6.2 Heiße Bemessung 

Der Nachweis der Tragfähigkeit für die außergewöhnliche Bemessungssituation wird nach 

den Regeln der DIN EN 1993-1-2 [7] durchgeführt. Am Beispiel des Rahmens sollen das 

vereinfachte Nachweisverfahren über die Berechnung der Festigkeit einzelner Bauteile  

(vgl. Kapitel 4.3.1) und das allgemeine Berechnungsverfahren (vgl. Kapitel 4.4) über die 

Berechnung des Gesamttragwerkes mit SAFIR durchgeführt werden. 

Wie in Kapitel 4.2 beschrieben, ist für den Brandfall eine besondere Lastfallkombination zu 

berücksichtigen. Die Kombinationsbeiwerte der veränderlichen Lasten für Bürogebäude, 

ausgenommen Wind- und Schneelasten, sind in Tabelle A.1.1 der DIN EN 1990 [1] mit  

ψ2 = 0,5 angegeben. Die Kombinationsbeiwerte der Wind- und Schneelasten werden nach 

o.g. Tabelle im Hochbau mit ψ2 = 0,0 angesetzt, dementsprechend sind diese Lasten nicht 

zu berücksichtigen. 

Daraus ergibt sich für den Brandfall lediglich die folgende, maßgebende Lastfallkombination 

(vgl. Anhang A): 

 

� Kombination für eine veränderliche Einwirkung 

- LFK 1: kk q5,0g0,1 +∑  (Nutzlast) 

 

Die Schnittgrößenverläufe sind ebenfalls in Anhang A, berechnet mit InfoCAD, dargestellt. 

Als Brandszenario wird ein Brand in der unteren Ebene mit der Einheitstemperaturkurve 
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nach DIN EN 1991-1-2 [3] angesetzt. Die Beflammungsseiten der Profile sind abhängig von 

der örtlichen Anordnung der Profile und werden entsprechend berücksichtigt. 

 

6.2.1 Vereinfachtes Nachweisverfahren 

Das vereinfachte Nachweisverfahren über die Berechnung der Festigkeit 

stabilitätsgefährdeter Einzelbauteile (vgl. Kapitel 4.3.1) wird nach den Bemessungsregeln der 

DIN EN 1993-1-2 [7] mit entsprechenden Abminderungsfaktoren nach Tabelle 2-4 (vgl. 

Kapitel 4.1) durchgeführt.  

Diese Faktoren sind durch Interpolation so gewählt, dass die Nachweise unter nahezu 

vollständiger Ausnutzung der Traglastreserven erfüllt werden. Nach Bestimmung der 

Abminderungsfaktoren wird die dazugehörige Temperatur als maximale Bauteiltemperatur 

definiert, bei deren Einhaltung ein Versagen der jeweiligen Bauteile ausgeschlossen werden 

kann.  

Anschließend wird für die jeweiligen Bauteile eine thermische Analyse mit SAFIR 

durchgeführt (vgl. Anhang A), nach der mit dem Temperaturverlauf gleichzeitig die 

Versagenszeit bestimmt werden kann. In Tabelle 6-1 sind die Versagenszeiten der einzelnen 

Bauteile nach Positionen sortiert aufgeführt. 

 

  

 

 

 

 

 Tab. 6-1: Versagen der Einzelbauteile in Minuten  (vereinfachtes Nachweisverfahren) 

 

Mit dem vereinfachten Nachweisverfahren können nur Einzelbauteile erfasst werden, von 

daher ist die Versagenszeit des schwächsten Bauteiles entscheidend. Demnach ist das 

Versagen der vierseitig durch die Einheitstemperaturkurve beanspruchten mittleren Stütze 

(Position 3) mit 11 Minuten maßgebend. 

 

Bauteilposition Versagenszeit 

Position 1 12 Min. 

Position 3 11 Min. 

Position 5 12 Min. 

Position 7 14 Min. 

Position 8 13 Min. 
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6.2.2 Allgemeines Nachweisverfahren mit SAFIR 

Das allgemeine Nachweisverfahren wird mit dem FEM - Programm SAFIR geführt. Hierzu ist 

für die einzelnen Stahlprofile eine thermische Analyse unter Berücksichtigung der je nach 

Einbausituation auftretenden Brandbeanspruchung (ETK) mit SAFIR notwendig. 

Anschließend wird mit Hilfe des Programmes GID das in Abbildung 6-1 abgebildete 

Tragwerk modelliert, die zuvor erzeugten Daten aus der thermischen Analyse entsprechend 

implementiert, die Lasten aufgebracht und ein FEM - Netz generiert.  

Da im Rahmen dieser Arbeit ausschließlich die Demonstrationsversion von SAFIR zur 

Verfügung stand, wurde die anschließende Berechnung mit SAFIR in Kooperation mit dem 

‚Building and Construction Support’ der Firma ArcelorMittal in Luxemburg durchgeführt. 

Hierzu wurden die ‚file.in’-Dateien per e-mail an den zuständigen ‚Technical Assistent’ 

gesandt, um anschließend den ‚Output-File’ mit entsprechenden Berechnungsergebnissen 

zur weiteren Auswertung zu erhalten. 

Nach der Berechnung des Tragwerkes mit SAFIR tritt ein Gesamtversagen der Konstruktion 

bei Brandbeanspruchung durch die Einheitstemperaturkurve nach 17 Minuten (1020 Sek.) 

ein (vgl. Abbildung 6-3). Hierbei ist ein Versagen der mittleren vierseitig beflammten Stütze 

(Pos. 3) mit einer maximalen horizontalen Verschiebung von 18,6 cm maßgebend  

(vgl. Abbildung 6-4). 

 

  

 Abb. 6-3: Gesamtverformung im Brandfall bei t = 17 Min. (SAFIR) 
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 Abb. 6-4: Verformung ux der mittleren Stütze über die Zeit 

 

Im Vergleich zu der zuvor durchgeführten Analyse nach dem vereinfachten 

Nachweisverfahren in Kapitel 6.2.1 kann festgestellt werden, dass bei gleichbleibenden 

Querschnitten allein durch die Nutzung der Systemreserven in Form von 

Schnittgrößenumlagerung die Feuerwiderstandsdauer im Brandfall um 6 Minuten bzw. 55 % 

gesteigert werden kann.  

 

6.3 Nachweis der Feuerwiderstandsdauer R 30 

Nachdem in Kapitel 6.2 gezeigt wurde, dass bei Brandbeanspruchung durch die 

Einheitstemperaturkurve das Rahmentragwerk unabhängig vom Nachweisverfahren 

frühzeitig versagt, soll im Folgenden durch Nutzung verschiedener Methoden die 

Feuerwiderstandsklasse R 30 erreicht werden. 

Hierbei sollen die Methode des ‚Overmarching’ und die Beanspruchung des Tragwerkes 

durch eine Naturbrandkurve angewendet werden. 

 

6.3.1 ‚Overmarching’ 

Zunächst sollen durch das so genannte ‚Overmarching’ (vgl. Kapitel 5.2) der Widerstand im 

Brandfall erhöht und so die Feuerwiderstandsdauer entsprechend verlängert werden. 

Exemplarisch soll diese Methode an der vierseitig beflammten Stütze (Position 3) 

durchgeführt werden, die zudem bei dem vereinfachten Nachweisverfahren die kürzeste 

Feuerwiderstandsdauer aufweist (vgl. Kapitel 6.2.1). 

Hierzu ist eine thermische Analyse mit SAFIR notwendig (vgl. Abbildung 6-5),  um so die 

nach 31 Minuten erreichte, maximale Temperatur im Stahlquerschnitt zu ermitteln. Anhand 

dieser Temperatur ( C800Tmax, °≤θ ) können nach Tabelle 4-4 die entsprechenden 
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Abminderungsfaktoren bestimmt und so die Nachweise mit einem ausreichend 

überdimensionierten Stahlprofil berechnet werden. Hierbei wird ein Profil der Baureihe HEB 

gewählt, welches gegenüber der HEA-Baureihe einen kleineren Profilfaktor bei gleichzeitig 

kompakten Außenmaßen aufweist.  

Unter Berücksichtigung der Gebrauchstauglichkeit wird die höhere Stahlgüte S 355 gewählt, 

womit ein kleinerer Querschnitt gegenüber einer niedrigeren Stahlgüte erreicht werden kann. 

Die Berechnung wird mit einem Stahlprofil HEB 360 der Stahlgüte S 355 durchgeführt  

(vgl. Anhang A).   

Aus wirtschaftlicher Sicht bedeutet die Methode des ‚Overmarching’ hier im Vergleich zu 

dem Stahlprofil HEA 240 einen deutlich höheren Mehraufwand an Material. In diesem Fall ist 

eine Analyse des Gesamttragwerkes empfehlenswert, da hiermit kleinere Profile realisiert 

werden können und so Material eingespart wird.  

Der allgemeine Nachweis für die Feuerwiderstandsklasse R 30 konnte leider nicht 

durchgeführt werden, da im Rahmen dieser Arbeit nur die Demonstrationsversion zur 

Verfügung stand. Der Zugriff auf eine Vollversion über ArcelorMittal kam hier nicht in 

Betracht, da eine Vielzahl von Änderungen und erneuten Berechnungen des Tragwerkes 

notwendig sind, um sich an eine Versagenszeit von 31 Minuten ‚heranzutasten’ und der 

Aufwand für den Mitarbeiter der Abteilung ‚Building and Construction Support’ so gering wie 

möglich gehalten werden sollte.  

 

  

 Abb. 6-5: Temperaturverlauf eines Stahlprofils HEB-360 bei t=31 Min. (SAFIR)  
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6.3.2 Naturbrandszenario 

Als Alternative zur Einheitstemperaturkurve besteht die Möglichkeit der Entwicklung einer 

Naturbrandkurve (vgl. Kapitel 2.3.1). 

Für das hier betrachtete Bürogebäude soll ein allgemeines Brandmodell (vgl. Kapitel 2.1.2) in 

vereinfachter Form mit dem Brandsimulationsprogramm OZone als Zwei-Zonen-Modell 

berechnet werden.  

Hierbei wird ein Flügel des Bürotraktes in OZone als Brandraum modelliert, wobei die Fläche 

des Brandes auf die Größe zweier Büroräume (50 m²) beschränkt ist. Auf Grund der 

Abtrennung durch leichte Trennwände bzw. Glaselemente, alle ohne brandschutztechnische 

Anforderungen, wird eine verzögerte Brandausbreitung in der unteren Ebene angenommen 

Die vorhandenen Fenster und der Durchgang zum Foyer werden als Öffnungen 

berücksichtigt, wodurch eine Sauerstoffzufuhr möglich ist. Hierbei wird die Öffnung der 

Fensterflächen abhängig von der Temperatur in drei Schritte unterteilt (5 % bei 20 °C, 25 % 

bei 300 °C, 100 % bei 500 °C). 

Als charakteristische Brandlastdichte werden für Bürogebäude nach DIN EN 1991-1-2 [3] 

Tabelle E.4 420 MJ/m² eine 80%-Fraktile von 511 MJ/m² und eine maximale 

Energiefreisetzungsrate von 250 kW/m² bei mittlerer Brandausbreitung angesetzt. Die 

Entwurfsbrandlastdichte qf,d errechnet sich zu 593,1 MJ/m² (vgl. Kapitel 2.3.2). In Anhang C 

ist der entsprechende Ergebnisbericht von OZone mit Eingangsdaten und 

Berechnungsergebnissen aufgeführt. 

In Abbildung 6-6 ist zu erkennen, dass nach 40 Minuten eine maximale Heißgastemperatur 

von 457 °C erreicht und eine Temperatur von 434 °C im Deckenträger HEA 260 (Position 8) 

nicht überschritten wird. 

  

 Abb. 6-6: Heißgas- und Stahltemperatur in Abhängigkeit von der Zeit (OZone) 

 

Bei Ansatz dieser Naturbrandkurve kann ein Versagen des Tragwerks ausgeschlossen 

werden, da nach Kapitel 6.2.1 (Tabelle 6-1) sämtliche berechnete Versagenstemperaturen 

der Einzelbauteile oberhalb der hier ermittelten maximalen Heißgastemperatur liegen.  
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6.4 Ausgeführte Bauobjekte 

In diesem Kapitel sollen dem Leser ausgewählte Objekte vorgestellt werden, die in der 

Vergangenheit unter Anwendung des allgemeinen Nachweisverfahrens oder von 

Brandsimulationsberechnungen in ungeschützter Stahlbauweise errichtet wurden (vgl. [19]). 

Anhand dieser Beispiele wird deutlich, dass für Gebäude mit hohem Investitionsvolumen der 

Aufwand einer solchen Berechnung unter wirtschaftlichen Aspekten einen großen Vorteil 

bedeutet. So kann oftmals durch gezielte Brandschutzmaßnahmen ein hohes 

Einsparpotenzial realisiert und gleichzeitig ein Bauwerk erstellt werden, welches die 

ästhetischen Vorstellungen von Architekt und Bauherrn erfüllt. 

 

6.4.1 Multifunktionshalle ‚Kölnarena’ 

Die ‚Kölnarena’ i.d. Nähe des Kölner Doms wurde nach 26 Monaten Bauzeit mit einem 

Investitionsvolumen von 150 Miilionen Euro im August 1998 fertiggestellt. Die Gesamtfläche 

der Arena umfasst 83.700 m² mit einer maximalen Zuschaueranzahl von 20.000 Personen. 

Im Mittelpunkt steht der über 187 m in Nord-Süd-Richtung gespannte Bogen mit einer 

Gesamthöhe von maximal 76 m. Als Querschnitt wurde ein auf dem Kopf stehendes Dreieck 

mit 3 m Höhe sowie 3 m Breite gewählt. Das Dachtragwerk wird von 28 Fachwerkträgern 

getragen, die in einem Abstand von 

5 m angeordnet und mittels 

Rundrohren (Durchmesser 177 mm) 

am zentralen Bogen über der Halle 

angeschlossen sind. Die übrige 

Konstruktion ist als tragender Ring 

ausgebildet, bei dem die 

Lastabtragung über 36 ringförmig 

angeordnete Stahlstützen im 

Außenbereich erfolgt.  

Für die Bemessung im Brandfall wurden als mögliche Naturbrandszenarien Brände im 

Veranstaltungsbereich, im Sitzplatzbereich und im obersten Bereich der Tribünen untersucht. 

Als Konsequenz daraus wurde der Bogen bis 3 m oberhalb des Daches durch 20 mm starke 

Brandschutzplatten vor direkter Flammeneinwirkung und daraus resultierenden, hohen 

Temperaturen geschützt (R 90). Die 3 m hohen Fachwerkträger und außenliegenden 

Rundstützen bleiben ungeschützt, da sie keiner nennenswerten Brandbeanspruchung 

ausgesetzt sind. Gleiches gilt für die Hänger aus Rundrohren, die oberhalb des Daches 

angeordnet sind.  
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6.4.2 Shopping Centre ‚Cactus’ 

Das im Jahr 2003 eröffnete Einkaufszentrum ‚Cactus’ in Esch-sur-Alzette (Luxemburg) mit 

einer Grundfläche von 28,5 x 48,0 m und einer maximalen Höhe von 9,1 m besteht aus 

einem Portalrahmen in Stahlbauweise mit einer Stützweite von 20 m. Der Rahmen besteht 

aus Wabenträgern mit einer Bauhöhe von 

590 mm und Stahlstützen der Baureihe 

HEB 500. Die Rahmen sind in einem 

Abstand von 6 m angeordnet und über 

Pfetten (IPE 200) miteinander verbunden. 

Die räumliche Aussteifung erfolgt über die 

Rahmen und einen Verband auf jeder Seite. 

Als Werkstoff wurde Baustahl der Güte  

S 235 verwendet. 

Die erforderliche Feuerwiderstandsdauer von 90 Minuten wurde durch Anwendung eines 

Naturbrandkonzeptes realisiert. Hierbei wurden eine automatische Brandmeldeanlage mit 

Aufschaltung zur Feuerwehr sowie Rauch- und Wärmeabzüge berücksichtigt. Eine bei 

Gebäuden dieser Größenordnung sonst übliche Sprinkleranlage wurde nicht vorgesehen. Mit 

OZone konnte, unter Annahme einer charakteristischen Brandlast von 730 MJ/m², eine 

maximale Stahltemperatur der Stützen von 880 °C 

ermittelt werden. Außerdem wurde das Tragwerk 

als 3D-Modell mit der Brandbemessungssoftware 

SAFIR modelliert und eine thermische und 

mechanische Analyse des Gesamttragwerks 

durchgeführt. Zusätzlich wurde der Träger als 

Schalenelement abgebildet und berechnet, um ein 

mögliches Versagen auszuschließen.  

So konnte durch Anwendung des allgemeinen 

Nachweisverfahrens in Kombination mit einem Naturbrandkonzept die Tragfähigkeit im 

Brandfall für die ungeschützte Stahlkonstruktion nachgewiesen werden.  

Als einzige Brandschutzmaßnahme am Stahlrahmen wurde im Brandschutzkonzept eine 

konstruktive Verstärkung der Halskehlnähte von 3 mm auf 5 mm vorgeschrieben, um im 

Brandfall eine Lastumlagerung der auftretenden Kräfte sicherzustellen.   
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6.4.3 Bürogebäude ‚State Street Bank’ 

Innerhalb einer zweijährigen Bauzeit wurde in Luxemburg im Jahr 2000 ein 4-geschossiges 

Bürogebäude der ‚State Street Bank’ mit 3-geschossiger Tiefgarage erstellt. Die 

Tragkonstruktion bildet ein Dreifeld-

rahmen mit Spannweiten von 15,15 m in 

den äußeren Feldern und  

8,5 m im mittleren Feld. Der Rahmen- 

abstand beläuft sich auf 4,5 m, wobei 

die räumliche Aussteifung durch 

innenliegende Betonkerne mit Treppen 

und Fahrstühlen sichergestellt wird. Als 

Deckenträger kommen in den Büroräumen Verbundträger zum Einsatz, wobei je nach 

Stützweite die Stahlgüte zwischen S 355 (8,5 m) und S 460 (15,15 m) variiert.  Für die 

Stützen wurden kammerbetonierte Verbundstützen der Stahlgüte S 355 verwendet. Die 

Deckenstärke beträgt im Rohbaumaß 16 cm, der verwendete Beton entspricht wie auch bei 

den Verbundbauteilen der Klasse C30/37.  

Für die Tiefgarage wurden neben den  o.g. Verbundstützen ebenfalls kammerbetonierte 

Verbundträger verwendet, um einem 

möglichen Brandereignis zu 

widerstehen. 

Die brandschutztechnische Bemessung 

wurde auch hier unter Ansatz eines 

Naturbrandkonzeptes durchgeführt. Auf 

der Grundlage einer automatischen  

Brandmeldeanlage mit Aufschaltung zur 

Feuerwehr, Rauch- und Wärmeabzügen sowie einer charakteristischen Brandlast von  

511 MJ/m² konnte mit OZone eine maximale Stahltemperatur von 850 °C für einen  

IPE 600-Träger berechnet werden. Auf eine selbsttätige Löschanlage wurde verzichtet. 

Außerdem wurde mit der Brandbemessungssoftware 

CEFICOSS der am stärksten belastete Rahmen unter 

Brandeinwirkung analysiert und ein frühzeitiges Tragversagen 

ausgeschlossen.  

Im Brandschutzkonzept wurden zusätzliche Maßnahmen, wie 

eine Verlängerung der Kopfplatten mit einer Schraubenreihe 

innerhalb der Betondecke, vorgesehen, um die Übertragung 

von Schubkräften im Brandfall zu ermöglichen. Des Weiteren 



Anwendungsbeispiel aus dem Stahlhochbau  

  Seite 74  

wurde eine Zulagebewehrung über den Mittelauflagern eingebaut, um die aufnehmbaren 

Stützmomente bei einer Lastumlagerung zu erhöhen.  

Auch am Beispiel dieses Bauwerkes kann gezeigt werden, dass unter Ansatz des 

allgemeinen Nachweisverfahrens und eines Naturbrandszenarios ungeschütze Stahlbauteile 

verwendet werden können und eine automatische Feuerlöschanlage hier ebenfalls nicht 

notwendig ist.    

 

6.4.4 Aufstockung eines Schulgebäudes 

Zur Erweiterung der räumlichen Kapazitäten erfolgte im Jahr 2006/2007 eine Aufstockung 

des bestehenden Gebäudes der Gemeinschaftsgrundschule in Jülich [vgl. 27]. Hierbei wurde 

eine Tragkonstruktion auf das bestehende 2. Obergeschoss des Südflügels aufgesetzt, 

wobei die Stahlträger des Dachtragwerks in 

ungeschützter Stahlbauweise ausgeführt 

wurden. Entsprechend den Vorgaben der 

Bauordnung NRW muss das Tragwerk 

mindestens einen 30-minütigen 

Feuerwiderstand aufweisen, was für die 

offen liegenden Stahlträger nicht 

gewährleistet war. 

In Abstimmung mit der Genehmigungsbehörde erfolgte eine Brandsimulation, um die 

maximale Bauteiltemperatur in den unter der Decke befindlichen Stahlträgern zu ermitteln. 

Dabei wurde mit OZone ein Brand in einem Klassenraum 

mit einer der Nutzung entsprechenden Brandlast 

berechnet. Es konnten für die Stahlträger maximale 

Bauteiltemperaturen von ca. 190 °C bei einer maximalen 

Heißgastemperatur von 395 °C ermittelt werden. Auch 

ohne weitere statische Nachweise war die ermittelte 

Stahltemperatur hinsichtlich der Feurwiderstandsfähigkeit des Tragwerkes als unkritisch zu 

bewerten.  
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7 Zusammenfassung und Ausblick 

In dieser Arbeit wurden die Grundlagen für die brandschutztechnische Bemessung von 

Stahltragwerken nach Eurocode 1 und 3  vorgestellt. Neben den notwendigen Regelwerken 

wurden die nach europäischer Regelung neuen Bauteilklassifizierungen erläutert sowie die 

im Eurocode 1 implementierten Brandmodelle ausführlich dargestellt. 

Bei der thermischen Analyse von Stahlbauteilen zeigt sich, dass die Anwendung der in  

DIN EN 1993-1-2 [7] vorhandenen Berechnungsformeln für geschützte wie auch 

ungeschützte Bauteile nicht sehr anwenderfreundlich ist. Hier werden neben der 

Oberflächentemperatur eines Bauteiles aus einer Brandsimulation diverse andere 

Eingangsparameter benötigt, die eine alltägliche und schnelle Anwendung erschweren. Für 

eine praxisorientierte Anwendung ist die an der Universität Hannover entwickelte 

Näherungsformel [22] zur Temperaturberechnung von ungeschützten Stahlprofilen deutlich 

effizienter, was neben einer Validierung mit SAFIR auch anhand von Berechnungsbeispielen 

verdeutlicht wurde. 

Für die Berechnung der Tragfähigkeit im Brandfall wurden die nach DIN EN 1993-1-2 [7] 

vereinfachten und allgemeinen Nachweisverfahren detailliert vorgestellt und die Grundlagen 

der Materialeigenschaften von Stahl unter erhöhter Temperatur erläutert. Weiter wurde an 

praktischen Berechnungsbeispielen die Anwendung der o.g. Nachweisverfahren konkretisiert 

und so die Berechnung nach Eurocodes erläutert. 

Es zeigt sich, dass für nicht stabilitätsgefährdende Bauteile mit dem vereinfachten 

Nachweisverfahren über die Berechnung der kritischen Temperatur ein Verfahren zur 

Verfügung steht, mit dem eine schnelle Einstufung des Bauteiles erfolgen kann. Das 

Nachweisverfahren über die Berechnung der Festigkeit erfordert hingegen mehr Aufwand 

und ist, wie die Anwendungsbeispiele belegen, einer globalen Tragwerksanalyse nach dem 

allgemeinen Berechnungsverfahren unterlegen. Es sollte daher nur für Einzelbauteile bzw. 

kleinere Teiltragwerke zur Anwendung gebracht werden.  

An verschiedenen Berechnungsbeispielen wurde ein Vergleich zwischen der Methode des 

‚Overmarching’ und der Verwendung von feuerresistentem Stahl durchgeführt. Als Ergebnis 

zeigt sich, dass durch eine Überdimensionierung von Stahlprofilen eine ungeschützte 

Bauweise in der Feuerwiderstandsklasse R 30 möglich ist. Mit dem Einsatz von FR-Stahl 

kann diese ebenfalls erreicht werden, allerdings ist ein gleiches Ergebnis auch mit 

höherfesten Stählen zu realisieren. Nicht zuletzt sind Faktoren wie Effizienz, Verfügbarkeit 

und konstruktive Belange zu berücksichtigen und entscheidend für die Wahl der geeigneten 

Methode.       

Die Analyse der Systemreserven eines Tragwerkes verdeutlicht, dass der Effekt der 

Lastumlagerung in Abhängigkeit vom statischen System im Brandfall eine deutliche 
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Steigerung der Feuerwiderstandsdauer bewirken kann. Allerdings sind die jeweiligen 

Verbindungen konstruktiv so zu bemessen, dass eine Übertragung der Kräfte auch im 

Brandfall sichergestellt ist. 

Bei der Berechnung eines Rahmentragwerkes für ein Bürogebäude nach dem vereinfachten 

und allgemeinen Nachweisverfahren hat sich gezeigt, dass die Betrachtung des 

Gesamttragwerkes und die Berechnung mit SAFIR einen enormen Vorteil gegenüber der 

Berechnung der Einzelbauteile bringen. 

Dieses Anwendungsbeispiel belegt, welche Möglichkeiten für Tragwerksplaner und 

Brandschutzingenieure mit der Bemessung von Tragwerken nach dem allgemeinen 

Nachweisverfahren, auch unter Anwendung von Naturbrandkurven, gegeben sind.  

Auf internationaler Ebene findet das allgemeine Berechnungsverfahren große Anerkennung 

und wird bereits heute bei der Planung von anspruchsvollen Konstruktionen für den 

Nachweis der Tragfähigkeit im Brandfall verwendet, wogegen in Deutschland einer 

Zulassung noch mit Zurückhaltung begegnet wird. 

 

Mit der geplanten Einführung der Eurocodes im Jahre 2010 werden sich auch in Deutschland 

die ingenieurmäßigen Methoden im Brandschutz weiter etablieren und eine höhere 

Akzeptanz bei Bauherren und Genehmigungsbehörden bewirken.  

Insbesondere für den Stahlbau ist hier ein bisher nicht genutztes Potential vorhanden, was 

sich durch die thermische und mechanische Analyse von Gesamttragwerken mit geeigneter 

Brandbemessungssoftware (z.B. SAFIR) weiter erschließen ließe.  

Werden diese Nachweisverfahren mit Naturbrandszenarien und mit weiteren Entwicklungen, 

die der Verbesserung des Brandverhaltens dienen, verknüpft, so ist das der richtige Weg, 

um in Zukunft zunehmend mehr architektonisch ansprechende Stahlkonstruktionen in 

ungeschützter Bauweise realisieren zu können.  
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2 Statisches System 
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3 Einwirkungen 

 

� Dach:  

- Eigengewicht ³/, mkN25m160 ×  ²/, mkN04=  

- Dämmung ³/,, mkN010m170 ×  ²/, mkN170=  

- Dichtung 3-lagig  ²/, mkN170=  

- Gründach ³/, mkN10m100 ×  ²/, mkN01=  

- Abgeh. Decke  ²/, mkN250=  

  ∑ ²/, mkN595  

 mkN3529m255mkN595g Dachk /,,²/,, =×=⇒  

 

� Decke 

- Eigengewicht ²/, mkN25m180 ×  ²/, mkN54=  

- Bodenaufbau  ²/, mkN52=  

  ∑ ²/, mkN07  

 mkN7536m255mkN07g Deckek /,,²/,, =×=⇒  

 

� Seitenwände 

- KS-Mauerwerk ³/,, mkN18m23m1750 ××  mkN110 /,=  

 

 kN0353m255mkN110G Wandk ,,/,, =×=⇒  

 

� Nutzlast 

- Büroräume  ²/, mkN02=  

- Trennwände  ²/, mkN251=  

  ∑ ²/, mkN253  

 mkN0617m255mkN253qk /,,²/, =×=⇒  

 

� Schneelast 

- Aachen, h ≤ 285 müNN 

- Schneezone II → ²/, mkN850sk =  

- Schneelast für Flachdach 

 ²/,,,,, mkN68080010180sccs ktei =×××=×××µ=  
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 mkN573m255mkN680sk /,,²/, =×=⇒  

 

� Windlast 

- Windzone II → sm627v 0b /,, =  

- Winddruck auf Oberflächen 

 pebepepe cqzcczqw ××=×= )()(  

- Basisgeschwindigkeit 

 sm6276270101vccv 0bseasondirb /,,,,, =××=××=  

- Mittlere Windgeschwindigkeit 

 b0rm vzczczv ××= )()()(  

 mit 6590
30

46
2150

z

z
k46c

0

rr ,
,

,
ln,ln),( =








×=








×=  

 sm191862701659046vm /,,,,),( =××=⇒  

- Basisgeschwidigkeitsdruck 

 ²/,,,,², mkN476062725150v50q bb =××=×ρ×=  

- Böengeschwindigkeitsdruck 

 [ ] )²(,)()( zv50zl71zq mvp ×ρ×××+=  

 mit 3270

30

46
01

01
46lv ,

,
,

ln,

,
),( =









×

=  

 [ ] ²/,²,,,,),( mkN680019182515032707146qp =××××+=⇒  

- Geländefaktor 

 4291
4760

6800

q

zq
zc

b

p

e ,
,
,)(

)( ===  

- Winddruck/-sog Wand 

 ²/,,,, mkN51075047604291wDFläche e =××=⇒  

 ( ) ²/,,,, mkN27039047604291wEFläche e −=−××=⇒  
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- Winddruck/-sog Flachdach 

 ( ) ²/,,,, mkN6109047604291wGFläche e −=−××=⇒  

 ( ) ²/,,,, mkN4807047604291wHFläche e −=−××=⇒  

 ( ) ²/,,, mkN140204291wIFläche e ±=±×=⇒  

 

 

 

 

 

 

 

 

 

- Zusammenfassung Windlast (Streckenlast) 

 mkN682255mkN510wDFläche e /,,²/, =×=⇒  

 mkN421255mkN270wEFläche e /,,²/, −=×−=⇒  

 mkN203255mkN610wGFläche e /,,²/, −=×−=⇒  

 mkN522255mkN480wHFläche e /,,²/, −=×−=⇒  

 mkN740255mkN140wIFläche e /,,²/, ±=×±=⇒  

 

- Skizze Windlasten 
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4 Lastfallkombinationen 

4.1 Ständige Bemessungssituation 

 

� ]QψγQPγGγ[EE k,i,i0Q,i
1i

1k,1Q,Pk,jG,j
1j

d
>≥
∑+γ++∑=  (vgl. 4.1) 

 

� Kombination für eine veränderliche Einwirkung 

- LFK 1: kk q51g351 ,, +∑  (Nutzlast) 

- LFK 2: kk s51g351 ,, +∑  (Schneelast) 

- LFK 3: kk w51g351 ,, +∑  (Windlast) 

 

� Kombination für zwei oder mehrere veränderliche Einwirkungen 

- LFK 4: ( )[ ]kkkk swq5170g351 +++∑ ,,,  (Nutz-, Wind- und Schneelast) 

- LFK 5: ( )[ ]kkk sq5170g351 ++∑ ,,,  (Nutz- und Schneelast, ohne Windlast) 
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Resultierende Schnittgrößen der Lastfallkombinationen 

(ständige Bemessungssituation) 



Lastfallkombinationen 
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LFK 1 - Schnittgrößen My 

 

LFK 1 - Schnittgrößen Nx 

 

LFK 1 - Schnittgrößen Vz 

 



Lastfallkombinationen 

 

  A - 9   

LFK 2 - Schnittgrößen My 

 

LFK 2 - Schnittgrößen Nx  

 

LFK 2 - Schnittgrößen Vz 

 



Lastfallkombinationen 

 

  A - 10   

LFK 3 - Schnittgrößen My 

 

LFK 3 - Schnittgrößen Nx 

 

LFK 3 - Schnittgrößen Vz 

 



Lastfallkombinationen 

 

  A - 11   

LFK 4 - Schnittgrößen My 

 

LFK 4 - Schnittgrößen Nx  

 

LFK 4 - Schnittgrößen Qz 

 



Lastfallkombinationen 

 

  A - 12   

LFK 5 - Schnittgrößen My 

 

LFK 5 - Schnittgrößen Nx  

 

LFK 5 - Schnittgrößen Vz 

 



Lastfallkombinationen 

 

  A - 13   

4.2 Außergewöhnliche Bemessungssituation 

 

� ]Qψ)Qψoder(ψAPG[EE k,i,i2
1i

1k,1,21,1dk,j
1j

d
≥≥
∑++++∑=  (vgl. 4.1) 

 

� Kombination für eine veränderliche Einwirkung 

- LFK 1: kk q50g01 ,, +∑  (Nutzlast) 

- LFK 2: kk s00g01 ,, +∑  (Schneelast) 

- LFK 3: kk w00g01 ,, +∑  (Windlast) 

 

� Kombination für zwei oder mehrere veränderliche Einwirkungen 

- Wind- und Schneelasten werden im Brandfall gleich null gesetzt, somit bleibt 

nur eine veränderliche Einwirkung (s.o.) übrig 



Lastfallkombinationen 

 

  A - 14   

 

 

 

 

 

 

 

 

Resultierende Schnittgrößen der Lastfallkombination 

(außergewöhnliche Lastfallkombination) 



Lastfallkombinationen 

 

  A - 15   

LFK Brand - Schnittgrößen My 

 

LFK Brand - Schnittgrößen Nx 

 

LFK Brand - Schnittgrößen Vz 



Nachweis der Tragfähigkeit für die ständige Bemessungssituation 

 

  A - 16   

 

 

 

 

 

 

 

 

 

5 Nachweis der Tragfähigkeit für die ständige 

Bemessungssituation 



Nachweis der Tragfähigkeit für die ständige Bemessungssituation 

 

  A - 17   

Position 1: Stütze HEA 240 

 

� Kein Biegedrillknicken möglich, da durch Wandscheiben seitlich gehalten 

� Kein Biegeknicken senkrecht zur z-Achse 

 

� Schnittgrößen (LFK 1 maßgebend): 

- kNm754MEd ,max =  

- kN2407NEd ,max =  

- kN117VEd ,max =  

 

� Querschnittklassifizierung 

- Steg 

 33
f

235
33338721

57

164

t

c

y

=×=ε≤== ,
,

���� 

- Flansch 

 99257
12

87

t

c
=ε≤== , ���� 

⇒ Querschnittklasse 1 

 

� Biegeknicken senkrecht zur y-Achse 

- Knicklänge Lcr 

 011 ,=η  (gelenkig gelagert) 

 5230
184425242

25242

KKKK

KK

22212c

2c
2 ,

,,
,

=
+×

×
=

+++

+
=η  

 
( )
( )

50

2121

2121
y

60801

120201
k

,

,,

,,









ηη+η+η−

ηη−η+η−
=  

 
( )
( )

50

52300160523001801

523001120523001201
,

,,,,,,
,,,,,,










××++−

××−+−
=  2524

320

7760
K i ,==  

 582,=  1844
620

18260
51K 22 ,, =×=  

 m268203582Lcr ,,, =×=⇒   

 

- 8710
993

1

110

8261

i

L

1

cr ,
,,

=×=
λ

×=λ  KSL b → 340,=α    

- ( )[ ] ( )[ ] 9930871020871034015020150 22 ,,,,,,,, =+−+=λ+−λα+=Φ  



Nachweis der Tragfähigkeit für die ständige Bemessungssituation 

 

  A - 18   

- 6800
871099309930

11

22
y ,

²,²,,
=

−+
=

λ−Φ+Φ
=χ  

 

- Normalkraftbeanspruchbarkeit, abgemindert 

  kN71115
11

523876
6800N Rdb ,

,
,,

,, =
×

×=  

- Nachweis gegen Biegeknicken 

1360
71115

2407

N

N

Rdb

Ed ≤== ,
,

,

,

���� 

 

� Querkraftbeanspruchung 

- Wirksame Schubfläche 

 ( ) ( ) ²,,,,,, cm14252112275021242876tr2tbt2AA fwfv =××++××−=++−=  

- Querkraftbeanspruchbarkeit  

 
( ) ( )

kN1310
11

35231425

11

3fA
V

yV

Rdpl ,
,

/,,
,

/
, ===  

- Nachweis 

 1060
1310

117

V

V

Rdpl

Ed ≤== ,
,

,

,

���� 

 

� Biegebeanspruchung 

- Interaktion von M,N 

 RdplEd N250N ,, ×≥  

 2410
11

523876
2502407 ,

,
,,

,, =
×

×≥ �  nicht zu berücksichtigen 

- Interaktion von M,V 

 RdplEd V50V ,, ×≥  

 1155131050117 ,,,, =×≥ �  nicht zu berücksichtigen 

- Biegebeanspruchbarkeit, abgemindert 

 kNm9158
11

10523744

11

fw
M

2
ypl

Rdpl ,
,
,

,, =
××

=
×

=
−

 

- Nachweis 

 1340
9158

754

M

M

RdplN

Ed ≤== ,
,

,

,,

���� 

 

 



Nachweis der Tragfähigkeit für die ständige Bemessungssituation 

 

  A - 19   

� Biegung und Druckkraft 

- Äquivalenter Momentenbeiwert für Knicken 

 90cmy ,=  

 

- Interaktionsbeiwert  

 ( )














χ
+≤















χ
−λ+=

Rdy

Ed
my

Rdy

Ed
ymyyy

N

N
801c

N

N
201ck ,,  

 ( ) 







+≤








−+=

71115

2407
80190

71115

2407
208710190

,
,

,,
,
,

,,,  

 161121 ,, ≤= ���� 

- Nachweis Biegung und Druck 

 1
M

MM
k

N

N

RdyLT

EdyEdy

yy

Rdy

Ed ≤
χ

∆+
+

χ ,

,,  

 1
915801

0754
121

71115

2407
≤

×

+
+

,,
,

,
,
,

 

 1750 ≤, ���� 



Nachweis der Tragfähigkeit für die ständige Bemessungssituation 

 

  A - 20   

Position 2: Stütze HEA 240 

 

� Kein Biegedrillknicken möglich, da durch Wandscheiben seitlich gehalten 

� Kein Biegeknicken senkrecht zur z-Achse 

 

� Schnittgrößen (LFK 1 maßgebend): 

- kNm8100MEd ,max =  

- kN9117NEd ,max =  

- kN261VEd ,max =  

 

� Querschnittklassifizierung 

- Steg 

 33
f

235
33338721

57

164

t

c

y

=×=ε≤== ,
,

���� 

- Flansch 

 99257
12

87

t

c
=ε≤== , ���� 

⇒ Querschnittklasse 1 

 

� Biegeknicken senkrecht zur y-Achse 

- Knicklänge Lcr 

 5640
77182524

2524

KKKK

KK

12111c

1c
1 ,

,,
,

=
+

=
+++

+
=η  

 5230
184425242

25242

KKKK

KK

22212c

2c
2 ,

,,
,

=
+×

×
=

+++

+
=η  

 
( )
( )

50

2121

2121
y

60801

120201
k

,

,,

,,









ηη+η+η−

ηη−η+η−
=  

 
( )
( )

50

523056406052305640801

5230564012052305640201
,

,,,,,,
,,,,,,










××++−

××−+−
=  2524

320

7760
K i ,==  

 561,=  7718
620

7760
51K12 ,, =×=  

 m994203561Lcr ,,, =×=⇒  1844
620

18260
51K 22 ,, =×=  

 



Nachweis der Tragfähigkeit für die ständige Bemessungssituation 

 

  A - 21   

- 5260
993

1

110

4991

i

L

1

cr ,
,,

=×=
λ

×=λ  KSL b → 340,=α  

- ( )[ ] ( )[ ] 6940526020526034015020150 22 ,,,,,,,, =+−+=λ+−λα+=Φ  

- 8720
526069406940

11

22
y ,

²,²,,
=

−+
=

λ−Φ+Φ
=χ  

- Normalkraftbeanspruchbarkeit, abgemindert 

 kN71430
11

523876
8720N Rdb ,

,
,,

,, =
×

×=   

- Nachweis gegen Biegeknicken 

 1080
71430

9117

N

N

Rdb

Ed ≤== ,
,

,

,

���� 

 

� Querkraftbeanspruchung 

- Wirksame Schubfläche 

 ( ) ( ) ²,,,,,, cm14252112275021242876tr2tbt2AA fwfv =××++××−=++−=  

- Querkraftbeanspruchbarkeit 

 
( ) ( )

kN1310
11

35231425

11

3fA
V

yV

Rdpl ,
,

/,,
,

/
, ===  

- Nachweis 

 1200
1310

261

V

V

Rdpl

Ed ≤== ,
,

,

,

���� 

 

� Biegebeanspruchung 

- Interaktion von M,N 

 RdplEd N250N ,, ×≥  

 2410
11

523876
2509117 ,

,
,,

,, =
×

×≥ �  nicht zu berücksichtigen 

- Interaktion von M,V 

 RdplEd V50V ,, ×≥  

 1155131050261 ,,,, =×≥ �  nicht zu berücksichtigen 

- Biegebeanspruchbarkeit 

 kNm9158
11

10523744

11

fw
M

2
ypl

Rdpl ,
,
,

,, =
××

=
×

=
−

 

- Nachweis 

 1630
9158

8100

M

M

RdplN

Ed ≤== ,
,

,

,,

���� 



Nachweis der Tragfähigkeit für die ständige Bemessungssituation 

 

  A - 22   

� Biegung und Druckkraft 

- Äquivalenter Momentenbeiwert für Knicken 

 90cmy ,=  

 

- Interaktionsbeiwert  

 ( )














χ
+≤















χ
−λ+=

Rdy

Ed
my

Rdy

Ed
ymyyy

N

N
801c

N

N
201ck ,,  

 ( ) 







+≤








−+=

71430

8100
80190

71430

8100
205260190

,
,

,,
,
,

,,,  

 950920 ,, ≤= ���� 

- Nachweis Biegung und Druck 

 1
M

MM
k

N

N

RdyLT

EdyEdy

yy

Rdy

Ed ≤
χ

∆+
+

χ ,

,,  

 1
915801

08100
920

71430

9117
≤

×

+
+

,,
,

,
,
,

 

 1670 ≤, ���� 



Nachweis der Tragfähigkeit für die ständige Bemessungssituation 

 

  A - 23   

Position 3: Stütze HEA 240 

 

� Schnittgrößen (LFK 4 maßgebend): 

- kNm959MEd ,max =  

- kN4634NEd ,max =  

- kN718VEd ,max =  

 

� Querschnittklassifizierung 

- Steg 

 33
f

235
33338721

57

164

t

c

y

=×=ε≤== ,
,

���� 

- Flansch 

 99257
12

87

t

c
=ε≤== , ���� 

⇒ Querschnittklasse 1 

 

� Biegeknicken senkrecht zur z-Achse 

- Knicklänge Lcr 

 m20320301Lcr ,,, =×=⇒   

- 5680
993

1

06

3201

i

L

1

cr ,
,,

=×=
λ

×=λ  

- ( )[ ] ( )[ ] 7510568020568049015020150 22 ,,,,,,,, =+−+=λ+−λα+=Φ  

- 8040
568075107510

11

22
z ,

²,²,,
=

−+
=

λ−Φ+Φ
=χ  

 

- Normalkraftbeanspruchbarkeit, abgemindert 

  kN11319
11

523876
8040N Rdb ,

,
,,

,, =
×

×=  

- Nachweis gegen Biegeknicken 

1480
11319

4634

N

N

Rdb

Ed ≤== ,
,

,

,

���� 

 

 

 

 



Nachweis der Tragfähigkeit für die ständige Bemessungssituation 

 

  A - 24   

� Biegeknicken senkrecht zur y-Achse 

- Knicklänge Lcr 

 011 ,=η  (gelenkig gelagert) 

 3770
9535184425242

25242

KKKK

KK

22212c

2c
2 ,

,,,
,

=
++×

×
=

+++

+
=η  

 
( )
( )

50

2121

2121
y

60801

120201
k

,

,,

,,









ηη+η+η−

ηη−η+η−
=  

 
( )
( )

50

37700160377001801

377001120377001201
,

,,,,,,
,,,,,,










××++−

××−+−
=  2524

320

7760
K i ,==  

 342,=  1844
620

18260
51K 21 ,, =×=  

 m497203342Lcr ,,, =×=⇒  9535
436

10450
51K 22 ,, =×=  

 

- 7900
993

1

110

7491

i

L

1

cr ,
,,

=×=
λ

×=λ  KSL b → 340,=α  

- ( )[ ] ( )[ ] 9120790020790034015020150 22 ,,,,,,,, =+−+=λ+−λα+=Φ  

- 7310
790091209120

11

22
y ,

²,²,,
=

−+
=

λ−Φ+Φ
=χ  

- Normalkraftbeanspruchbarkeit, abgemindert 

 kN41199
11

523876
7310N Rdb ,

,
,,

,, =
×

×=   

- Nachweis gegen Biegeknicken 

 1530
41199

4634

N

N

Rdb

Ed ≤== ,
,

,

,

���� 

 

� Biegedrillknicken 

- Ideales Biegedrillknickmoment 

 
50

z

T

z

wz
1cr

EI

GIL

I

I

L

EI
cM

,

²

²

²

²









π
+

π
=  

 

50

27701021

6418077320

2770

328500

320

27701021
8791

,

³²
,²

²
³²

, 








×××π

××
+×

×××π
×=  

 kNm61407,=  

- 403520
140760

523744

M

fw
oT

cr

yy

LT ,,
,

, =λ≤=
×

=
×

=λ ���� Nachweis entfällt 

 



Nachweis der Tragfähigkeit für die ständige Bemessungssituation 

 

  A - 25   

� Querkraftbeanspruchung 

- Wirksame Schubfläche 

 ( ) ( ) ²,,,,,, cm14252112275021242876tr2tbt2AA fwfv =××++××−=++−=  

- Querkraftbeanspruchbarkeit  

 
( ) ( )

kN1310
11

35231425

11

3fA
V

yV

Rdpl ,
,

/,,
,

/
, ===  

- Nachweis 

 1060
1310

718

V

V

Rdpl

Ed ≤== ,
,

,

,

���� 

 

� Biegebeanspruchung 

- Interaktion von M,N 

 RdplEd N250N ,, ×≥  

 2410
11

523876
2504634 ,

,
,,

,, =
×

×≥ ���� zu berücksichtigen 

- Interaktion von M,V 

 RdplEd V50V ,, ×≥  

 1155131050718 ,,,, =×≥ �  nicht zu berücksichtigen 

- Biegebeanspruchbarkeit, abgemindert 

 kNm9158
11

10523744

11

fw
M

2
ypl

Rdpl ,
,
,

,, =
××

=
×

=
−

 

 390
71640

4634

N

N
n

Rdpl

Ed ,
,

,

,

===  

 
( )

250
876

21242876
a ,

,
,,

=
××−

=  

 kNm8110
250501

3901
9158

a501

n1
MM RdplRdplN ,

,,
,

,
,,,, =

×−

−
=

−

−
=  

- Nachweis 

 1540
8110

959

M

M

RdplN

Ed ≤== ,
,

,

,,

���� 

 

� Biegung und Druckkraft senkrecht zur y-Achse 

- Äquivalenter Momentenbeiwert für Knicken 

 90cmy ,=  

 

 



Nachweis der Tragfähigkeit für die ständige Bemessungssituation 

 

  A - 26   

- Interaktionsbeiwert  

 ( )














χ
+≤















χ
−λ+=

Rdy

Ed
my

Rdy

Ed
ymyyy

N

N
801c

N

N
201ck ,,  

 ( ) 







+≤








−+=

41199

4634
80190

41199

4634
207900190

,
,

,,
,
,

,,,  

 281181 ,, ≤= ���� 

- Nachweis Biegung und Druck 

 1
M

MM
k

N

N

RdyLT

EdyEdy

yy

Rdy

Ed ≤
χ

∆+
+

χ ,

,,  

 1
915801

0959
181

41199

4634
≤

×

+
+

,,
,

,
,
,

 

 1970 ≤, ���� 

 

� Biegung und Druckkraft senkrecht zur z-Achse 

- Äquivalenter Momentenbeiwert für Knicken 

 90cmz ,=  

- Interaktionsbeiwert  

 71018160k60k yyzy ,,,, =×=×=  

- Nachweis Biegung und Druck 

 1
M

MM
k

N

N

RdyLT

EdyEdy

zy

Rdz

Ed ≤
χ

∆+
+

χ ,

,,  

 1
915801

0959
710

11319

4634
≤

×

+
+

,,
,

,
,

,
 

 1750 ≤, ���� 



Nachweis der Tragfähigkeit für die ständige Bemessungssituation 

 

  A - 27   

Position 4: Stütze HEA 240 

 

� Schnittgrößen (LFK 4 maßgebend): 

- kNm359MEd ,max =  

- kN7240NEd ,max =  

- kN736VEd ,max =  

 

� Querschnittklassifizierung 

- Steg 

 33
f

235
33338721

57

164

t

c

y

=×=ε≤== ,
,

���� 

- Flansch 

 99257
12

87

t

c
=ε≤== , ���� 

⇒ Querschnittklasse 1 

 

� Biegeknicken senkrecht zur z-Achse 

- Knicklänge Lcr 

 m20320301Lcr ,,, =×=⇒   

- 5680
993

1

06

3201

i

L

1

cr ,
,,

=×=
λ

×=λ  KSL c → 490,=α  

- ( )[ ] ( )[ ] 7510568020568049015020150 22 ,,,,,,,, =+−+=λ+−λα+=Φ  

- 8040
568075107510

11

22
z ,

²,²,,
=

−+
=

λ−Φ+Φ
=χ  

 

- Normalkraftbeanspruchbarkeit, abgemindert 

  kN11319
11

523876
8040N Rdb ,

,
,,

,, =
×

×=  

- Nachweis gegen Biegeknicken 

1180
11319

7240

N

N

Rdb

Ed ≤== ,
,

,

,

���� 

 

 

 

 



Nachweis der Tragfähigkeit für die ständige Bemessungssituation 

 

  A - 28   

 

� Biegeknicken senkrecht zur y-Achse 

- Knicklänge Lcr 

 3930
611877182524

2524

KKKK

KK

12111c

1c
1 ,

,,,
,

=
++

=
+++

+
=η  

 3770
9535184425242

25242

KKKK

KK

22212c

2c
2 ,

,,,
,

=
++×

×
=

+++

+
=η  

 
( )
( )

50

2121

2121
y

60801

120201
k

,

,,

,,









ηη+η+η−

ηη−η+η−
=  2524

320

7760
K i ,==  

 
( )
( )

50

377039306037703930801

3770393012037703930201
,

,,,,,,
,,,,,,










××++−

××−+−
=  7718

620

7760
51K11 ,, =×=  

 331,=  6118
436

5410
51K12 ,, =×=  

 m264203331Lcr ,,, =×=⇒  1844
620

18260
51K 21 ,, =×=  

 9535
436

10450
51K 22 ,, =×=  

- 4490
993

1

110

4261

i

L

1

cr ,
,,

=×=
λ

×=λ  KSL b → 340,=α  

- ( )[ ] ( )[ ] 6430449020449034015020150 22 ,,,,,,,, =+−+=λ+−λα+=Φ  

- 9060
449064306430

11

22
y ,

²,²,,
=

−+
=

λ−Φ+Φ
=χ  

- Normalkraftbeanspruchbarkeit, abgemindert 

 kN51486
11

523876
9060N Rdb ,

,
,,

,, =
×

×=   

- Nachweis gegen Biegeknicken 

 1160
51486

7240

N

N

Rdb

Ed ≤== ,
,

,

,

���� 

 

� Biegedrillknicken 

- Beiwert C1 

( ) ( ) 7027539805209804188152041881c
2

1 ,,,,,,,²,,, ≤=−×+−×−=ψ+ψ−=  

- Ideales Biegedrillknickmoment 

 
50

z

T

z

wz
1cr

EI

GIL

I

I

L

EI
cM

,

²

²

²

²









π
+

π
=  



Nachweis der Tragfähigkeit für die ständige Bemessungssituation 

 

  A - 29   

 

50

27701021

6418077320

2770

328500

320

27701021
702

,

³²
,²

²
³²

, 








×××π

××
+×

×××π
×=  

 kNm62022,=  

- 402800
202260

523675

M

fw
oT

cr

yy

LT ,,
,

, =λ≤=
×

=
×

=λ ���� Nachweis entfällt 

 

� Querkraftbeanspruchung 

- Wirksame Schubfläche 

 ( ) ( ) ²,,,,,, cm14252112275021242876tr2tbt2AA fwfv =××++××−=++−=  

- Querkraftbeanspruchbarkeit  

 
( ) ( )

kN1310
11

35231425

11

3fA
V

yV

Rdpl ,
,

/,,
,

/
, ===  

- Nachweis 

 1120
1310

736

V

V

Rdpl

Ed ≤== ,
,

,

,

���� 

 

� Biegebeanspruchung 

- Interaktion von M,N 

 RdplEd N250N ,, ×≥  

 2410
11

523876
2507240 ,

,
,,

,, =
×

×≥ �  nicht zu berücksichtigen 

- Interaktion von M,V 

 RdplEd V50V ,, ×≥  

 1155131050736 ,,,, =×≥ �  nicht zu berücksichtigen 

- Biegebeanspruchbarkeit 

 kNm9158
11

10523744

11

fw
M

2
ypl

Rdpl ,
,
,

,, =
××

=
×

=
−

 

- Nachweis 

 1370
9158

359

M

M

RdplN

Ed ≤== ,
,

,

,,

���� 

 

� Biegung und Druckkraft senkrecht zur y-Achse 

- Äquivalenter Momentenbeiwert für Knicken 

 90cmy ,=  
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- Interaktionsbeiwert  

 ( )














χ
+≤















χ
−λ+=

Rdy

Ed
my

Rdy

Ed
ymyyy

N

N
801c

N

N
201ck ,,  

 ( ) 







+≤








−+=

51486

7240
80190

51486

7240
204490190

,
,

,,
,
,

,,,  

 021940 ,, ≤= ���� 

- Nachweis Biegung und Druck 

 1
M

MM
k

N

N

RdyLT

EdyEdy

yy

Rdy

Ed ≤
χ

∆+
+

χ ,

,,  

 1
915801

0359
940

51486

7240
≤

×

+
+

,,
,

,
,
,

 

 1510 ≤, ���� 

 

� Biegung und Druckkraft senkrecht zur z-Achse 

- Äquivalenter Momentenbeiwert für Knicken 

 90cmz ,=  

- Interaktionsbeiwert  

 56094060k60k yyzy ,,,, =×=×=  

- Nachweis Biegung und Druck 

 1
M

MM
k

N

N

RdyLT

EdyEdy

zy

Rdz

Ed ≤
χ

∆+
+

χ ,

,,  

 1
915801

0359
560

51486

7240
≤

×

+
+

,,
,

,
,
,

 

 1370 ≤, ���� 
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Position 5: Stütze HEA 200 

 

� Kein Biegedrillknicken möglich, da durch Wandscheiben seitlich gehalten 

� Kein Biegeknicken senkrecht zur z-Achse 

 

� Schnittgrößen (LFK 4 maßgebend): 

- kNm531MEd ,max =  

- kN8293NEd ,max =  

- kN57VEd ,max =  

 

� Querschnittklassifizierung 

- Steg 

 33
f

235
33336220

56

134

t

c

y

=×=ε≤== ,
,

���� 

- Flansch 

 99207
10

72

t

c
=ε≤== , ���� 

⇒ Querschnittklasse 1 

 

� Biegeknicken senkrecht zur y-Achse 

- Knicklänge Lcr 

 011 ,=η  (gelenkig gelagert) 

 3910
953553112

53112

KKKK

KK

22212c

2c
2 ,

,,
,

=
+×

×
=

+++

+
=η  

 
( )
( )

50

2121

2121
y

60801

120201
k

,

,,

,,









ηη+η+η−

ηη−η+η−
=  

 
( )
( )

50

39100160391001801

391001120391001201
,

,,,,,,
,,,,,,










××++−

××−+−
=  5311

320

3690
K i ,==  

 352,=  9535
436

10450
51K 21 ,, =×=  

 m527203352Lcr ,,, =×=⇒   

 

- 9670
993

1

288

7521

i

L

1

cr ,
,,

=×=
λ

×=λ  KSL b → 340,=α    

- ( )[ ] ( )[ ] 0981967020967034015020150 22 ,,,,,,,, =+−+=λ+−λα+=Φ  
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- 6180
967009819801

11

22
y ,

²,²,,,
=

−+
=

λ−Φ+Φ
=χ  

 

- Normalkraftbeanspruchbarkeit, abgemindert 

  kN3710
11

523853
6180N Rdb ,

,
,,

,, =
×

×=  

- Nachweis gegen Biegeknicken 

1410
3710

8293

N

N

Rdb

Ed ≤== ,
,

,

,

���� 

 

� Querkraftbeanspruchung 

- Wirksame Schubfläche 

 ( ) ( ) ²,,,,,, cm05180181265001202853tr2tbt2AA fwfv =××++××−=++−=  

- Querkraftbeanspruchbarkeit  

 
( ) ( )

kN6222
11

35230518

11

3fA
V

yV

Rdpl ,
,

/,,
,

/
, ===  

- Nachweis 

 1030
6222

57

V

V

Rdpl

Ed ≤== ,
,

,

,

���� 

 

� Biegebeanspruchung 

- Interaktion von M,N 

 RdplEd N250N ,, ×≥  

 3287
11

523853
2508293 ,

,
,,

,, =
×

×≥ ���� zu berücksichtigen 

- Interaktion von M,V 

 RdplEd V50V ,, ×≥  

 311162225057 ,,,, =×≥ �  nicht zu berücksichtigen 

- Biegebeanspruchbarkeit 

 kNm991
11

10523430

11

fw
M

2
ypl

Rdpl ,
,
,

,, =
××

=
×

=
−

 

 260
41149

8293

N

N
n

Rdpl

Ed ,
,

,

,

===  

 
( )

260
853

01202853
a ,

,
,,

=
××−

=  
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 kNm278
260501

2601
991

a501

n1
MM RdplRdplN ,

,,
,

,
,,,, =

×−

−
×=

−

−
=  

- Nachweis 

 1400
278

531

M

M

RdplN

Ed ≤== ,
,

,

,,

���� 

 

� Biegung und Druckkraft 

- Äquivalenter Momentenbeiwert für Knicken 

 90cmy ,=  

- Interaktionsbeiwert  

 ( )














χ
+≤















χ
−λ+=

Rdy

Ed
my

Rdy

Ed
ymyyy

N

N
801c

N

N
201ck ,,  

 ( ) 







+≤








−+=

3710

8293
80190

3710

8293
209670190

,
,

,,
,
,

,,,  

 201191 ,, ≤= ���� 

- Nachweis Biegung und Druck 

 1
M

MM
k

N

N

RdyLT

EdyEdy

yy

Rdy

Ed ≤
χ

∆+
+

χ ,

,,  

 1
99101

0531
191

3710

8293
≤

×

+
+

,,
,

,
,
,

 

 1820 ≤, ���� 
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Position 6: Stütze HEA 200 

 

� Kein Biegedrillknicken möglich, da durch Wandscheiben seitlich gehalten 

� Kein Biegeknicken senkrecht zur z-Achse 

 

� Schnittgrößen (LFK 4 maßgebend): 

- kNm443MEd ,max =  

- kN887NEd ,max =  

- kN130VEd ,max =  

 

� Querschnittklassifizierung 

- Steg 

 33
f

235
33336220

56

134

t

c

y

=×=ε≤== ,
,

���� 

- Flansch 

 99207
10

72

t

c
=ε≤== , ���� 

⇒ Querschnittklasse 1 

 

� Biegeknicken senkrecht zur y-Achse 

- Knicklänge Lcr 

 3830
61185311

5311

KKKK

KK

12111c

1c
1 ,

,,
,

=
+

=
+++

+
=η  

 3910
953553112

53112

KKKK

KK

22212c

2c
2 ,

,,
,

=
+×

×
=

+++

+
=η  

 
( )
( )

50

2121

2121
y

60801

120201
k

,

,,

,,









ηη+η+η−

ηη−η+η−
=  

 
( )
( )

50

391038306039103830801

3910383012039103830201
,

,,,,,,
,,,,,,










××++−

××−+−
=  5311

320

3690
K i ,==  

 331,=  6118
436

5410
51K11 ,, =×=  

 m264203331Lcr ,,, =×=⇒  9535
436

10450
51K 21 ,, =×=  
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- 5480
993

1

288

4261

i

L

1

cr ,
,,

=×=
λ

×=λ  KSL b → 340,=α  

- ( )[ ] ( )[ ] 7090548020548034015020150 22 ,,,,,,,, =+−+=λ+−λα+=Φ  

- 8620
548070907090

11

22
y ,

²,²,,
=

−+
=

λ−Φ+Φ
=χ  

- Normalkraftbeanspruchbarkeit, abgemindert 

 kN8990
11

523853
8620N Rdb ,

,
,,

,, =
×

×=   

- Nachweis gegen Biegeknicken 

 1090
7990

887

N

N

Rdb

Ed ≤== ,
,

,

,

���� 

 

� Querkraftbeanspruchung 

- Wirksame Schubfläche 

 ( ) ( ) ²,,,,,, cm05180181265001202853tr2tbt2AA fwfv =××++××−=++−=  

- Querkraftbeanspruchbarkeit 

 
( ) ( )

kN6222
11

35230518

11

3fA
V

yV

Rdpl ,
,

/,,
,

/
, ===  

- Nachweis 

 1140
6222

130

V

V

Rdpl

Ed ≤== ,
,

,

,

���� 

 

� Biegebeanspruchung 

- Interaktion von M,N 

 RdplEd N250N ,, ×≥  

 3287
11

523853
250887 ,

,
,,

,, =
×

×≥ �  nicht zu berücksichtigen 

- Interaktion von M,V 

 RdplEd V50V ,, ×≥  

 3111622250130 ,,,, =×≥ �  nicht zu berücksichtigen 

- Biegebeanspruchbarkeit 

 kNm991
11

10523430

11

fw
M

2
ypl

Rdpl ,
,
,

,, =
××

=
×

=
−

 

- Nachweis 

 1470
991

443

M

M

RdplN

Ed ≤== ,
,

,

,,

���� 
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� Biegung und Druckkraft 

- Äquivalenter Momentenbeiwert für Knicken 

 90cmy ,=  

- Interaktionsbeiwert  

 ( )














χ
+≤















χ
−λ+=

Rdy

Ed
my

Rdy

Ed
ymyyy

N

N
801c

N

N
201ck ,,  

 ( ) 







+≤








−+=

8990

887
80190

8990

887
205480190

,
,

,,
,
,

,,,  

 960930 ,, ≤= ���� 

- Nachweis Biegung und Druck 

 1
M

MM
k

N

N

RdyLT

EdyEdy

yy

Rdy

Ed ≤
χ

∆+
+

χ ,

,,  

 1
99101

0443
930

6990

887
≤

×

+
+

,,
,

,
,
,

 

 1530 ≤, ���� 
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Position 7: Riegel HEA 300 

 

� Träger durch aufliegende Decke in Verbundbauweise am Druckgurt ausreichend 

gegen Kippen gehalten 

 

� Schnittgrößen (LFK 1 maßgebend): 

- kNm5258MEd ,max =  

- kN144NEd ,max =  

- kN9250VEd ,max =  

 

� Querschnittklassifizierung 

- Steg 

 33
f

235
33334724

58

208

t

c

y

=×=ε≤== ,
,

���� 

- Flansch 

 99797
14

109

t

c
=ε≤== , ���� 

⇒ Querschnittklasse 1 

 

� Zugbeanspruchung 

- Normalkraftbeanspruchbarkeit 

  kN72392
11

523112
N Rdc ,

,
,

, =
×

=  

- Nachweis  

1020
72392

144

N

N

Rdc

Ed ≤== ,
,

,

,

���� 

 

� Querkraftbeanspruchung 

- Wirksame Schubfläche 

 ( ) ( ) ²,,,,, cm75364172285041302112tr2tbt2AA fwfv =××++××−=++−=  

- Querkraftbeanspruchbarkeit  

 
( ) ( )

kN3453
11

35237536

11

3fA
V

yV

Rdpl ,
,

/,,
,

/
, ===  
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- Nachweis 

 1560
3453

9250

V

V

Rdpl

Ed ≤== ,
,

,

,

���� 

 

� Biegebeanspruchung 

- Interaktion von M,N 

 RdplEd N250N ,, ×≥  

 1598
11

523112
250144 ,

,
,

,, =
×

×≥ �  nicht zu berücksichtigen 

- Interaktion von M,V 

 RdplEd V50V ,, ×≥  

 72263453509250 ,,,, =×≥ ���� zu berücksichtigen 

- Biegebeanspruchbarkeit, abgemindert 

 0101
3453

92502
1

V

V2
22

Rdpl

Ed ,
,

,

,

=







−

×
=














−=ρ  

 
( ) ( )

kNm7292
11

1052301011384

11

f1w
M

2
ypl

RdV ,
,

,,
,, =

××−×
=

ρ−
=

−

 

- Nachweis 

 1880
7292

5258

M

M

RdV

Ed ≤== ,
,

,

,

���� 
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Position 8: Riegel HEA 260 

 

� Träger durch aufliegende Decke in Verbundbauweise am Druckgurt ausreichend 

gegen Kippen gehalten 

 

� Schnittgrößen (LFK 1 maßgebend): 

- kNm6166MEd ,max =  

- kN618NEd ,max =  

- kN2188VEd ,max =  

 

� Querschnittklassifizierung 

- Steg 

 33
f

235
33336023

57

177

t

c

y

=×=ε≤== ,
,

���� 

- Flansch 

 99487
512

593

t

c
=ε≤== ,

,
,

���� 

⇒ Querschnittklasse 1 

 

� Zugbeanspruchung 

- Normalkraftbeanspruchbarkeit 

  kN41854
11

523886
N Rdc ,

,
,,

, =
×

=  

- Nachweis  

1010
41854

618

N

N

Rdc

Ed ≤== ,
,

,

,

���� 

 

� Querkraftbeanspruchung 

- Wirksame Schubfläche 

 

( ) ( ) ²,,,,,, cm7328251422750251262886tr2tbt2AA fwfv =××++××−=++−=  

- Querkraftbeanspruchbarkeit  

 
( ) ( )

kN4354
11

35237328

11

3fA
V

yV

Rdpl ,
,

/,,
,

/
, ===  
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- Nachweis 

 1530
4354

2188

V

V

Rdpl

Ed ≤== ,
,

,

,

���� 

 

� Biegebeanspruchung 

- Interaktion von M,N 

 RdplEd N250N ,, ×≥  

 5462
11

523686
250618 ,

,
,,

,, =
×

×≥ �  nicht zu berücksichtigen 

- Interaktion von M,V 

 RdplEd V50V ,, ×≥  

 21774354502188 ,,,, =×≥ ���� zu berücksichtigen 

- Biegebeanspruchbarkeit, abgemindert 

 00401
4354

21882
1

V

V2
22

Rdpl

Ed ,
,

,

,

=







−

×
=














−=ρ  

 
( ) ( )

kNm8195
11

1052300401920

11

f1w
M

2
ypl

RdV ,
,

,,
,, =

××−×
=

ρ−
=

−

 

- Nachweis 

 1850
8195

6166

M

M

RdV

Ed ≤== ,
,

,

,

���� 
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Position 9: Riegel HEA 240 

 

� Träger durch aufliegende Decke in Verbundbauweise am Druckgurt ausreichend 

gegen Kippen gehalten 

 

� Schnittgrößen (LFK 2 maßgebend): 

- kNm0154MEd ,max =  

- kN356NEd ,max =  

- kN6148VEd ,max =  

 

� Querschnittklassifizierung 

- Steg 

 33
f

235
33338721

57

164

t

c

y

=×=ε≤== ,
,

���� 

- Flansch 

 99257
12

87

t

c
=ε≤== , ���� 

⇒ Querschnittklasse 1 

 

� Druckbeanspruchung 

- Normalkraftbeanspruchbarkeit 

  kN71640
11

523876
N Rdc ,

,
,,

, =
×

=  

- Nachweis  

1030
71640

356

N

N

Rdc

Ed ≤== ,
,

,

,

���� 

 

� Querkraftbeanspruchung 

- Wirksame Schubfläche 

 ( ) ( ) ²,,,,,, cm14252112275021242876tr2tbt2AA fwfv =××++××−=++−=  

- Querkraftbeanspruchbarkeit  

 
( ) ( )

kN1310
11

35231425

11

3fA
V

yV

Rdpl ,
,

/,,
,

/
, ===  
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- Nachweis 

 1480
1310

6148

V

V

Rdpl

Ed ≤== ,
,

,

,

���� 

 

� Biegebeanspruchung 

- Interaktion von M,N 

 RdplEd N250N ,, ×≥  

 2410
11

523876
250356 ,

,
,,

,, =
×

×≥ �  nicht zu berücksichtigen 

- Interaktion von M,V 

 RdplEd V50V ,, ×≥  

 11551310506148 ,,,, =×≥ ���� zu berücksichtigen 

- Biegebeanspruchbarkeit, abgemindert 

 0201
1310

61482
1

V

V2
22

Rdpl

Ed ,
,

,

,

=







−

×
=














−=ρ  

 
( ) ( )

kNm8155
11

105230201744

11

f1w
M

2
ypl

RdV ,
,

,,
,, =

××−×
=

ρ−
=

−

 

- Nachweis 

 1990
8155

0154

M

M

RdV

Ed ≤== ,
,

,

,

���� 
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Position 10: Riegel HEA 220  

 

� Träger durch aufliegende Decke in Verbundbauweise am Druckgurt ausreichend 

gegen Kippen gehalten 

 

� Schnittgrößen (LFK 2 maßgebend): 

- kNm497MEd ,max =  

- kN223NEd ,max =  

- kN6148VEd ,max =  

 

� Querschnittklassifizierung 

- Steg 

 33
f

235
33337121

7

152

t

c

y

=×=ε≤== , ���� 

- Flansch 

 99367
11

81

t

c
=ε≤== , ���� 

⇒ Querschnittklasse 1 

 

� Druckbeanspruchung 

- Normalkraftbeanspruchbarkeit 

  kN71373
11

523364
N Rdc ,

,
,,

, =
×

=  

- Nachweis  

1020
71373

223

N

N

Rdc

Ed ≤== ,
,

,

,

���� 

 

� Querkraftbeanspruchung 

- Wirksame Schubfläche 

 ( ) ( ) ²,,,,,, cm6320118127011222364tr2tbt2AA fwfv =××++××−=++−=  

- Querkraftbeanspruchbarkeit  

 
( ) ( )

kN5254
11

35236320

11

3fA
V

yV

Rdpl ,
,

/,,
,

/
, ===  
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- Nachweis 

 1440
5254

7111

V

V

Rdpl

Ed ≤== ,
,

,

,

���� 

 

� Biegebeanspruchung 

- Interaktion von M,N 

 RdplEd N250N ,, ×≥  

 4343
11

523364
250223 ,

,
,,

,, =
×

×≥ �  nicht zu berücksichtigen 

- Interaktion von M,V 

 RdplEd V50V ,, ×≥  

 31275254507111 ,,,, =×≥ �  nicht zu berücksichtigen 

- Biegebeanspruchbarkeit 

 kNm3121
11

10523568

11

fw
M

2
ypl

Rdpl ,
,
,

,, =
××

=
×

=
−

 

- Nachweis 

 1800
3121

497

M

M

RdV

Ed ≤== ,
,

,

,

���� 
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6.1 Allgemeines 

Abhängig von den gewählten Abminderungsfaktoren für das vereinfachte 

Bemessungsverfahren nach DIN EN 1993-1-2 wird für die einzelnen Bauteile eine 

Temperatur ermittelt, bis wohin ein Bauteilversagen unter Berücksichtigung von 

Stabilitätsproblemen ausgeschlossen werden kann. 

Anschließend kann mittels einer thermischen Analyse die Temperatur für die einzelnen 

Querschnitte mit dem FEM-Programm SAFIR berechnet werden. So lässt sich feststellen, zu 

welchem Zeitpunkt die vorher ermittelte kritische Temperatur erreicht wird.  

Als Temperatureinwirkung wird die Einheitstemperaturkurve nach DIN EN 1991-1-2 

angesetzt. Die Beflammungsseiten der Profile sind abhängig von der örtlichen Anordnung 

der Profile und werden entsprechend berücksichtigt. 

 

Nachfolgend ist das System mit entsprechender Beflammung dargestellt. 
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6.2 Vereinfachtes Nachweisvefahren 

Position 1: Stütze HEA 240 

 

� Schnittgrößen: 

- kNm631M Edfi ,max , =  

- kN6271N Edfi ,max , =  

- kN99V Edfi ,max , =  

 

� Abminderungsfaktoren 

- gew. C600T °=θmax,  4700k y ,, =→ θ  3100k E ,, =θ  

 

� Querschnittklassifizierung 

- Abminderung des Wertes ǫ 

 850
235

235
850

f

235
850

y

,,, ===ε  

- Steg 

 0528338721
57

164

t

c
,,

,
=ε≤== ���� 

- Flansch 

 6579257
12

87

t

c
,, =ε≤== ����                         

⇒ Querschnittklasse 1 

 

� Biegeknicken senkrecht zur y-Achse 

- Knicklänge lfi  

 m78526870lfi ,,, =×=   

- 6090
993

1

110

5781

i

l

1

fi ,
,,

=×=
λ

×=λ   

- [ ] [ ] 7500310047006090kk
5050

Ey ,,/,,/ ,,
,, =×=λ=λ θθθ   

- 650235235650f235650 y ,/,/, ===α  

- [ ] [ ] 025175007500650150150
2 ,²,,,,, =+×+=λ+λα+=ϕ θθθ  

- 5800
750002510251

11

22
fi ,

²,²,,
=

−+
=

λ−ϕ+ϕ
=χ

θθθ
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- Normalkraftbeanspruchbarkeit, abgemindert 

  kN0492
01

5234700876
5800

fkA
N

fiM

yy

fiRdfib ,
,

,,,
,

,

,
,, =

××
×=

γ

××
χ=

θ
 

- Nachweis gegen Biegeknicken 

1550
0492

6271

N

N

Rdfib

Edfi
≤== ,

,
,

,,

,
���� 

 

� Querkraftbeanspruchung  

- Querkraftbeanspruchbarkeit  

 [ ] [ ] kN3160011113104700VkV fiM0MRdplwebyRdfi ,,/,,,/ ,,,,,, =××=γγ×= θ  

- Nachweis 

 1060
3160

99

V

V

Rdfi

Edfi
≤== ,

,
,

,

,
���� 

 

� Biegebeanspruchung 

- Biegebeanspruchbarkeit 

 [ ] [ ] kNm282011191584700MkM fiM0MRdyRdfi ,,/,,,/ ,,,,, =××=γγ×= θθ  

- Nachweis 

 1380
282

631

M

M

Rdfi

Edfi
≤==

θ

,
,
,

,,

,
���� 

 

� Biegung und Druckkraft 

- Beiwert 

 ( ) 290440321 yMyyMy ,,, ,,, −β+λ−β=µ θ  

 ( ) 29081440750038121 ,,,,,, −×+×−×=  

 801280 ,, ≤−= ���� 

- Interaktionsbeiwert  

 

fiM

y

yfiy

EDfiy

y f
kA

N
1k

,
,,

,

γ
×××χ

µ
−=

θ

 

 
52347008765800

62711280
1

,,,,
,,

×××

×
+=  

 03071 ,, ≤= ���� 
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- Nachweis Biegung und Druck 

 1
f

kw

Mk

f
kA

N

fiM

y

yypl

Edfiyy

fiM

y

yfi

Edfi
≤

γ
×

×
+

γ
×××χ θθ

,
,,

,,

,
,min,

,  

 1
5234700744

10631071

52347008765800

6271
≤

××

××
+

××× ,,
²,,

,,,,
,

 

 1960 ≤, ���� 

 

� Thermische Bauteilanalyse mit SAFIR/GID 

- Dreiseitige Beflammung 

- Bis zur Zeitstufe t=12 Min. kann ein Bauteilversagen ausgeschlossen werden, 

da C600T °≤θmax,  
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Position 3: Stütze HEA 240 

 

� Schnittgrößen: 

- kNm618M Edfi ,max , =  

- kN0433N Edfi ,max , =  

- kN85V Edfi ,max , =  

 

� Abminderungsfaktoren 

- gew. C590T °=θmax,  5010k y ,, =→ θ  3390k E ,, =θ  

 

� Querschnittklassifizierung 

- Abminderung des Wertes ǫ 

 850
235

235
850

f

235
850

y

,,, ===ε  

- Steg 

 0528338721
57

164

t

c
,,

,
=ε≤== ���� 

- Flansch 

 6579257
12

87

t

c
,, =ε≤== ����                         

⇒ Querschnittklasse 1 

 

� Biegeknicken senkrecht zur z-Achse 

- Knicklänge lfi  

 m24220370lfi ,,, =×=   

- 3980
993

1

06

2241

i

l

1

fi ,
,,

=×=
λ

×=λ   

- [ ] [ ] 4840339050103980kk
5050

Ey ,,/,,/ ,,
,, =×=λ=λ θθθ   

- 650235235650f235650 y ,/,/, ===α  

- [ ] [ ] 774048404840650150150
2 ,²,,,,, =+×+=λ+λα+=ϕ θθθ  

- 7260
484077407740

11

22
fi ,

²,²,,
=

−+
=

λ−ϕ+ϕ
=χ

θθθ
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- Normalkraftbeanspruchbarkeit, abgemindert 

  kN5656
01

5235010876
7260

fkA
N

fiM

yy

fiRdfib ,
,

,,,
,

,

,
,, =

××
×=

γ

××
χ=

θ
 

- Nachweis gegen Biegeknicken 

1660
5656

0433

N

N

Rdfib

Edfi
≤== ,

,
,

,,

,
���� 

 

� Biegeknicken senkrecht zur y-Achse 

- Knicklänge lfi  

 m24549770lfi ,,, =×=   

- 5530
993

1

110

5241

i

l

1

fi ,
,,

=×=
λ

×=λ   

- [ ] [ ] 6720339050105530kk
5050

Ey ,,/,,/ ,,
,, =×=λ=λ θθθ   

- 650235235650f235650 y ,/,/, ===α  

- [ ] [ ] 944067206720650150150
2 ,²,,,,, =+×+=λ+λα+=ϕ θθθ  

- 6220
672094409440

11

22
fi ,

²,²,,
=

−+
=

λ−ϕ+ϕ
=χ

θθθ

 

 

- Normalkraftbeanspruchbarkeit, abgemindert 

  kN4562
01

5235010876
6220

fkA
N

fiM

yy

fiRdfib ,
,

,,,
,

,

,
,, =

××
×=

γ

××
χ=

θ
 

- Nachweis gegen Biegeknicken 

1770
4562

0433

N

N

Rdfib

Edfi
≤== ,

,
,

,,

,
���� 

 

� Querkraftbeanspruchung  

- Querkraftbeanspruchbarkeit  

 [ ] [ ] kN9170011113105010VkV fiM0MRdplwebyRdfi ,,/,,,/ ,,,,,, =××=γγ×= θ  

- Nachweis 

 1030
9170

85

V

V

Rdfi

Edfi
≤== ,

,
,

,

,
���� 

 

� Biegedrillknicken 

- [ ] [ ] 4280339050103520kk
5050

comEcomyLTcomLT ,,/,,/ ,,
,,,,,, ==λ=λ θθθ  
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- ( )[ ]2

comLTcomLTcomLT 150 ,,,,,, , θθθ λ+λ×α+=φ  

 [ ] 731042804280650150 ,²,,,, =+×+=  

- 
[ ] [ ]2

comLT

2

comLTcomLT

fiLT

1

,,,,,,

,

θθθ λ−φ+φ

=χ  

 7560
428073107310

1
,

²,²,,
=

−+
=  

- Biegedrillknickbeanspruchbarkeit 

 
fiM

y

comyyplfiLTRdfib

f
kwM

,
,,,,,,

γ
×××χ= θ  

  kNm26652350107447560 ,,,, =×××=  

- Nachweis 

 1280
266

618

M

M

Rdfib

Edfi
≤== ,

,
,

,,

,  

 

� Biegung und Druckkraft senkrecht zur y-Achse 

- Beiwert 

 ( ) 290440321 yMyyMy ,,, ,,, −β+λ−β=µ θ  

 ( ) 29081440672038121 ,,,,,, −×+×−×=  

 800620 ,, ≤−= ���� 

- Interaktionsbeiwert  

 

fiM

y

yfiy

EDfiy

y f
kA

N
1k

,
,,

,

γ
×××χ

µ
−=

θ

 

 
52350108766220

04330620
1

,,,,
,,

×××

×
+=  

 030481 ,, ≤= ���� 

- Nachweis Biegung und Druck 

 1
f

kw

Mk

f
kA

N

fiM

y

yypl

Edfiyy

fiM

y

yfi

Edfi
≤

γ
×

×
+

γ
×××χ θθ

,
,,

,,

,
,min,

,  

 1
5235010744

106180481

52350108766220

0433
≤

××

××
+

××× ,,
²,,

,,,,
,

 

 1990 ≤, ���� 
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� Biegung und Druckkraft senkrecht zur z-Achse 

- Beiwert 

 150150 LTMzLT ,, ,, −β×λ=µ θ  

 150814840150 ,,,, −××=  

 900190 ,, ≤−= ���� 

- Interaktionsbeiwert  

 

fiM

y

yfiz

EDfiLT

LT f
kA

N
1k

,
,,

,

γ
×××χ

µ
−=

θ

 

 
52350108767260

04330190
1

,,,,
,,

×××

×
+=  

 030131 ,, ≤= ���� 

- Nachweis Biegung und Druck 

 1
f

kw

Mk

f
kA

N

fiM

y

yyplfiLT

EdfiyLT

fiM

y

yfiz

Edfi
≤

γ
××χ

×
+

γ
×××χ θθ

,
,,,

,,

,
,,

,  

 1
52350107447440

106180131

52350108767260

0433
≤

×××

××
+

××× ,,,
²,,

,,,,
,

 

 1950 ≤, ���� 

 

� Thermische Bauteilanalyse mit SAFIR/GID 

- Vierseitige Beflammung  

- Bis zur Zeitstufe t=11 Min. kann ein Bauteilversagen ausgeschlossen werden, 

da C590T °≤θmax,  
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Position 5: Stütze HEA 200 

 

� Schnittgrößen: 

- kNm013M Edfi ,max , =  

- kN8195N Edfi ,max , =  

- kN14V Edfi ,max , =  

 

� Abminderungsfaktoren 

- gew. C610T °=θmax,  4460k y ,, =→ θ  2920k E ,, =θ  

 

� Querschnittklassifizierung 

- Abminderung des Wertes ǫ 

 850
235

235
850

f

235
850

y

,,, ===ε  

- Steg 

 0528336220
56

134

t

c
,,

,
=ε≤== ���� 

- Flansch 

 6579207
10

72

t

c
,, =ε≤== ����                         

⇒ Querschnittklasse 1 

 

� Biegeknicken senkrecht zur y-Achse 

- Knicklänge lfi  

 m26552770lfi ,,, =×=   

- 6770
993

1

288

5261

i

l

1

fi ,
,,

=×=
λ

×=λ   

- [ ] [ ] 8370292044606770kk
5050

Ey ,,/,,/ ,,
,, =×=λ=λ θθθ   

- 650235235650f235650 y ,/,/, ===α  

- [ ] [ ] 122183708370650150150
2 ,²,,,,, =+×+=λ+λα+=ϕ θθθ  

- 5350
837012211221

11

22
fi ,

²,²,,
=

−+
=

λ−ϕ+ϕ
=χ

θθθ
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- Normalkraftbeanspruchbarkeit, abgemindert 

  kN7301
01

5234460853
5350

fkA
N

fiM

yy

fiRdfib ,
,

,,,
,

,

,
,, =

××
×=

γ

××
χ=

θ
 

- Nachweis gegen Biegeknicken 

1650
7301

8195

N

N

Rdfib

Edfi ≤== ,
,
,

,,

,
���� 

 

� Querkraftbeanspruchung  

- Querkraftbeanspruchbarkeit  

 [ ] [ ] kN2109011162224460VkV fiM0MRdplwebyRdfi ,,/,,,/ ,,,,,, =××=γγ×= θ  

- Nachweis 

 1040
2109

14

V

V

Rdfi

Edfi ≤== ,
,

,

,

,
���� 

 

� Biegebeanspruchung 

- Biegebeanspruchbarkeit 

 [ ] [ ] kNm14501119914460MkM fiM0MRdyRdfi ,,/,,,/ ,,,,, =××=γγ×= θθ  

- Nachweis 

 1270
145

012

M

M

Rdfi

Edfi ≤==
θ

,
,
,

,,

,
���� 

 

� Biegung und Druckkraft 

- Beiwert 

 ( ) 290440321 yMyyMy ,,, ,,, −β+λ−β=µ θ  

 ( ) 29081440837038121 ,,,,,, −×+×−×=  

 802010 ,, ≤−= ���� 

- Interaktionsbeiwert  

 

fiM

y

yfiy

EDfiy

y f
kA

N
1k

,
,,

,

γ
×××χ

µ
−=

θ

 

 
52344608535350

81952010
1

,,,,
,,

×××

×
+=  

 03131 ,, ≤= ���� 

 

 



Nachweis der Tragfähigkeit für den Brandfall 

 

  A - 56   

 

- Nachweis Biegung und Druck 

 1
f

kw

Mk

f
kA

N

fiM

y

yypl

Edfiyy

fiM

y

yfi

Edfi
≤

γ
×

×
+

γ
×××χ θθ

,
,,

,,

,
,min,

,  

 1
5234460430

10012131

52344608535350

8195
≤

××

××
+

××× ,,
²,,

,,,,
,

 

 1950 ≤, ���� 

 

� Thermische Bauteilanalyse mit SAFIR/GID 

- Dreiseitige Beflammung 

- Bis zur Zeitstufe t=12 Min. kann ein Bauteilversagen ausgeschlossen werden, 

da C610T °≤θmax,  
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Position 7: Riegel HEA 300  

 

� Schnittgrößen: 

- kNm0156M Edfi ,max , =  

- kN631N Edfi ,max , =  

- kN1151V Edfi ,max , =  

 

� Abminderungsfaktoren 

- gew. C650T °=θmax,  3500k y ,, =→ θ   

 

� Querschnittklassifizierung 

- Abminderung des Wertes ǫ 

 850
235

235
850

f

235
850

y

,,, ===ε  

- Steg  

 0528334724
58

208

t

c
,,

,
=ε≤== ���� (QKL 1) 

- Flansch 

 50810797
14

109

t

c
,, =ε≤== ���� (QKL 2)                         

⇒ Querschnittklasse 2 

 

� Zugbeanspruchung 

- Normalkraftbeanspruchbarkeit 

  [ ] 5837
11

523112
3500NkN fiM0MdRyRdfi ,

,
,

,/ ,,,,,, =
×

×=γγ×= θθ  

- Nachweis  

1040
5837

631

N

N

Rdfi

Edfi ≤==
θ

,
,

,

,,

,
���� 

 

� Querkraftbeanspruchung  

- Querkraftbeanspruchbarkeit  

 [ ] [ ] kN5174011134533500VkV fiM0MRdplwebyRdfi ,,/,,,/ ,,,,,, =××=γγ×= θ  
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- Nachweis 

 1870
5174

0151

V

V

Rdfi

Edfi ≤== ,
,
,

,

,
���� 

 

� Biegebeanspruchung 

- Biegebeanspruchbarkeit 

 
[ ]

kNm0161
0170

1172923500Mk
M

21

fiM0MRdVy

Rdfi ,
,,

,,,/ ,,,,
,, =

×

××
=

κ×κ

γγ×
=

θ

θ  

- Nachweis 

 1970
0161

0156

M

M

Rdfi

Edfi ≤==
θ

,
,
,

,,

,
���� 

 

� Thermische Bauteilanalyse mit SAFIR/GID 

- Berücksichtigung des Effektes der Wärmeableitung durch aufliegende Decke  

- Dreiseitige Beflammung 

- Bis zur Zeitstufe t=14 Min. kann ein Bauteilversagen ausgeschlossen werden, 

da C650T °≤θmax,  
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Position 8: Riegel HEA 260  

 

� Schnittgrößen: 

- kNm798M Edfi ,max , =  

- kN213N Edfi ,max , =  

- kN7112V Edfi ,max , =  

 

� Abminderungsfaktoren 

- gew. C650T °=θmax,  3500k y ,, =→ θ   

 

� Querschnittklassifizierung 

- Abminderung des Wertes ǫ 

 850
235

235
850

f

235
850

y

,,, ===ε  

- Steg  

 0528336023
57

177

t

c
,,

,
=ε≤== ����  

- Flansch 

 6579487
512

593

t

c
,,

,
,

=ε≤== ����   

⇒ Querschnittklasse 1 

 

� Zugbeanspruchung 

- Normalkraftbeanspruchbarkeit 

  [ ] 0649
11

523886
3500NkN fiM0MdRyRdfi ,

,
,,

,/ ,,,,,, =
×

×=γγ×= θθ  

- Nachweis  

1020
0649

213

N

N

Rdfi

Edfi ≤==
θ

,
,

,

,,

,
���� 

 

� Querkraftbeanspruchung  

- Querkraftbeanspruchbarkeit  

 [ ] [ ] kN4136011143543500VkV fiM0MRdplwebyRdfi ,,/,,,/ ,,,,,, =××=γγ×= θ  
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- Nachweis 

 1830
4136

7112

V

V

Rdfi

Edfi ≤== ,
,
,

,

,
���� 

 

� Biegebeanspruchung 

- Biegebeanspruchbarkeit 

 
[ ]

kNm6107
0170

1181953500Mk
M

21

fiM0MRdVy

Rdfi ,
,,

,,,/ ,,,,
,, =

×

××
=

κ×κ

γγ×
=

θ

θ  

- Nachweis 

 1920
6107

798

M

M

Rdfi

Edfi ≤==
θ

,
,
,

,,

,
���� 

 

� Thermische Bauteilanalyse mit SAFIR/GID 

- Berücksichtigung des Effektes der Wärmeableitung durch aufliegende Decke  

- Dreiseitige Beflammung 

- Bis zur Zeitstufe t=13 Min. kann ein Bauteilversagen ausgeschlossen werden, 

da C650T °≤θmax,  
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6.3 Allgemeines Nachweisverfahren 

Das allgemeine Nachweisverfahren wird mit dem FEM - Programm SAFIR geführt. Hierzu ist 

für die einzelnen Stahlprofile eine thermische Analyse unter Berücksichtigung der je nach 

Einbausituation auftretenden Brandbeanspruchung (ETK) mit SAFIR notwendig. 

Anschließend wird mit Hilfe des Programmes GID das in Kapitel 6.1 abgebildete Tragwerk 

modelliert, die zuvor erzeugten Daten aus der thermischen Analyse entsprechend 

implementiert, die Lasten aufgebracht und ein FEM - Netz generiert.  

 

Die Berechnungsergebnisse mit Auswertung sind im Haupteil dieser Arbeit aufgeführt (vgl. 

Kapitel 6.2.2). 
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7 Nachweis der Feuerwiderstandsdauer R 30 

Nach der durchgeführten ‚heißen Bemessung’ und der thermischen Bauteilanalyse kann die 

Stütze der Position 3 als maßgebender Versagensfall definiert werden. 

Nachfolgend soll mittels der Methode des ‚Overmarching’ eine Feuerwiderstandsdauer von  

R 30, also 30 Minuten, nachgewiesen werden. 

Der Nachweis wird für ein Profil der Baureihe HEB 700 geführt, die Stahlgüte wird von S 235 

auf S 355 erhöht. 

 

Position 3: Stütze HEB 360 

 

� Schnittgrößen: 

- kNm618M Edfi ,max , =  

- kN0433N Edfi ,max , =  

- kN85V Edfi ,max , =  

 

� Abminderungsfaktoren 

- gew. C800T °=θmax,  1100k y ,, =→ θ  0900k E ,, =θ  

 

� Querschnittklassifizierung  

⇒ Querschnittklasse 1 oder 2 vorrausgesetzt 

 

� Biegeknicken senkrecht zur z-Achse 

- Knicklänge lfi  

 m24220370lfi ,,, =×=   

- 3930
176

1

497

2241

i

l

1

fi ,
,,

=×=
λ

×=λ   

- [ ] [ ] 4340090011003930kk
5050

Ey ,,/,,/ ,,
,, =×=λ=λ θθθ   

- 5290355235650f235650 y ,/,/, ===α  

- [ ] [ ] 7090434043405290150150
2 ,²,,,,, =+×+=λ+λα+=ϕ θθθ  

- 7880
434070907090

11

22
fi ,

²,²,,
=

−+
=

λ−ϕ+ϕ
=χ

θθθ
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- Normalkraftbeanspruchbarkeit, abgemindert 

  kN9556
01

5351100181
7880

fkA
N

fiM

yy

fiRdfib ,
,

,,
,

,

,
,, =

××
×=

γ

××
χ=

θ
 

- Nachweis gegen Biegeknicken 

1780
9556

0433

N

N

Rdfib

Edfi ≤== ,
,
,

,,

,
���� 

 

� Biegeknicken senkrecht zur y-Achse 

- Knicklänge lfi  

 m24549770lfi ,,, =×=   

- 4440
176

1

515

5241

i

l

1

fi ,
,,

=×=
λ

×=λ   

- [ ] [ ] 4910090011004440kk
5050

Ey ,,/,,/ ,,
,, =×=λ=λ θθθ   

- 5290355235650f235650 y ,/,/, ===α  

- [ ] [ ] 7500491049105290150150
2 ,²,,,,, =+×+=λ+λα+=ϕ θθθ  

- 7590
491075007500

11

22
fi ,

²,²,,
=

−+
=

λ−ϕ+ϕ
=χ

θθθ

 

- Normalkraftbeanspruchbarkeit, abgemindert 

  kN5536
01

5351100181
7590

fkA
N

fiM

yy

fiRdfib ,
,

,,
,

,

,
,, =

××
×=

γ

××
χ=

θ
 

- Nachweis gegen Biegeknicken 

1810
5536

0433

N

N

Rdfib

Edfi ≤== ,
,
,

,,

,
���� 

 

� Querkraftbeanspruchung  

- Wirksame Schubfläche 

 ( ) ( ) ²,,,,, cm3579917221191302181tr2tbt2AA fwfv =××++××−=++−=  
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� Biegedrillknicken 
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� Biegung und Druckkraft senkrecht zur y-Achse 

- Beiwert 
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- Interaktionsbeiwert  
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� Biegung und Druckkraft senkrecht zur z-Achse 

- Beiwert 
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� Thermische Bauteilanalyse mit SAFIR/GID 

- Vierseitige Beflammung  

- Bis zur Zeitstufe t=31 Min. kann ein Bauteilversagen ausgeschlossen werden, 

da C800T °≤θmax,  
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1 Installation SAFIR 

 

1) Aufrufen der Internetadresse 

 http://www.argenco.ulg.ac.be/logiciels/SAFIR/index.html  

2) Download folgender Dateien unter dem link ‚free downloads’: 

 

� Preprocessors → Datei ‚Wizard_2004.msi’ 

� Postprocessor → Datei ‚Diamond.msi’ 

� Shell → Datei ‚tools.msi’ 

 

3) O.g. Dateien ausführen und Installationsroutine folgen 

4) Persönlichen Software-Dongle (Datei ‚identity.key’) für die SAFIR 

Demonstrationsversion bei Professor Franssen auf o.g. Homepage unter 

Menüpunkt ‚free demonstration version’ kostenfrei bestellen 

5) Einschränkungen der SAFIR Demonstrationsversion: 

 

� Max. Anzahl an Knoten (nodes): 500 

� Max. Anzahl an Elementen (beam elements): 12 

� Max. Anzahl an Elementtypen (beam types): 2 

� Max. Anzahl an Fachwerkelementen (truss elements): 10 

� Max. Anzahl an Fachwerkelementtypen (truss types): 1 

� Max. Anzahl an Hohlräumen (internal cavities): 1 

� Max. Anzahl an FEM-Elementen (solid elements): 500 

� Max. Anzahl an Mantelflächen-Elementen (shell elements): 0 

� Ausschließlich 2D Berechnung 

� Keine dynamische Berechnung  
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2 Installation GID 

 

1) Download GID 7.2 von http://gid.cimne.upc.es/  

2) Ausführen der Datei ‚GID 7.2-win.exe’ 

3) Kopieren des Ordners ‚SAFIR2004b’ unter C:\SAFIR\GID\Gid2Safir in das 

Installationsverzeichnis C:\Programme\GiD\GiD7.2\problemtypes 

4) Öffnen der *.bat Datei unter …\SAFIR2004b\Safir_Structural_2d.gid mit Hilfe des 

Texteditors 

5) Löschen der Zeile 11 und 13 

6) Installationspfad von SAFIR in Zeile 12 kontrollieren/anpassen 

 

 

 

 

 

 

7) Anpassen der Ausführungsdatei von SAFIR in Zeile 35 speichern 

 

 

 

 

 

8) Schritt 4 bis 8 ebenfalls für …\SAFIR2004b\Safir_Thermal_2d.gid durchführen 

9) Beim ersten Start des Programms die ‚Education’-Version auswählen (zeitlich 

unbegrenzte Nutzung mit Einschränkung der Knotenanzahl auf 700) 
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3 Einführung 

Die Brandbemessungssoftware SAFIR wurde an der Universität Lüttich unter Leitung von 

Professor Franssen entwickelt und wird weiter erforscht und verbessert. Unter Experten gilt 

die Software bereits jetzt als sehr gutes Werkzeug, um brandbeanspruchte Tragwerke 

hinsichtlich ihres Verhaltens unter erhöhter Temperatur zu untersuchen und so einen 

möglichen Versagensfall festzustellen. 

 

Die Tragwerksanalyse unterteilt sich allgemein in die thermische und mechanische Analyse. 

Hierbei werden für die einzelnen Bauteile von Tragwerken thermische Berechnungen 

durchgeführt, welche anschließend in die mechanische Analyse eingebracht werden und so 

das Gesamttragverhalten berechnet wird. 

Für die Modellierung der Bauteile und Systeme bieten sich folgende drei Möglichkeiten an: 

 

� ‚Wizard’-Editor 

� Texteditor 

� GID 

 

Das Programm ‚Wizard’ ist dafür geeignet einfache Stahlträger der verschiedenen 

Baureihen, ggf. mit aufliegender Betondecke, zu erstellen. Hierbei können die 

brandbeanspruchten Seiten sowie eine mögliche Brandschutzbekleidung mit variabler Stärke 

ausgewählt werden. Auch lässt sich die Anzahl der Finiten Elemente bestimmen und so die 

Genauigkeit und der Rechenaufwand beeinflussen. 

Komplexere Strukturen können mit dem CAD-gestützten Programm ‚GID’ erstellt werden, 

wobei die entsprechenden Querschnitte graphisch unterstützt und mit entsprechenden 

Randbedingungen (Brandbeanspruchung, Material, etc.) für SAFIR modelliert werden. 

Hierbei bietet sich an, komplexe Strukturen mit einem bekannten Programm (z.B. AutoCAD) 

vorzunehmen und anschließend als dxf-file in ‚GID’ einzulesen.  

Die im Format ‚file.in’ erstellten Eingangsdaten für SAFIR lassen sich auch über den 

Texteditor erstellen, was aber ein gewisses Maß an Erfahrung voraussetzt und einen 

höheren Zeitaufwand bedeutet. Zur Kontrolle der Daten oder für kleine Änderungen ist diese 

Methode aber in jedem Fall zu empfehlen.  

Nach der Berechnung der ‚file.in’ Dateien mit SAFIR erhält man je eine ‚file.out’ und ‚file.tem’ 

Datei. Die ‚file.out’ Datei lässt sich mit dem Programm ‚Diamond’ betrachten, hierbei wird der 

Querschnitt mit entsprechendem Temperaturverlauf graphisch dargestellt. Auch ist eine 

graphische Auswertung des Temperaturverlaufes über die Zeit an ausgewählten Knoten 
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möglich. Wurde die Struktur in ‚GID’ erstellt, ist auch hier eine graphische Darstellung und 

Auswertung über die Postprocessor Funktion möglich. 

Die ‚file.tem’ Datei wird den entsprechenden Elementen in der mechanischen Analyse 

zugewiesen und beinhaltet sowohl die Information über den Querschnitt als auch über die 

Brandbeanspruchung und daraus resultierende Temperaturentwicklung. Hieraus kann 

wiederum mit SAFIR das Tragverhalten von verschiedensten Konstruktionen berechnet 

werden und mit dem Programm ‚Diamond’ oder ‚GID’ ausgewertet werden. 

Nachfolgend ist ein Ablaufschema dargestellt, welches die allgemeine Vorgehensweise einer 

thermischen und mechanischen Analyse am Beispiel einer Rahmenberechnung aufzeigt. 

 

 

 

 

3.1 Thermische Analyse 

Bei der thermischen Analyse werden der Wärmeübergang und die Wärmeleitung von 

Bauteilen mit Hilfe der Finiten-Element-Methode (2-D Elemente) berechnet. Hierbei können 

beliebige Querschnitte modelliert und diesen dann eine oder mehrere Oberflächen (surfaces) 

zugewiesen werden. Anschließend können diesen Oberflächen verschiedene Materialien 

hinzugefügt werden.  

So lässt sich die Temperaturentwicklung in Bauteilen realitätsnah abbilden und in einem 

weiteren Schritt die Auswirkung auf die Tragfähigkeit durch die mechanische Analyse 

berechnen. Insbesondere für Querschnitte mit geometrisch aufwendigen Formen, die mit den 

gängigen Formeln nicht erfasst werden können, ist dies eine effiziente Methode. 
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3.2 Mechanische Analyse 

Mit Hilfe der strukturellen Analyse kann das Tragverhalten von Teil- oder Gesamttragwerken, 

ebenfalls auf Grundlage der Finiten-Element-Methode, berechnet werden. Hierzu wird das 

statische System mit Auflagern und Lasten entsprechend abgebildet. Anschließend werden 

den einzelnen Elementen die entsprechenden Querschnitte mit den Daten aus der 

thermischen Analyse zugewiesen. So kann ein mögliches Versagen eines Tragwerkes unter 

erhöhter Temperatur mit Hilfe des Programmes SAFIR berechnet werden. 
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4 Berechnungsbeispiel eines Rahmens 

Als Beispiel soll das Gesamtversagen eines einfachen Rahmens mit Festeinspannung an 

beiden Stützenfüßen und einer Belastung von 45 kN/m auf dem Riegel und 40 kN Druckkraft 

auf den Stützen berechnet werden. Die Stützen bestehen aus HEA 200 - Profilen mit 

ausbetonierten Kammern, der Riegel wird als HEA 280 - Profil ausgeführt. Die jeweiligen 

Abmessungen sind der nachstehenden Systemskizze zu entnehmen. Nachfolgend sind 

zunächst die notwendigen Schritte für die thermische Analyse der Stütze und des Trägers 

aufgeführt, danach erfolgt die Eingabe des Rahmens in ‚GID’ mit den vorgegebenen 

Randbedingungen und der anschließenden Berechnung. 

 

 

 

4.1 Thermische Analyse (1) – Stütze HEA 240 

Für die Stütze ist eine Stahlbeton-Verbundstütze vorgesehen, welche in ‚GID’ entsprechend 

modelliert wird. Die konstruktive Bewehrung im Beton wird hierbei für die 

Temperaturverteilung als vernachlässigbar bewertet und im folgenden Modell nicht 

berücksichtigt. 

Nachfolgend sind die notwendigen Schritte im Einzelnen aufgeführt und erläutert. 

 

1) GID-Projekt für thermische Analyse mit SAFIR erstellen 

� Data → Problem type → Safir2004b → Safir_Thermal_2D 

� Projekt speichern 

⇒ Files → Save as → HEA240.gid 

� Kopieren der Datei ‚identity.key’ in Ordner ‚HEA240.gid’  
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2) Modellierung des Querschnittes 

� I-Profil über implementiertes Makro erstellen 

⇒ Cross_Section → I-Profil 

� Eingabe der entsprechenden Querschnittswerte in Meter (!!) 

⇒ h=0.23m, b=0.24m, w=0.0075m, tf=0.012m, r=0.021m 

� Verbindungslinie zwischen den Flanschen erstellen 

⇒ Geometry → Create → Line oder Button ‚Create Line’  

� 3 Oberflächen durch Auswählen der Umfassungslinien erstellen 

⇒ Geometry → Create → NURBS surface → by contour or search 

 

 

3) Materialien zuweisen 

� Beton nach EC2 als Material für die beiden Kammern 

⇒ Data → Materials → ‚SILCONCEC2’ auswählen 

� Über Button ‚Assign’ → Surfaces die beiden eckigen Kammern markieren, 

dann ‚Finish’ 

� Stahl nach EC3 als Material für das HEA-Profil  

⇒ Data → Materials → ‚STEELEC3’ auswählen 

� Über Button ‚Assign’ → Surfaces das Stahlprofil markieren, dann ‚Finish’ 

� Kontrolle der Eingabedaten 

⇒ Data  → Materials → Draw → All materials 
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4) Brandbeanspruchung festlegen 

� Vierseitige Brandbeanspruchung der Stütze hinzufügen 

⇒ Data → Conditions → Frontier constraints 

� ‚FISO’ auswählen  

� Über Button ‚Assign’ alle äußeren Linien markieren, dann ‚Finish’ 

� Kontrolle der Eingabedaten 

⇒ Data → Conditions → Draw → Colors 

 

 

5) FEM-Netz generieren 

� Standard Netzstruktur ‚Triangle’ wird beibehalten 

� Festlegen der Netzdichte 

⇒ Meshing → Generate → 0,22 eingeben, dann ‚OK’ 

� Elemente → 458 < 500, Knoten → 260 < 500  

� Bei nachträglichen Änderungen der Struktur muss das FEM-Netz neu generiert 

werden 

 

6) Berechnungsdaten für SAFIR 

� Aufrufen des Menüs  

⇒ Data → Problem Data → General 

� Wesentliche Einstellungen in der Übersicht 

NPTTOT Max Knotenanzahl  
LARGEUR11,12 Bandweite der Steifigkeitsmatrix 
Teta Zeitparameter der Integration 
TINITIAL Ausgangstemperatur des Bauteils 
RENUMBER Berechnungsmethode 
NVOID Anzahl der Leerräume 
NFRONTIERVOID Max Anzahl der Oberflächen incl. Leerräume 
TIMESTEP Zeitintervall in Sekunden 
UPTIME Zeitdauer in Sekunden 
Timeprint Zeitintervall für Ausgabedaten 

 

� Voreinstellungen können übernommen werden 
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7) Berechnung durch SAFIR 

� Start der Berechnung  

⇒ Calculate → Calculate Window → Start 

� Ansicht des Berechnungsablaufes über Button ‚Output view’ möglich 

� Anschließend Wechsel in den ‚Postprocess’ Modus über entsprechenden 

Button im sich öffnenden Fenster  

� Bei Fehlern in den Daten wird in der Datei HEA240.txt der Grund für den 

Abbruch angegeben 

 

 

8) Auswertung der Ergebnisse 

� Eine Auswertung der ‚HEA240.out’ Datei ist mit dem Programm ‚Diamond’ 

oder ‚GID’ möglich 

� Öffnen der o.g. Datei mit ‚Diamond’ oder wechsel in den ‚Postprocess’ Modus 

in ‚GID’ 

� Ansicht der Temperaturverteilung mit mit Postprocessor ‚GID’  

⇒ View Results→ Contour Fill → Temperature (t=30 Min) 
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� Temperaturentwicklung als Funktion der Zeit (Diamond) 

→rot: Beton außen →grün: Flansch Mitte →magenta: Steg Mitte 

 

  

 

 

4.2 Thermische Analyse (2) – Riegel HEA 280 

Für den Riegel ist ein Stahlprofil der Baureihe HEA 280 geplant, welches im Standardkatalog 

verfügbar ist und so mit dem Programm ‚Wizard’ in wenigen Schritten erstellt werden kann. 

 

1) Programm ‚Wizard’ starten, der Begrüßungstext kann übergangen werden  

(Step 0 of 6) 

2) Als nächstes wird das gewünschte Profil und bei Bedarf eine aufliegende 

Betondecke mit entsprechende Abmessungen ausgewählt (Step 1 of 6) 

� Type ‚HE’ und Profile ‚HE 280 A’ auswählen 

� Keine Betondecke  

3) Auswahl eines Brandschutzmaterials und dessen Dicke (Step 2 of 6) 

� Keine Auswahl 

4) Festlegung des FEM-Netzes (Step 3 of 6) 

� Divisor des Steges und Flansches (Höhe) auf 3 erhöhen 

� Divisor des Steges und Flansches (Länge) auf 20 erhöhen 

5) Auswahl der brandbeanspruchten Seiten (Step 4 of 6) 

� Dreiseitig durch ETK (FISO) beansprucht – Face 1,2,3 auswählen 

6) Einstellung der Berechnungs- und Zeitparameter (Step 5 of 6) 

� Standardeinstellungen beibehalten 
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7) Kontrolle der Ergebnisse, dann ‚Finish’ und Speicherort wählen (Step 6 of 6) 

� Ordner ‚HEA280’ erstellen 

� Datei ‚HEA280.in’ in o.g. Ordner ablegen 

 

 

 

8) Berechnung mit SAFIR 

� Kopieren des Registrationsschlüssels ‚identity.key’ in o.g. Ordner 

� Öffnen des Programms SafirShell 

� SafirPath ‚C:\Installationspfad’ ggf. korrigieren 

� Datei ‚HEA280.in’ über Button ‚Add’ hinzufügen, dann ‚Run’ klicken 

� Datei ‚HEA280.out’ und ‚HEA280.tem’ werden im Ordner abgelegt, Fehler 

werden in der Datei ‚HEA280.txt’ angezeigt 
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9) Betrachtung der Temperaturverteilung bei t = 30 Min. mit Diamond 

� Öffnen der Datei ‚HEA280.out’ mit ‚Diamond’ 

� Buttons ‚Contour’ und ‚Temperature’ anklicken 

� Zeitstufe über Drop Down Menü wählen 

 

 

 

 

4.3 Mechanische Analyse (2D) - Rahmen 

Nachdem für die Stütze und den Träger die thermische Analyse durchgeführt und damit die 

entsprechenden ‚file.tem’ Dateien mit dem Temperaturverlauf der Bauteile zur Verfügung 

stehen, kann nun der Rahmen mit den Randbedingungen modelliert und die Analyse des 

Gesamttragwerkes durchgeführt werden. 

1) GID-Projekt für strukturelle Analyse mit SAFIR erstellen 

� Data → Problem type → Safir2004b → Safir_Structural_2D 

� Projekt speichern 

⇒ Files → Save as → Frame.gid 

� Kopieren der Datei ‚identity.key’ in Ordner ‚Frame.gid’  

� Kopieren der Dateien ‚HEA240.tem’ und ‚HEA280.tem’ in o.g. Ordner 

 

2) Eingeben der zweidimensionalen Systemstruktur 

� Befehl ‚Linie zeichnen’ aufrufen 

⇒ Geometry → Create → Line oder Button ‚Create Line’  

� Startpunkt ‚0 0’ ↵, 2.Pkt ‚0 3’ ↵, 3.Pkt ‚5 3’ ↵, Endpunkt ‚5 0’ ↵ 

� Alternativ die Struktur als ‚dxf.file’ z.B. aus AutoCAD importieren  

⇒ Import → DXF → file.dxf  
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3) Definieren der Auflagerbedingungen 

� Feste Einspannungen für beide Stützen 

⇒ Data → Conditions → Constraints  

� Mit Button ‚Assign’ beide Auflagerpunkte markieren, dann ‚Finish’ 

� Kontrolle der Eingabedaten  

⇒ Draw → Colors 

 

 

4) Punkt- und Streckenlasten aufbringen 

� Punktlasten von jeweils 40 kN am Anfang und Ende des Riegels, zentrisch auf 

den Stützen 

⇒ Data → Conditions → Loads → Point-Load auswählen 

� Y-Force ‚-40.000’ (ACHTUNG: Einheit in N, Orientierung beachten) 

� Mit Button ‚Assign’ beide Eckpunkte des Rahmens markieren, dann ‚Finish’ 

� Kontrolle der Eingabedaten 

⇒ Draw → Colors 

� Streckenlast von 25kN/m 

⇒ Data → Conditions → Loads → Beam-Load auswählen 

� Y-Force ‚-25.000’ 

� Mit Button ‚Assign’ den Riegel markieren, dann ‚Finish’ 

� Kontrolle der Eingabedaten  

⇒ Draw → Colors 
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5) Querschnitte zuweisen 

� Querschnitt HEA240 beiden Stützen zuweisen 

⇒ Data → Conditions → Properties  

 

� File-Name ‚HEA240.tem’ der thermischen Analyse eingeben 

� Anzahl der Materialien des Querschnittes → ‚2’ auswählen 

� Mit Button ‚Assign’ beide Stützen markieren, dann ‚Finish’ 

� Querschnitt HEA280 dem Riegel zuweisen 

⇒ Data → Conditions → Properties  

� File-Name ‚HEA280.tem’ der thermischen Analyse eingeben 

� Anzahl der Materialien des Querschnittes → ‚1’ auswählen 

� Mit Button ‚Assign’ den Riegel markieren, dann ‚Finish’ 

� Kontrolle der Eingabedaten  

⇒ Draw → Colors  
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6) Anpassen der Berechnungsdaten für SAFIR 

� Anzahl der verwendeten BEAM-Elemente (Anzahl der file.tem Dateien) 

⇒ Data → Problem Data → General → NGEOBEAM → ‚2’  

� Anzahl der verwendeten Materialien 

⇒ Data → Problem Data → General → Number of Materials → ‚2’  

 

� Globale Nummer der verwendeten Materialien zuweisen 

⇒ Data → Problem Data → Material  

� Material 1 → STEELEC3 

� Material 2 → SILCONC EN 

 

 

7) FEM-Netz erstellen 

� Wie auch für die thermische Analyse wird ein ‚Netz’ für die Berechnung mit der 

Finiten-Element-Methode benötigt 

⇒ Meshing → Generate → 1.0 ↵ (max. 12 Beam-Elements) 

� Nach Änderungen der Struktur oder der Randbedingungen muss dieses Netz 

erneut generiert werden 

 

8) Berechnung mit SAFIR 

� Start der Berechnung  

⇒ Calculate → Calculate Window → Start 

� Ansicht des Berechnungsablaufes über Button ‚Output view’ möglich 

� Anschließend Wechsel in den ‚Postprocess’ Modus über entsprechenden 

Button im sich öffnenden Fenster 

 



Berechnungsbeispiel eines Rahmens 

  B - 16  

9) Auswertung der Ergebnisse 

� Eine Auswertung der ‚Frame.out’ Datei ist mit dem Programm ‚Diamond’ oder 

‚GID’ möglich 

� Öffnen der o.g. Datei mit ‚Diamond’ oder Wechsel in den ‚Postprocess’ Modus 

in ‚GID’ 

� Gesamtversagen des Rahmens nach 31 Minuten, Zeitschritt auswählen 

⇒ View Results → Default Analysis/Step → Structural 2D → 1860 sec 

� Verformungen anzeigen  

⇒ View Results → Deformation → Displacements 

 

� Momentenverlauf anzeigen 

⇒ View Results → Line Diagram → Scalar → Axial-Force 

 

� Normalkraftverlauf anzeigen 

⇒ View Results → Line Diagram → Scalar → BendingMoment 
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Ergebnisbericht der Brandsimulation mit OZone V2.2 

 

Berechnung einer Naturbrandkurve für ein Bürogebäude
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Ergebnisbericht 
 

OZone V 2.2.2 Report 
 Analysis Name: Tobias Flesch, Diplomarbeit, 08/2007 
 File Name: C:\Programme\OZone V2.2\Rahmen_Büro.ozn 
 Created:  29.07.2007 at 23:05:06 
 

ANALYSIS STRATEGY 
 Selected strategy: Combination 2Zones - 1 Zone Model 
 Transition criteria from 2 Zones to 1 Zone 

 Upper Layer Temperature  ≥ 500°C 

 Combustible in Upper Layer + U.L. Temperature ≥ Combustible Ignition Temperature = 300 °C 

 Interface Height  ≤ 0,2 Compartment Height 

 Fire Area  ≥ 0,25 Floor Area 
 

PARAMETERS 
 
 Openings 
 Radiation Through Closed Openings: 0,8 
 Bernoulli Coefficient: 0,7 
 
 Physical Characteristics of Compartment 
 Initial Temperature: 293 K 
 Initial Pressure: 100000 Pa 
 
 Parameters of Wall Material 
 Convection Coefficient at the Hot Surface: 25 W/m²K 
 Convection Coefficient at the Cold Surface: 9 W/m²K 
 
 Calculation Parameters 
 End of Calculation: 7200 sec 
 Time Step for Printing Results: 60 sec 
 Maximum Time Step for Calculation: 10 sec 
 
 Air Entrained Model: Heskestad 
 
 Temperature Dependent Openings 
  
 Stepwise Variation 
 Temperature % of Total Openings 
 [°C] [%] 
 20 5 
 400 25 
 500 100 
 
 

COMPARTMENT 
 Form of Compartment: Rectangular Floor 
 Height: 3,2 m 
 Depth: 10,56 m 
 Length: 34,38 m 
 Roof Type: Flat Roof 
 
 DEFINITION OF ENCLOSURE BOUNDARIES 
 
 Floor 
 Material (from inside to outside) Thickness Unit Mass Conductivity Specific Heat 
  [cm] [kg/m³] [W/mK] [J/kgK] 
 Normal Wood 5 450 0,1 1113 
 Normal weight Concrete [EN1994-1-2] 18 2300 1,6 1000 
 
 Ceiling 
 Material (from inside to outside) Thickness Unit Mass Conductivity Specific Heat 
  [cm] [kg/m³] [W/mK] [J/kgK] 
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 Normal weight Concrete [EN1994-1-2] 16 2300 1,6 1000 
 
 Wall 1 
 Material (from inside to outside) Thickness Unit Mass Conductivity Specific Heat 
  [cm] [kg/m³] [W/mK] [J/kgK] 
 Normal Bricks 24 1600 0,7 840 
 
 Openings 
 Sill Height Soffit Height Width Variation Adiabatic 
 [m] [m] [m] 
 1,26 2,3 2 Stepwise no 
 
 Wall 2 
 Material (from inside to outside) Thickness Unit Mass Conductivity Specific Heat 
  [cm] [kg/m³] [W/mK] [J/kgK] 
 Normal Bricks 24 1600 0,7 840 
 
 Openings 
 Sill Height Soffit Height Width Variation Adiabatic 
 [m] [m] [m] 
 0 3,1 2,2 Constant no 
 1,26 2,3 4 Stepwise no 
 1,26 2,3 4 Stepwise no 
 
 Wall 3 
 Material (from inside to outside) Thickness Unit Mass Conductivity Specific Heat 
  [cm] [kg/m³] [W/mK] [J/kgK] 
 Normal Bricks 24 1600 0,7 840 
 
 Openings 
 Sill Height Soffit Height Width Variation Adiabatic 
 [m] [m] [m] 
 1,26 2,3 2 Stepwise no 
 
 Wall 4 
 Material (from inside to outside) Thickness Unit Mass Conductivity Specific Heat 
  [cm] [kg/m³] [W/mK] [J/kgK] 
 Normal Bricks 24 1600 0,7 840 
 
 Openings 
 Sill Height Soffit Height Width Variation Adiabatic 
 [m] [m] [m] 
 1,26 2,3 4 Stepwise no 
 1,26 2,3 4 Stepwise no 
 1,26 2,3 5 Stepwise no 
 

FIRE 
 Fire Curve: NFSC Design Fire 
 Maximum Fire Area: 50 m² 
 Fire Elevation: 0,5 m 
 Fuel Height: 0 m 
 
 Occupancy Fire Growth RHRf Fire Load qf,k Danger of Fire 
  Rate [kw/m²] [MJ/m²] Activation 
 Office (standard) Medium 250 511 1 
 
 Active Measures 
 Description Active Value 

 Automatic Water Extinguishing System No γn,1 = 1 

 Independent Water Supplies No γn,2 = 1 

 Automatic Fire Detection by Heat No γn,3 = 1 

 Automatic Fire Detection by Smoke No 

 Automatic Alarm Transmission to Fire Brigade No γn,5 = 1 

 Work Fire Brigade No 

 Off Site Fire Brigade Yes γn,7 = 0,78 

 Safe Access Routes Yes γn, 8 = 1 
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 Staircases Under Overpressure in Fire Alarm No 

 Fire Fighting Devices Yes γn, 9 = 1 

 Smoke Exhaust System No γn, 10 = 1,5 

 

 Fire Risk Area: 50 m² γq, 1=  1,24 

 Danger of Fire Activation:   γq, 2=  1 

 qf, d=  593,1 MJ/m² 

 
 Combustion Heat of Fuel: 17,5 MJ/kg 
 Combustion Efficiency Factor: 0,8 
 Combustion Model: Extended fire duration 
 

RESULTS 
 Fire Area: The maximum fire area (  50.00m²) is lower than 25% of the floor area ( 363.05m²). The fire load 
is localised. 
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 Peak: 457 °C  At: 40 min 
 
 Figure 1. Hot and Cold Zone Temperature 
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 Peak: 12,50 MW  At: 17,7 min 
 
 Figure 2. RHR Data and Computed 
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 Peak: 457 °C  At: 40 min 
 
 Figure 3. Hot Zone and Steel Temperature 
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 h = 0,76 m  At: 18,00 min 
 
 Figure 4. Zones Interface Elevation 
 

STEEL PROFILE 
 Unprotected Section 
 Catalog Profile: HE 260 A           
 Exposed to Fire on: 3 sides 
 

HEATING 
 Profile heated by: Hot Zone Temperature 
 Convection coefficient: 25 W/m²K 
 Relative emissivity: 0,7 
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